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Document Information

Revision History

Each page of the document has the document part number and revision 
letter at the bottom of the page. The revision letter identifies the 
document’s update level. 

The revision history of this document is summarized in the table below.

Manual Purpose

This manual contains the instructions necessary to operate and service 
the Mac-Lab/CardioLab system safely in accordance with its function 
and intended use. These instructions include but are not limited to:

� Describing fundamental controls and indicators.
� Operating procedures.
� Connecting and disconnecting detachable parts and accessories.
� Troubleshooting and service procedures.

Intended Audience

This manual is intended for the person who maintains and troubleshoots 
this equipment. 

Related Manuals

Table 1. Revision History PN 2007623-079

A 31 March 2003 Initial release of manual.

B 28 July 2003 Added ML370 G3 server information.

C 01 September 2004 Added Disaster Recovery Server Repartitioning 
(+180 GB)

D 13 October 2004 Updated Disaster Recovery Section (Chapter 6)

E 15 May 2005 Updated Per ECR01905-003; Removed 
incorrect leakage current info in Chapter 4.

Part Number Document

2007623-042 Mac-Lab Operator’s Manual

2007623-043 CardioLab Operator’s Manual

2007623-083 Centricity CardioLink Operator’s Manual

2007623-081 Centricity CardioLink Installation/Upgrade Instructions
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2007623-080 Mac-Lab/CardioLab System Installation Manual

2007623-059 Mac-Lab/CardioLab Advanced Security Guide

2007623-078 Mac-Lab/CardioLab/Centricity CardioLink Pre-Installation Manual

2007623-082 Mac-Lab/CardioLab System Software Upgrade Instructions

2007623-169 Mac-Lab/CardioLab Lab Management Tools (LMT) Installation/Service Manual

Part Number Document
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Statement of Indications for Use

Mac-Lab System
The Mac-Lab system is intended for use under the direct supervision of a 
licensed healthcare practitioner to monitor, calculate, or record 
cardiovascular data from patients as they undergo cardiac 
catheterization. Cardiovascular data may be manually entered or 
acquired via interfaced GE Medical Systems Information Technologies 
TRAM modules, MUSE cardiovascular system, and other interfaced 
information systems. Data includes: ECG waveforms, heart rate, pulse 
oximetry (SpO2), respiration rate, valve gradients and areas, cardiac 
output, hemodynamic measurements, invasive and non-invasive blood 
pressure, procedural information, and optional intracardiac 
electrocardiogram (IECG).

This is applicable to pediatric and adult patients requiring cardiac/
circulatory system catheterization. This is intended for use in 
catheterization and related cardiovascular specialty laboratories.

CardioLab System
The intended use of the CardioLab system is to acquire, filter, digitize, 
amplify, display, and record electrical signals obtained during 
electrophysiological studies and related procedures conducted in an 
electrophysiological laboratory. Signal types acquired include ECG 
signals, direct cardiac signals, and pressure recordings. Physiological 
parameters such as diastolic, systolic, and mean blood pressure, heart 
rate, and cycle length may be derived from the signal data, displayed and 
recorded. The system allows the user to monitor the acquisition of data, 
review the data, store the data, perform elementary caliper-type 
measurements of the data, and generate reports on the data. 
Additionally, the system may acquire, amplify, display, and record data 
received from other medical devices typically used during these 
procedures, such as imaging devices and RF generators.

The CardioLab EP system does not control the delivery of energy, 
administer drugs, perform any life-supporting or life-sustaining 
functions, or analyze physiological data or other data acquired during an 
EP procedure. It does not transmit alarms or arrhythmias and does not 
have arrhythmia detection capabilities.
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Chapter Content

This manual is organized into chapters and appendices.

1 Introduction – This chapter describes the field service manual and 
chapter contents. Provides general information on safety, service 
requirements, equipment symbols, and serial number identification. 

2 Equipment Overview – This chapter describes the equipment and its 
technical characteristics, connector locations, and preparation for use.

3 Installation – This chapter contains the system components for the 
Mac-Lab/CardioLab system.

4 Maintenance – This chapter contains a preventive maintenance 
schedule, illustrated instructions for opening the unit, and cleaning 
guidelines. Instructions for performing electrical safety (leakage) tests 
are also included.

5 Troubleshooting – This chapter provides overall and specific 
troubleshooting help, and directions for performing functional tests.

6 CardioLink Disaster Recovery – This chapter provides the 
procedures needed to perform a server disaster recoveries in a 
CardioLink network environment.

7 Drawings and Parts Lists – This chapter contains upper-level parts 
lists, photos, and illustrations for reference in repairing the unit at the 
assembly level.

Appendix A - Technical Specifications – This appendix lists the 
technical descriptions and specifications for the Mac-Lab/CardioLab 
system.

Appendix B - CardioLink Server Rename – This appendix explains 
the procedure used to change the server name in a CardioLink network 
environment.

Index – The Index lists the terms used in the document.
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Safety Information

Follow all of the instructions and warnings marked included in this 
manual, save these instructions for later use. However, these 
instructions in no way supersede current medical practices regarding 
patient care and safety.

Electromagnetic Compatibility and Interference

This catheterization system meets the requirements of the European 
Medical Device Directive, and by reference, the requirements for 
electromagnetic compatibility specified by EN 60601-1-2. This equipment 
is not likely to interfere with other equipment, except with certain types 
of rate adaptive pacemakers that rely on bioelectric impedance 
measurement (BIM) technology. Also, interference with the operation of 
this equipment is not likely to result from proximity to general 
equipment.

This equipment meets or exceeds Class A immunity levels. However, 
avoid the use of strong intentional radio transmitters in the immediate 
vicinity, including cellular telephones. The use of strong unintentional 
radiators, such as electrosurgical equipment, may cause some level of 
interference. GE Medical Systems Information Technologies offers 
optional ECG patient cables with electrosurgical noise filtering, which 
reduces the level of interference on ECG traces. 

If using electrosurgical or RF ablation equipment in conjunction with 
this equipment, select an ESU filtered cable. For more information about 
management of the equipment in the clinical environment (from an 
electromagnetic compatibility perspective) consult the Association for the 
Advancement of Medical Instrumentation’s technical information report 
Guidance on Electromagnetic Compatibility of Medical Devices for 
Clinical/Biomedical Engineers.

Responsibility of the Manufacturer

GE Medical Systems Information Technologies is responsible for the 
effects of safety, reliability, and performance only if:

� Installation operations, extensions, readjustments, modifications, or 
repairs are performed by persons authorized by GE Medical Systems 
Information Technologies.

� The equipment is used in accordance with the instructions provided.
� The user attaches only accessory equipment recommended for 

interaction with the amplifier.
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General

This system is intended for use under the direct supervision of a licensed 
health care practitioner.

The Mac-Lab/CardioLab system maintains leakage currents below 
medical limits with an isolation transformer which is incorporated into 
the design of the integrated electronics box (IEB). The system power is 
supplied by a dedicated power supply on an isolated circuit for proper 
behavior of the system.

To ensure patient safety, use only parts and accessories manufactured or 
recommended by GE Medical Systems Information Technologies. Parts 
and accessories used must meet the requiremetns for the applicable IEC 
601 series safety standards, and the system configuration must meet the 
requirements of the IEC 601-1-1 medical electrical systems standard. 
Contact GE Medical Systems Information Technologies before connecting 
any device to this system that is not recommended for use in this 
manual.

If the equipment is installed in the USA and uses 240V rather than 
120V, the source must be a center-tapped, 240V single-phase circuit.

To ensure patient safety, use only parts and accessories manufactured or 
recommended by GE Medical Systems Information Technologies.

This equipment should only be connected as specified by GE Medical 
Systems Information Technologies. Installation of the equipment should 
only be performed by qualified GE Medical Systems Information 
Technologies service representatives. Connection of the system to the 
equipment is not recommended in this manual.

Contact GE Medical Systems Information Technologies for information 
before connecting any device to this equipment that is not recommended 
in this manual. Only cables and accessory equipment purchased form GE 
Medical Systems Information Technologies should be used in conjunction 
with the system.

It is important that all of the instructions in this manual be followed. 
However, these instructions in no way supersede current medical 
practices regarding patient care and safety.

Refer servicing of the equipment to GE Medical Systems Information 
Technologies authorized service personnel. Any attempt to repair 
equipment under warranty will void that warranty.

Failure on the part of responsible individuals or institutions to 
implement a satisfactory equipment maintenance schedule may lead to 
undue equipment failure and possible health hazards.
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The use of ACCESSORY equipment not complying with the equivalent 
safety requirements of this equipment may lead to a reduced level of 
safety of the resulting system. Consideration relating to the choice 
includes:

� Use of the accessory in the PATIENT VICINITY.
� Evidence that the safety certification of the ACCESSORY is 

performed in accordance with the appropriate IEC 601-1 and IEC 
601-1 harmonized national standard.
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Equipment Symbols

Table 2. Equipment Symbols

Equipment Symbols Descriptions

Underwriters Laboratories, Inc.
Classified by Underwriters Laboratories Inc. with respect to electric shock, fire, mechanical 
and other specified hazards, only in accordance with UL 2601-1, CAN/CSA C22.2 No. 
601.1, IEC 60601-1, and, if required, IEC 60601-2-27, IEC 60601-2-30, IEC 60601-2-34, 
IEC 60601-1-1.

CE Marking

Power Ratings Chart:
V~ = Voltage
I     = Current
Fuse = 

Equipotentiality
A nonessential electrical connection which may be used to connect the chassis to other 
equipment to achieve the same potential.

Type CF Equipment that is Defibrillator Proof
Type CF Applied Part: Isolated (floating) applied part suitable for intentional external and internal 
application to the patient excluding direct cardiac application. The "paddles" outside the box indicate 
that the part is defibrillator proof.
(Medical Standard Definition:) F-Type applied part (floating/isolated) complying with the specified 
requirements of IEC 60601-1/UL 2601-1/CSA 601.1 Medical Standards provide a higher degree of 
protection against electric shock than that provided by Type B applied parts.

Type CF Equipment
Type CF Applied Part: Isolated (floating) applied part suitable for intentional external and internal 
application to the patient excluding direct cardiac application.
(Medical Standard Definition:) F-Type applied part (floating/isolated) complying with the specified 
requirements of IEC 60601-1/UL 2601-1/CSA 601.1 Medical Standards provide a higher degree of 
protection against electric shock than that provided by Type B applied parts.

Attention 
Pay attention to the documents delivered with the equipment.

Input Symbol
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Conventions

Safety Messages

������
Safety messages which indicate an imminently hazardous 
situation which, if not avoided, WILL result in death or serious 
injury.

�������
Safety messages which indicate a potentially hazardous situation 
which, if not avoided, COULD result in death or serious injury.

	�
����
Safety messages which indicate a potentially hazardous situation 
which, if not avoided may result in minor or moderate injury, loss 
of data or system failure.

����
Messages which provide additional user information.

Definitions
� Items shown in Black text are keys on the keyboard, text to be entered, or 

hardware items such as buttons or switches on the equipment.

� Items shown in Italicized text are software terms which identify menu items, 
buttons, or options in various windows.

� To perform an operation which appears with a plus (+)sign between the names 
of two keys, you press and hold the first key while pressing the second key 
once. This is called a keystroke combination.

For example, Press Ctrl+Esc means to press and hold down the Ctrl key while 
pressing the Esc key.

� When instructions are given for typing a precise text string with one or more 
spaces, the point where the spacebar must be pressed is indicated as: <Space>. 
The purpose of the < > brackets is to ensure you press the spacebar when 
required.

� Enter means to press the Enter or Return key on the keyboard. Do not type 
enter.
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Danger, Warnings, and Cautions

������
EXPLOSION HAZARD

Do not use in the presence of flammable anesthetics or 
other flammable gases.

�������
ACCESSORIES

Only connect UL 544 or UL 2601-1 listed or IEC certified 
medical equipment.

ACCIDENTAL SPILLS

If fluid of any kind should leak into the system, 
discontinue use of the equipment and contact GE Medical 
Systems Information Technologies immediately.

DO NOT allow hydraulic fluid from any device to contact 
any conductive surface. Hydraulic fluid is electrically 
conductive.

ACCURACY

The system may report erroneous heart rate values when 
pacemaker spikes or arrhythmias are present. Reported 
values should be verified by a qualified physician.

CONDUCTION HAZARD

Keep the conductive parts of lead electrodes and 
associated parts away from other conducting parts, 
including earth.

DEFIBRILLATOR PRECAUTIONS

DO NOT contact the amplifier or patient during 
defibrillation.

Standby defibrillation equipment is required in the event 
that the patient needs to be cardioverted or defibrillated.

Disconnect leadwires from patient before defibrillating. 
Otherwise, serious injury, death, or damage to the 
equipment could result.

IEC

All equipment not complying with IEC 601-1 should be 
placed outside the patient environment.
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�������
INTERPRETATION HAZARD

A qualified physician must overread all computer-
generated measurements and tracings. Computerized 
interpretation is only significant when used in 
conjunction with clinical findings.

Signal quality should be checked only by a licensed 
health care practitioner. 

All computer assisted measurement functions must be 
verified by a licensed health care practitioner.

LEAKAGE CURRENT TEST

The system should be tested yearly for adequate 
grounding on patient leakage current.

Keep leakage current within acceptable limits when 
connecting auxiliary equipment to the system. 

When more than two electrical devices are 
interconnected, the summation of leakage currents must 
be checked yearly. 

MAINTENANCE/SERVICE

High voltages exist in the unit. Use insulated tools. 
Remove jewelry and use only one hand when possible.

Always disconnect power from the equipment before 
attempting service.

PINCH POINT HAZARD

Keep hands, hair, jewelry and loose clothing away from 
moving parts. Otherwise, serious injury could result.

POWER SUPPLY

Total system earth leakage current must not exceed 500 
microamperes.

Voltages between the three power outlet connections 
must be accurate BEFORE measuring power outlet 
ground-to-neutral loop resistance.

Electrostatic discharge (ESD) can damage electronic 
components. Be sure you are properly grounded when 
using or servicing the system.

To reduce the risk of electric shock or damage to the 
equipment, do not disable the power cord grounding 
feature. This equipment is designed for connection to a 
grounded (earthed) power outlet.



1-14 Mac-Lab/CardioLab Revision E
2007623-079

Introduction: Danger, Warnings, and Cautions

�������
The supply line must be fused and capable of delivering 
16A.

Route the AC power cable away from moving parts.

Connect only to a properly earth grounded outlet.

REPLACEMENTS

Replace only with the same type and rating of fuse.

SHOCK HAZARD

Electrical shock hazard between chassis ground and 
isolated (floating) ground when power is applied. Unplug 
the unit from the power source before proceeding.

To reduce the risk of electric shock or damage to your 
equipment, do not disable the power cord grounding 
feature. This equipment is designed for connection to a 
grounded (earthed) power outlet. The grounding plug is 
an important safety feature.

SUPERVISED USE

This device is intended for use under the direct 
supervision of a licensed health care practitioner. 

	�
����
 Federal (USA) law restricts this device to sale by or on 
the order of a physician.

ACCURACY

DO NOT display any channels which are based on 
unused catheter input modules. Otherwise, erroneous 
values may occur.

ECG signal quality should only be checked by qualified 
medical personnel.

CABLING

Route optical cables thorough conduit in the ceiling or 
floor to avoid damage to the cables of cable connectors.

DEVICES

DO NOT reuse single use devices.
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	�
����
EMC

No known electromagnetic or other interference between 
the system exists. However, precautions should be taken 
to avoid the use of cellular telephones, pagers, or other 
transmitters.

OPTICAL DISK

Exit the software application properly before turning off 
the system. Failure to do so may damage the optical disk.

Remove the optical disk before moving the system. 
Failure to do so may result in damage to the drive or the 
disk.

TRANSDUCER

Remove air that is trapped in the transducer or 
associated tubing by flushing the system according to 
Cath lab procedures.

REMOTE MONITOR

Always power the system through separate isolation 
transformers which are independently connected to a 
wall outlet. You can power the laser printer through the 
IEB/Workstation power supply. Otherwise, the printer 
may draw enough current away from the system and 
cause it to reboot.

SOFTWARE

DO NOT add unauthorized software to the Mac-Lab/
CardioLab system. Doing so may make the Mac-Lab/
CardioLab software unstable.
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Service Information

Service Requirements

Follow the service requirements listed below:

� Equipment servicing should be performed by GE Medical Systems 
Information Technologies authorized service personnel only.

� Any unauthorized attempt to repair equipment under warranty voids 
that warranty.

� It is the user’s responsibility to report the need for service to GE 
Medical Systems Information Technologies or one of their authorized 
agents.

� Failure on the part of the responsible individual, hospital, or 
institution using this equipment to implement a satisfactory 
maintenance schedule may cause undue equipment failure and 
possible health hazards.

� Regular maintenance, irrespective of usage, is essential to ensure 
that the system is always functional when required.
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Equipment Identification

Every GE Medical Systems Information Technologies device has a 
unique serial number for identification. The serial number appears on 
the back of the CardioLab II Plus Amplifier. 

Equipment Identifications Table

A

B

C

D E F G H I

GE Medical Systems Information Technologies, Inc.

CardioLab Computer

A0XH0001FP

PK1

Table 3. Equipment Identifications

Item Name Description

A Manufacturer GE Medical Systems Information Technologies

B Name of device CardioLab computer

C Serial number Unique identifier

D Month manufactured A = January, B = February, C = March, D = April, E = May, F = June, G = July, 
H = August, J = September, K = October, L = November, M = December

E Year manufactured 9 = 1999, 0= 2000, 1= 2001, (and so on)

F Product code Two-character product descriptor XH= CardioLab computer

G Product sequence number Four-character manufacturing number (of total units manufactured)

H Plant designator F = Cardiology G = Monitoring

I Device characteristics One or two characters that further describe the unit, for example: P = prototype not 
conforming to marketing specification; R = refurbished equipment; S = special product 
documented under Specials part numbers; U = upgraded unit
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Required Tools and Supplies

The following is a list of tools needed to service the Mac-Lab/CardioLab 
system:

� Adjustable wrench with a 1-inch capacity
� Phillips screwdriver
� Needle nose pliers
� Pliers
� Socket wrench (3/16 inch to 1 inch size bits)
� Phillips head screwdriver (small and large sizes)
� Flat head screwdriver (small and large sizes)
� Cutting pliers
� Power outlet ground tester
� Grounding strap
� Signal generator with ECG, pressure, cardiac output, and 

temperature outputs.
� Cables to connect simulator to ECG inputs of amplifier and TRAM
� Cables to connect the simulator to the catheter input modules (2 mm 

shielded)
� Adapter cable to connect the simulator to the amplifier and TRAM 

pressure inputs
� Cables to connect the simulator to the TRAM, cardiac output, and 

temperature inputs

Power Input Requirements

If the equipment is installed in the USA and uses 240V rather than 
120V, the source must be a center-tapped, 240V single-phase circuit 
(120V, 20A; 240V, 10A).
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Acquisition Computer with Workstation

Central Processing Unit (CPU)

The Mac-Lab/CardioLab products are diagnostic systems used for the 
assessment of the cardiac electrophysiologic (CardioLab) and 
hemodynamic (Mac-Lab) condition of patients.

The computer hardware consists of a PC motherboard, expansion cards 
for added functionality, and a SCSI drive system.

See Chapter 7, “Drawings and Parts List”  for diagrams of the computer.

PK1
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General Description

Standard Equipment

Table 1.  Standard Equipment

Description Part Number

Barcode Scanner 2003417-001

Laser Printer 
4200 
 2200

2015205-001
2007078-001

Monitors: 
18" Flat Screen
19" CRT
20" Flat Screen
21" CRT

2013547-002
2012980-001
2006144-001
2010311-001

Keyboard: Mac-Lab (English) 
CardioLab (English)
ComboLab (English) 

2003809-001
2003809-002
2003809-003

Scroll Mouse 2007023-001

TRAM Modules (Mac-Lab 7000/Combination systems only)
                    450 SL

400 SL
412654-001
411161-001

Remote Acquisition Unit (RAU) Mac-Lab 7000/Combination
systems only) (400SL or 450 SL)

415540-001

CardioLab II Plus Amplifier (Mac-Lab/CardioLab/Combination systems only)
32 Channel
64 Channel
96 Channel
128 Channel

2003232-001
2003232-002
2003232-003
2003232-004

Acquisition Computer 2011646-00X

TRAM-Net RAC 4A (Mac-Lab/Combo System only) 900031-006
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Additional Systems

Optional Equipment

CardioLink Server 

Software

Operating System
The computer uses the Windows NT 4.0 Operating System.

Application
The Mac-Lab/CardioLab system is a single, custom application which 
has an EP and a CathLab mode. The ComboLab system includes both 
Mac-Lab and CardioLab.

Table 2.  CardioLink Clients

Description

Nurses Station/Pre-Post Op Station/Review Station 2011646-006

Table 3.  Optional Equipment

Description Part Number

Strip Chart Recorder (Thermal Writer) 2002480-001

Analog Output Box 2006168-001

Video Printer 2004142-001

Table 4.  Server

Description Part Number

G2:
High-End Server
Mid-Level Server
Local Server

G3:
High-End Server
Mid-Level Server
Low-End Server

2009350-001
2009350-002
2009350-003

2016992-001
2016992-002
2016992-003

Network Switch 10/100 Base-TX 2001084-001

Rack-Mounted UPS 2006397-001

Rack 2006483-001
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Accessory Software
In addition to the Mac-Lab/CardioLab system, the computer has the 
following accessory software installed:

� Microsoft Office (for generating procedure reports)
� PC Anywhere 32 (for remote support via modem)
� Microsoft Database Engine (MSDE) for database communication
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MotherBoard

The motherboard is a server and has the following features:

� Pentium III processor support
� Integrated 10/100 Network card
� Integrated SCSI controller

Component Boards

The following expansion cards may be added to the computer for 
additional functionality.

Video PCI Expansion Cards 
The video subsystem utilizes a PCI video card. This card supports the 
high resolutions used for the application (up to 1600 by 1280 per 
monitor). 

The computer can be configured with one or two video cards, depending 
on the configuration purchased. The use of the extra video card allows 
the desktop display to be shown across two monitors instead of one. The 
board in the slot labeled Video 1 drives the real-time signal display of the 
system, as well as non-real-time display elements. The optional board in 
the slot labeled Video 2 displays only non-real-time display elements.
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RS422 PCI Expansion Card 
The computer can be configured with an optional RS422 expansion card. 
This card allows the computer to communicate with the TRAM RAU 
module. This card has two independent RS422 DB9 connectors, allowing 
it to communicate with two TRAM RAUs simultaneously. 

������
The DB9 connectors on the board do not connect directly to the 
TRAM, but connect instead to the IEB. The IEB routes the dual 
RS422 connections to a single DB15 connector, which connect to 
the TRAM RAU cable.

Imaging PCI Expansion Card - Optional
The computer can be configured with an optional Imaging expansion 
card. This card allows the computer to acquire and display analog video 
input, such as images from an X-ray system.
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COMMS ISA Expansion Card 
The computer is configured with a COMMS expansion card. The purpose 
of this card is to:

� Communicate with the CardioLab II/II Plus amplifier (via 2 ST 
connectors on the bracket).

� Output of analog signals for use by other equipment (output via the 
DB 44 connector on the bracket).

� Input of analog signals from other equipment (input via the DB 44 
connector on the bracket).

� Provide additional serial ports (COM 5,6,7,8,9,10). Input/Output via 
the internal 40 pin header for COM 5,6,7,8,9 and internal 10 pin 
header for COM 10.

� Output a video switching signal to toggle the video display of the 
Switched Video output on the system VID/MUX (video distribution/
amplifier board in the IEB) (output via the DB 44 connector on the 
bracket).

SCSI PCI Expansion Card - Optional
The computer can be configured with an optional SCSI expansion card. 
This card allows the computer to review old patient studies from the 
previous DOS CardioLab EP version of the CardioLab product. 

SCSI Drive Subsystem
The computer is configured with an Ultrawide II SCSI interface. A SCSI 
interface is used to increase performance of the data read/write that is 
achieved with the SCSI.

The SCSI drives used in the system are:

� Hard drive used for the operating system, application software, and 
accessory software.

� CD ROM drive used for loading software as needed.
� Optical drive used for recording system studies to portable optical 

media.
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USB Port (part of IEB Box)
The computer is configured with two USB ports:

� The USB port communicates with or prints to the optional Thermal 
Writer. Only one port is needed for the writer.

� The second port is an active port which can be used in the event of a 
problem with the first port.

Optical Drive 2.6GB 
The optical drive used for recording system studies to portable optical 
media.

Type IV (High-end option): 

 5 1/4 inch Optical Drive)

Optical Drive 320MB
The optical drive used for recording system studies to portable optical 
media.

Type III (low-end option): 

 3 1/2 inch Optical Drive 

TRAM-net to Ethernet conversion board 
Converts signals from the TRAM-net RAC to Ethernet. Allows Mac-Lab 
communications with the TRAM-net RAC.
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Integrated Electronics Box (IEB)

Introduction

The IEB serves as the power conditioner/distribution device for the  Mac-
Lab/CardioLab/ComboLab workstations. The power supplied by the IEB 
supports all specified equipment that is needed for system operation.The 
IEB is designed to provide power to the following equipment:
� NT Computer
� 3- 20" LCD Monitors
� Uninterruptible Power Supply (UPS) (Internal)
� Laser printer
� Video Multiplexer (VID/MUX) amplifier (Internal)
� Modem (Internal)
� Thermal Writer
� Two TRAM modules

There are three different versions of the IEB. They are:
� IEB 100V, 50/60 Hz
� IEB 120V, 50/60 Hz
� IEB 240V,  50/60 Hz
See Chapter 7, “Drawings and Parts List”  for part numbers.

Isolation Transformer (part of IEB Box)
The isolation transformer is used to provide isolation as required by 
IEC601-1. The transformer is a 2.0kVA medical grade high isolation 
transformer. It has the appropriate primary and secondary taps to 
achieve 1:1 ratings for 100V, 120V, and 240V.
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Uninterruptible Power Supply (UPS) 
There are three different versions of the UPS, one for each rated voltage 
version of the IEB. The UPS is only required to power the computer (no 
monitors) to prevent momentary loss of power. The UPS is powered 
directly from the unswitched power on the secondary of the transformer. 
This prevents the UPS from detecting a power fault condition when the 
power is switched off to other components.The computer is turned off 
using the power switch on either the UPS or the computer.

The UPS is mounted on the upper internal shelf and is fastened in place 
using the UPS Hold Bracket. The front panel of the UPS is visible 
through the opening in the front panel of the IEB. This is needed for user 
access to the UPS power switch.

Modem 
The universal modem is used for remote dialing to the system for service.

� The IEB is supplied with an internal modem that is connected to the 
computer. 

� There are two versions of modems. One for use in the 120V IEB and 
one that is used in the 100V and 220V versions. Each version of 
modem is supplied with a power supply.
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Modem Power Supply (part of IEB Box)
� The IEB is supplied with an internal modem that is connected to the 

computer. 
� There are two versions of modems. One for use in the 120V IEB and 

one that is used in the 100V and 220V versions. Each version of 
modem is supplied with a power supply.

� The modem is attached to the lower internal shelf and the power is 
connected to the appropriate AC outlet on the same shelf. The 
modem is secured with Velcro. The serial interface to the computer is 
connected through the DB Connect Circuit Board. The phone line in 
and out is connected through the DB Connect Panel.

Video Multiplexer (VID/MUX) for IEB 
The VID/MUX is a video board that is capable of the following functions:

� Accepts three video inputs
� Two buffered outputs for each input (one for a local monitor and one 

for remote)
� One buffered output that is software selectable to view input 1 or 2

VID/MUX Power Supply (part of IEB Box)
The VID/MUX board requires ±5V @ 1.25A each. The power supply for 
the VID/MUX board is mounted in the lower power compartment of the 
IEB. Switched AC power is delivered by the power supply. 
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DB Connect Circuit Board 
The DB Connect Panel has the following I/O connections.

� Analog IN and OUT from computer on DB44
The DB44 is the new connector on the COMMS board. It combines 
the functions of Analog In and Analog OUT.

� Analog OUT to breakout box on DB37
This connection routes the Analog OUT from the DB44 to the DB37. 
This allows for interface to the current analog output breakout cable.

� Analog OUT Channel 1-2 on BNC
These connections are individual channel outputs from the DB44 
connector.

� Analog IN CH 1-4 on BNC
These connections are analog inputs that connect to the DB44.

� Digital IN on 1/4 inch phone jack.
These connections are digital inputs that connect to the DB44.

� Modem Line IN on pass through RJ12.
Connects modem to the phone line.

� Modem Phone OUT on pass through RJ12.
Port allows for the connection of the external phone to the phone line.

� Serial IN for the modem.
Serial connection for the internal modem.

� RS422 from the computer on 2 DB9.
There are two RS422 ports from the computer for interface to 2 
TRAM modules 

� RS422 to TRAM on DB15 (DB9 shell).
This connector has integrated the two RS422 ports and power for the 
TRAM. This connects to an RAU.

� Power from TRAM power supply for TRAM (solder side connector).
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Thermal Overcurrent Circuit Breaker 
The device is mounted on the lower half of the rear panel. It has two 
functions:

� Main Power Switch
This switch controls power to all internal components and all 
external components that are connected to the system.

� Overcurrent Protection
This is an overcurrent condition to trip the breaker. Once the 
overcurrent condition is removed, the breaker can be turned on.

ON/Standby Switch 
This switch controls power to all components connected to the 4 outlets 
on the rear of the unit. It does not switch power to the single unswitched 
outlet on the rear of the unit. The main purpose for this switch is to allow 
for power control of all the components except the UPS that delivers 
power to the computer.

Rack-Mounted UPS for CardioLink Server
The UPS features a maximum of 2700 Watts of true power. This new 
rack-space saving design allows more support for critical rack mountable 
equipment. 

LED and switch menbrane integrated into the front panel with four 
button controls (three buttons for UPS power control and one button 
under the front bezel for configuration).
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Installation

CardioLab 2000/4000/7000

Components
The components may vary depending on the options in use. These 
variations are covered in instructions that are provided with each option.

Catheterization Procedure Room
The components that are found in the catheterization procedure room 
are:

� Patient leads, ECG cable 
� Catheter input
� Analog output cable
� Analog input cable
� Remote monitors
� Video cables
� Video power cables
� Amplifier
� Stim input cables
� Fiber optic cable
� Amplifier power cable
� RF generator
� Stimulator
� Integrated Electronics Box (IEB) power cable
� Radio Frequency (RF) cable
� IEB
� Computer
� Workstation
� Printer
� Barcode scanner
� Network cable (with Network option)
� Mouse
� Keyboard
� Image input cable (with Image option)
� Analog phone line
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Reviewing the Assembly
Before beginning to service the system, review the existing assembly to 
ensure that it is correctly installed and connected. This should be done 
prior to turning on the system. 

� Ensure that the power is off.
� Ensure that the components are conveniently positioned in the room 

and have adequate room for access and ventilation.
� Have the monitors been mounted properly?
� Use a line analyzer to check the wall outlets for power and ground. Is 

the wall outlet in both the control room and procedure room a duplex 
20 Amp circuit on the hospital emergency power?

� Is the conduit sized correctly and correctly installed?
� Make sure that all connections are complete and secure.
� If a line conditioner is to be used, make sure that it is connected now.
� Route all cables so that they will not be walked on, tripped over, or 

rolled on.
� Ensure that Network cables are correctly installed (Network option).
� Ensure that the floppy disk drive is empty.
� Turn on the power to the system at the IEB.
� Check the screen adjustments on each monitor. Is the picture 

centered, shaped properly, sized correctly, and the right color? Is 
there any color distortion indicating a need for degaussing the 
monitor? Moving the monitor may cause color distortion.
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Mac-Lab 2000/4000/7000

Connecting System Components
For complete information on planning for and assembling the system, 
mounting brackets, and options, see the following manual:

� Mac-Lab System EX RAU Mounting Kits Installation Manual 
This chapter is limited to an overview of the assembly/disassembly as it 
pertains to the repair of a unit already in the field.

Components
The components may vary depending on the options in use. These 
variations are covered in instructions that are provided with each option.

Catheterization Procedure Room
The components that are found in the catheterization procedure room 
are:

� Remote Acquisition Unit (RAU) or TRAM-net RAC 4a
� TRAM
� RAU mounting bracket
� Patient leads
� BP cuff SPO2 probe

� Analog output cable
� Analog input cable
� RAU data acquisition/power cable (from RA unit DB-15 to buffer 

plate DB-15 connection)
� Remote monitors
� Video cable
� Video power cable

Control Room
The components that are found in the control room are:

� IEB power cable
� Video power cables to IEB
� Video cables
� IEB
� Computer
� Workstation
� Printer
� Thermal Writer
� Image input cable (with Image option)
� Barcode scanner
� Network cable (with Network option)
� Local system monitors
� Mouse
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� Keyboard
� Analog phone line

Reviewing the Assembly
Before beginning to service the system, review the existing assembly to 
ensure that it is correctly installed and connected. This should be done 
prior to turning on the system. 

� Ensure that the power is off.
� Ensure that the components are conveniently positioned in the room 

and have adequate room for access and ventilation.
� Is the RA unit positioned so that the TRAM opening is not facing the 

ceiling or floor?
� Have the monitors been mounted properly?
� Use a line analyzer to check the wall outlets for power and ground. Is 

the wall outlet in both the control room and procedure room a duplex 
20 Amp circuit on the hospital emergency power?

� Is the conduit sized correctly and correctly installed?
� Make sure that all connections are complete and secure.
� If a line conditioner is to be used, make sure that it is connected now.
� Route all cables so that they will not be walked on, tripped over, or 

rolled on.
� Ensure that Network cables are correctly installed (Network option).
� Ensure that the floppy disk drive is empty.
� Turn on the power to the system at the IEB.
� Check the screen adjustments on each monitor. Is the picture 

centered, shaped properly, sized correctly, and the right color? Is 
there any color distortion indicating a need for degaussing the 
monitor? Moving the monitor may cause color distortion.



3-8 Mac-Lab/CardioLab Revision E
2007623-079

Installation: Installation

PK2



Revision E Mac-Lab/CardioLab 3-9
2007623-079

Installation: Installation

ComboLab 2000/4000/7000

Connecting System Components
For complete information on planning for and assembling the system, 
mounting brackets, and options, see the following manual:

� Mac-Lab System EX RAU Mounting Kits Installation Manual 
This chapter is limited to an overview of the assembly/disassembly as it 
pertains to the repair of a unit already in the field.

Components
The components may vary depending on the options in use. These 
variations are covered in instructions that are provided with each option.

Catheterization Procedure Room
The components that are found in the catheterization procedure room 
are:

� RAU or TRAM-net RAC 4A
� TRAM
� RAU mounting bracket
� Patient leads
� BP cuff SPO2 probe

� ECG cable
� Catheter input modules,
� Analog output cable, and 
� Analog input cable.
� Simulator and cables
� RAU data acquisition/power cable (from RA unit DB-15 to buffer 

Plate DB-15 connection)
� Remote monitors
� Video cables
� Video power cables
� Amplifier
� IEB
� Workstation
� RF generator
� Fiber optic cable
� Amplifier power cable
� Computer
� Thermal Writer
� IEB power cable
� Printer
� Barcode scanner
� Network cable (with Network option)
� Analog phone line
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� Mouse
� Keyboard
� Image input cable (with Image option)
� RF cable

Reviewing the Assembly
Before beginning to service the system, review the existing assembly to 
ensure that it is correctly installed and connected. This should be done 
prior to turning on the system. 

� Ensure that the power is off.
� Ensure that the components are conveniently positioned in the room 

and have adequate room for access and ventilation.
� Ensure that the RA unit is positioned so that the TRAM opening is 

not facing the ceiling or floor.
� Ensure that the monitors are mounted properly.
� Use a line analyzer to check the wall outlets for power and ground. Is 

the wall outlet in both the control room and procedure room a duplex 
20 Amp circuit on the hospital emergency power?

� Is the conduit sized correctly and correctly installed?
� Make sure that all connections are complete and secure.
� Ensure that the line conditioner being used is connected.
� Route all cables so that they will not be walked on, tripped over, or 

rolled on.
� Ensure that LAN cables are correctly installed (LAN option).
� Ensure that the floppy disk drive is empty.
� Turn on the power to the system at the IEB.
� Check the screen adjustments on each monitor. Is the picture 

centered, shaped properly, sized correctly, and the right color? Is 
there any color distortion indicating a need for degaussing the 
monitor? Moving the monitor may cause color distortion.
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Integrated Electronics Box
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CardioLink Diagram
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Changing the SA Password

If desired the system administrator can sa password.

On Server

������
Record the new password, as it will be needed for any future software 
upgrades.

To change the sa password on the server, follow these steps:

1. Login to the system as an administrator

������
See system administrator for login information.

2. Select Start > Programs > Enterprise Manager

3. Select Server > Security > Logins

4. Double-click on SA and change the password.

5. Click OK.

6. At the Confirm Password window, re-enter the new password and 
click OK.

7. Click OK.

8. Close Enterprise Manager.

On Acquisition and Review Systems

������
Record the new password, as it will be needed for any future software 
upgrades.

To change the sa password on an acquisition or review system, follow 
these steps:

1. Login to the system as an administrator

������
See system administrator for login information.

2. Select Start > Microsoft Access

3. At the Microsoft Access opening window, click Cancel.

4. Select File > New.

5. Double-click the Project (Existing Database) icon.

6. Enter a file name and click Create.

7. In the Connection tab, from the Select or Enter a server name 
dropdown box, select the local system name as the server name.

8. Select the Use a specific user radio button.
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9. Type the current username in the Username textbox.

������
The default user for version 5.2 is sa; for version 5.1D is clabsys.

10. Uncheck the Blank Password and Allow saving password 
checkboxes.

11. Type the current password in the Password textbox.

������
The default password for version 5.2 is gemssqladmin; for 
version 5.1D is clab.admin

12. From the Select the database on the server dropdown box, choose clab.

13. Click the Test Connection button.

14. At the Test Connection Succeeded window, click OK.

15. Once in the database, Select Tools > Security > Database Security.

16. Single-click sa.

17. Click the Edit button.

18. Type the new password in the Password textbox.

19. Click OK.

20. Type the new password in the Confirm New Password textbox and 
click OK.

21. At the SQL Server Login Properties window, click OK.

22. Close Microsoft Access.
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Introduction

Recommended Maintenance

This chapter provides preventive maintenance instructions for the 
system and its equipment and supplies. These maintenance guidelines 
are followed to prevent unnecessary equipment and supply failure and 
possible health hazards.

This chapter contains instructions for the following recommended 
maintenance:
� Inspecting and cleaning the unit
� AC line voltage tests to verify that the power outlet is properly wired
� Leakage tests to verify that the equipment does not pose a 

microshock hazard
� Ground continuity test to verify that all exposed metal is properly 

grounded

Operator’s Maintenance Schedule

This chapter contains maintenance schedules for users. The CathLab 
supervisor and assigned operators should perform the maintenance 
described.

Pre-service Procedures

Before you open the unit for maintenance or service, perform these 
required preparations:

� Turn OFF the system at the console and at the IEB, and unplug the 
IEB before servicing the equipment.

� Check the power cord, but do not remove it if you will be doing 
anything that requires a ground. The power cord should be removed 
for cleaning purposes. 

� Verify that the line, neutral, and ground wires are all connected 
firmly to the plug and that they are not shorted together.

Environmental Protection

Although the system operates in many different environments, some 
precautions are observed.

� Take care to avoid extremes of temperature, moisture, and humidity. 
The system components are not waterproof.

� Protect the various system components from spills or other debris. 
Eating, drinking and smoking should not be permitted near the 
system during a study or during maintenance procedures.
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Inspection and Cleaning

Precautions 

� Turn off the Integrated Electronics Box (IEB) and remove the power 
cord from the wall outlet before inspecting or cleaning. 

� Wear latex surgical gloves and follow hospital regulations when 
cleaning equipment that has been exposed to bodily fluids.

� Do not immerse any part of the equipment in water.
� Do not use organic solvents, strong ammonia-based solutions, or 

abrasive cleaning agents which may damage equipment surfaces.
� Do not use a cleaning solution or solvent on the diskettes or disk 

drives. Doing so can cause loss of data or damage to the data and/or 
drive.

� Do not use metal articles to clean the disk drives.
� Do not allow any magnetic material near the system unit.

Daily Visual Inspection

Operators should perform a general overall inspection daily. 
� Turn off the console and the IEB, and remove the power cord from 

the wall outlet before making an inspection or cleaning the unit.
� Check the case and display screens for cracks or other damage.
� Regularly inspect all cords and cables for fraying or other damage.
� Inspect all plugs, cables, and connectors for bent prongs or pins.
� Verify that all cords, socketed components, and connectors are 

securely seated.
� Inspect keys and controls for proper operation.

Toggle keys should not stick in one position.

Diskette drives should be fully functional.

Perform a visual exterior and interior inspection during preventive 
maintenance checks.

� Inspect interior for debris, oil, and moisture (liquid or condensation). 
Determine the source of the contamination and correct both the 
source and resulting problems.

� Inspect for missing hardware. Be sure that all components are 
present and intact. Socketed components should be firmly seated in 
their respective sockets. Check that all board components are 
properly attached, especially soldered components added as part of a 
repair or modification.

� Check for burn damage from overheated components. The familiar 
smell of burned components indicates that something has failed, 
even when there is no discoloration or disformation.

� Check that all printed circuit boards are seated properly if mounted 
in a card cage or connected to any type of edge connector. Make sure 
that all ground straps are connected.
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� Check that all power cords and interface cables are firmly connected, 
with no sign of excessive wear or excessive tension.

� Check that screws and other hardware connectors are in place and 
properly installed. Check the security of the Remote Acquisition Unit 
(RAU) mounting bracket. The knobs holding the RAU to the bracket 
should be tight. However, be careful not to strip the threads.

� Verify that the remote video monitors are properly secured to the 
mounting plates. Verify that the mounting plates are properly 
secured.

� Verify that the local monitors are properly placed or secured.
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General Maintenance

This section contains preventive maintenance instructions for the system and its 
equipment and supplies. These maintenance guidelines should be followed by the 
operator to prevent unnecessary equipment failure or possible health hazards. Before 
starting any maintenance, turn the system power off.

Cleaning the Exterior 

Clean the exterior of the system on a regular basis with a clean, soft cloth 
and a solution consisting of mild detergent diluted in water. However, 
avoid coming in contact with open vents, plugs and connectors of any 
kind, the keyboard, mouse, and the thermal printer. Thoroughly wipe the 
exterior of the unit with a lint-free cloth dampened with one of the 
following approved solutions, then dry it with a clean, soft cloth or paper 
towel. The cleaning agents include:

� Ammonia (diluted to 10% strength)
� Cidex
� Mild soap
� Sodium hypochlorite bleach (diluted to 10% strength)

To avoid damage to the equipment, follow these rules:

� Wring the excess cleaning solution from the cloth. 
� If exterior surface is swabbed with bleach or 10% ammonia solution, 

follow by swabbing with water.
� Always immediately wipe off all of the cleaning solution with a dry 

cloth or paper towel after cleaning.
� Never pour water or any cleaning solution on the equipment or 

permit fluids to run into the Thermal Writer, Console, AC 
Distribution Unit, RAU, monitors, connectors, or ventilation 
openings in the equipment.

� Never use these cleaning agents:
� Abrasive cleaners or solvents of any kind
� Alcohol-based cleaning agents
� Wax containing a cleaning substance
� Acetone
� Betadine

Failure to follow these guidelines may melt, distort, or dull the finish of 
the case, blur lettering on the labels, or cause equipment failures.
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Cleaning the Monitor Screens

Clean the monitor’s screen using a gentle commercial glass cleaner. 
Apply a small amount of cleaner to a clean, soft, anti-static, lint-free 
cloth, then use on screen. This method prevents excess cleaner from 
running inside of the monitor.
� Use a gentle commercial cleaner.
� Follow directions for use on product.
� Do not spray directly on the glass. 
� Use a clean, non-abrasive, soft, anti-static, lint-free cloth.
� Wipe glass carefully and allow to dry.

Cleaning EP Cables

GE’s electrophysiology cables are typically used outside the sterile zone 
and therefore are not routinely sterilized. The cables may, however, be 
cleaned using one of the following solutions:

� Ammonia (diluted to 10% strength)
� Cidex
� Sodium hypochlorite bleach (diluted to 10% strength)
� Mild soap
� Isopropyl alcohol
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Monthly Maintenance

Perform the following preventive maintenance on a monthly basis. 
Before starting any maintenance, turn off the system.

Cleaning the Print Head

Clean the thermal print head using isopropyl alcohol and a clean, soft cloth. Non-
abrasive alcohol wipes may also be used. To access the print head, open the writer 
door and wipe the print head where it makes contact with the capstan roller. Clean 
the roller when necessary with a small amount of alcohol. Excessive use of alcohol 
over time may cause the roller to crack. 

PK1
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Annual Maintenance

Perform the following preventive maintenance on an annual basis. 
Before starting any maintenance, turn off the Console and AC 
Distribution Unit, and remove the power cord from the wall outlet.

Cleaning the Interior 

Generally, it is not necessary to clean the interior of the system; however, 
if dust is an environmental problem, use a commercially available, 
electronically-safe, dust remover (compressed air, difluoroethane, or 
other). Follow the manufacturer’s directions for use. Note cautions about 
flammability, the possibility of ignition, and the possibility of causing 
frostbite. Be sure to clear the nozzle before use, hold the can upright, and 
do not allow liquid propellant to contact skin or electronics. Be careful 
not to drive dust into connections or disk drives.

Whenever an exterior spill occurs, you should completely turn off the IEB 
and remove power from the wall outlet. Clean up the spill, and check to 
be sure the spill has not penetrated the CPU, Thermal Writer, RAU, or 
IEB. If it has, carefully blot and dry the affected area. Do not reconnect 
power or turn the system on until you are sure no moisture remains.

Inspect All Cables, Plugs, and Connectors

Inspect all cords for fraying or other damage. Inspect all plugs and 
connectors for bent prongs or pins. Verify that all cords and connectors 
are securely seated. Repair or replacement must be performed by 
qualified service personnel.

Cleaning the RAU and TRAM

Check the RAU and TRAM modules for buildup of moisture, fluids, or 
dust. Clean the units in the same way as the exterior of the console, 
being careful not to allow any moisture into the unit.
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Preventative Maintenance

Perform the following general preventative maintenance.

� Make a backup copy of the hard drive onto a blank optical disk. This 
way, if any files ever become corrupt, a backup copy will exist to 
replace them.

� Test the integrity of the disk using scandisk or a similar utility found 
at the local computer store. DO NOT ATTEMPT TO REPAIR ANY 
PROBLEMS FOUND. Only diagnose the errors. If errors are found, 
contact technical support for assistance.

� Scan the hard disk for viruses using the recommended validated 
anti-virus software.

� Remove the fiber optic cable from the amplifier and computer and 
clean the contacts with rubbing alcohol and a clean, lint-free cloth. 
When finished, verify that you have connected the cables back 
correctly by acquiring a test patient in the software.

� Remove any dust or lint from inside the computer and IEB using 
electronics-safe compressed air. Do not use compressed air to clean 
the inside of the optical drive.

� Ensure that all cables connected to the monitors, IEB and computer 
are securely fastened.

� The standard life of the UPS ranges from 3 to 6 years. Test the UPS 
by turning the main power switch on, letting the computer boot 
completely and then unplugging the IEB from the wall. The 
computer should maintain power and the UPS will beep to indicate 
that power was lost to the system. If computer maintains power, the 
UPS is functioning normally.
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Domestic Electrical Safety Tests

AC Line Voltage Test

This test verifies that the domestic wall outlet supplying power to the 
equipment is properly wired. For international wiring tests, refer to the 
internal standards agencies of that particular country.

120 VAC, 50/60 Hz

Use a digital voltmeter to check the voltages of the 120-volt AC wall 
outlet (dedicated circuit recommended). If the measurements are 
significantly out of range, have a qualified electrician repair the outlet. 
The voltage measurements should be as follows:
� 120 VAC (± 10%) (108 to 132 VAC) between the line contact and 

neutral and between the line contact and ground. 
� Less than 3 VAC between neutral and ground. 

240 VAC, 50/60 Hz

Use a digital voltmeter, set to measure at least 300 VAC, to check the 
voltages of the AC wall outlet (dedicated circuit recommended). If the 
measurements are significantly out of range, have a qualified electrician 
repair the outlet. The voltage measurements should be as follows:
� 240 VAC (± 10%) (216 to 264 VAC) between either “hot” contact and 

ground.
� 216 to 264 VAC between the two “hot” contacts.

PK2
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Leakage Current Tests
The leakage tests are safety tests to ensure that the equipment poses no 
electrical microshock hazards. The specific leakage current tests and the 
frequency at which they should be performed should be determined by 
your facility. 

If the unit under test fails the leakage tests, do not allow the customer to 
use the equipment. Call Tech Support for assistance. (See the “How to 
Reach Us” page in the front of the manual.)

GE Medical Systems recommends that you perform these tests:
� Before applying power for the first time
� Every year as part of routine maintenance
� Whenever internal assemblies are serviced

You need a leakage tester to perform the leakage tests.

������
The accuracy of the leakage tests depends on a properly wired wall 
outlet. Do not proceed until you verify the integrity of the power 
source.

Special Test Considerations
When patient sink current is measured, it may be necessary to 
manipulate the patient cable to avoid excessive stray capacitance to 
ground, which may result in artificially high measurements.
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Ground Continuity

This test verifies that there is continuity (less than 100 mΩ resistance) 
between all the exposed metal surfaces on the console that have the 
potential to become energized, and the ground prong on the Mains AC 
power cord. 
� Measure the resistance between the equipotential lug on the back of 

the console and the ground pin on the AC inlet of the AC Distribution 
Unit. Repeat between the shell of the I/O port on the Thermal Writer 
and the ground pin on the AC inlet of the AC Distribution Unit. 

� If the measurements are significantly out of range, check for breaks 
in the power cord or in the internal connections within the unit.

Special Considerations
� To perform this test accurately, it is necessary to use a special 

ground impedance measuring device that can accurately measure 
low resistances while providing a significant amount of current (10 to 
30 A). This test cannot be performed accurately with a typical volt 
ohm meter.

� Because of the resistance in the power cables between the console or 
writer and the AC Distribution Unit, it is essential that special care 
is taken to obtain precise measurements. Resistance in test leads 
must be subtracted from an overall reading to accurately isolate the 
resistance in the equipment under test. 

� For a cursory field service check, a volt ohm meter may be used to 
verify continuity and that resistance is reasonable low (less than 0.3 
to 0.4 ohms, including test leads).

Maintenance/Repair Log

The Maintenance/Repair Log is included in this manual to aid in keeping 
a record of the work performed on the system.

������
Unless you have an Equipment Maintenance Contract, GE Medical 
Systems Information Technologies does not in any manner assume 
the responsibility for performing the recommended maintenance 
procedures. The sole responsibility rests wit the individual or 
institution using the equipment. GE Medical Systems Information 
Technologies service personnel may, at their discretion, follow the 
procedures provided in this manual as a guide during visits to the 
equipment site.
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Maintenance/Repair Log Table

Unit Serial Number: 

Institution Name:

Date Maintenance/Repair Technician
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Unit Serial Number: 

Institution Name:

Date Maintenance/Repair Technician
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Introduction

This chapter includes the following sections:

� General Troubleshooting for the system
� Troubleshooting the Remote Acquisition Unit (RAU)
� Troubleshooting the Video Processing
� Troubleshooting the Thermal Writer

Initial Inspection

The following are the most common causes for system failure:

� Ensure that the IEB, CPU, RAU, monitors, keyboard, and optional 
LAN are properly connected. If not, power down the system, connect 
the cables properly, and turn on the IEB.

� Ensure that the wall outlet is live. With a line analyzer, check the 
outlet for both power and ground.

� Ensure that a disk is not in the floppy disk drive. No disk should be 
present.

� Ensure that the IEB is turned on. 
� Ensure that the monitors are turned on.
� Ensure that the CPU is turned on.
� Ensure that nothing (other than a patient lead on the TRAM) is 

connected or disconnected while the system is under power. If so, 
turn off the IEB, reconnect the cables, and then turn the IEB on 
again.

Visual Inspection

A thorough visual inspection of the equipment can save time. Small 
things — disconnected cables, foreign debris on circuit boards, missing 
hardware, loose components — can frequently cause symptoms and 
equipment failures that may appear to be unrelated and which are 
difficult to track.
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General Troubleshooting for the System

Problems

No Boot Up
If the computer does not boot:

� Verify that the power cable from the workstation is plugged into the 
wall.

� Verify that the power cable is secure in the back of the IEB.
� Check the power cable from the IEB to the computer to verify that it 

is secure on both ends.
� With the IEB power switch turned on, try pressing the power switch 

on the CPU. This can be accessed by opening the right front panel on 
the workstation.

� Replace the power cables.

System Does Not Boot

Disk in Disk Drive
� Check to see if you left a disk in the floppy disk drive. If you did, 

remove the disk. Turn the system off and wait 10 seconds before 
turning the system on again.

� Check the IEB and then the other hardware.

System Locked Up
The system locked up and there is a patient on the table.

� If you are still able to monitor the patient, continue, but get 
assistance from Technical Support. See the How to Reach Us insert 
at the front of the manual.

� If you are not able to monitor the patient, recycle power on the 
system. Have hospital ready to put patient on standby equipment. 
Get assistance from Technical Support. 

If there is no patient on the table when the system locks up: 

� Turn the system off, wait ten seconds, then turn the system on again.
� If the system still does not work correctly, get assistance from 

technical support.

Multiple Monitors Change Colors
If more than one monitor changed colors, there is a possible VID/MUX 
problem. Get assistance from Technical Support. See the How to Reach 
Us insert at the front of the manual.
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Monitor Went Black (No Signal)

One Monitor Went Black (No Signal)
� If only one monitor went black, check to see if the power light is on. 
� If the power light is not on, check power to the monitor. 
� If the power is OK, the fuses are OK, and the power light is still off, 

the monitor needs to be replaced. 
� If the power light is on, hook the monitor up to another monitor 

signal cable. 
� If the monitor still does not work with a good known signal, the 

monitor must be replaced.

Multiple Monitors Went Black (No Signal)
If more than one monitor goes black, there is a possible VID/MUX 
problem. Get assistance from Technical Support.See the How to Reach 
Us insert at the front of the manual.

Take the time to make all the recommended visual checks (refer to the 
visual inspection chart on the next page) before starting any detailed 
troubleshooting procedures
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Inspection List

Table 1. Visual Inspection List (Continued)

Area Look for the following problems

I/O Connectors and Cables � Fraying or other damage

� Bent prongs or pins

� Damaged housing

� Loose screws in plugs

Fuses � Type and rating. Replace as necessary.

Interface Cables � Excessive tension or wear

� Loose connection

� Strain reliefs out of place

Circuit Boards � Moisture, dust, or debris (top and bottom)

� Loose or missing components

� Burn damage or smell of over-heated components

� Socketed components not firmly seated

� PCB not seated properly in edge connectors

� Solder problems: cracks, splashes on board, incomplete feedthrough, prior modifications or 
repairs

Ground Wires/Wiring � Loose wires or ground strap connections

� Faulty wiring

� Wires pinched or in vulnerable position

Mounting Hardware � Loose or missing screws or other hardware, especially fasteners used as connections to 
ground panes on PCBs

IEB � IEB not plugged in to working wall outlet.

� CPU or peripheral device not properly connected to AC Distribution Unit.

Power Source � Faulty wiring, especially AC outlet

� Circuit not dedicated to system

� Power source problems cause static discharge, resetting problems, and noise.
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Power On Failure Modes

No display, system appears not to initialize
Most errors will be displayed on the window. The following are additional 
things to check.

� Can you hear the floppy disk drive being accessed several 
seconds after Power On? The “in use” LED will come on at the 
same time. The keyboard LEDs will turn on at Power On and 
turn off just prior to the floppy disk drive’s LED turning on. 
These LEDs indicate that the PC/AT system (EPC-9) is 
functioning properly. 

� Is the floppy disk drive active?
If you do not hear the floppy disk drive, check the fuses and 
power.

� Several different failures modes may exist. If the floppy drive 
LED is never active and there is brief activity on the hard disk 
drive (listen for the drive activity or watch for the hard disk drive 
light), the problem is probably the floppy disk drive, and vice 
versa. 

If the two drives appear inactive at initialization, there is probably a 
controller failure.

� Is the Hard Disk Drive Active?
If the system appears to initialize, but there is still no display, 
listen for the hard drive or watch the hard drive light to see if the 
hard disk drive is active several seconds after turning the system 
on. This activation should occur shortly after you hear the floppy 
disk drive spin up. 

If the hard disk drive is not active, communication between the 
disk drive and the control board does not exist, and the software 
is not being loaded into the system from the drive. The hard disk 
drive should be active for about 17 seconds, indicating that it is 
loading software for the entire system. If it is on for only about 2 
to 3 seconds, then it is not loading the software.

� Is the COMMS board active? Check for the green LED on the 
COMMS board.

If the system appears inactive, observe the LEDs on the COMMS 
board. After Power On, the green LED should be on.

� Is the software present?
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Functional Checkout Procedure

Introduction

As part of the system checkout procedure, hook up a simulator to the 
TRAM module in the RAU or the CardioLab II Plus Amplifier located in 
the procedure area. 

1. If a GE or Bio-Tek simulator is being used, connect the P1 output to 
the P1 input of the TRAM module in the slot A position.

2. Connect the P2 output to the P2 input of the same TRAM module. 

3. Define the pressures to be Arterial and Venous. These two pressure 
simulations provide a realistic representation of pressure monitoring 
waveforms. 

4. Also connect the ECG leadwires. 

See the “TRAM 100-600 A and SL Modules Service Manual” for 
additional information. 

System Initialization

After you are sure that the system is properly connected, the peripherals 
are turned on, and there is no disk in the floppy disk drive, you can 
Power On the system.

1. Turn on the IEB and CPU power switches.

2. Verify that the image fills the entire window and that the colors are 
correct. If there appear to be video problems, refer to the “Video 
Failure Modes” on page 5-13. If the system does not successfully 
initialize, refer to “General Troubleshooting for the System” on 
page 5-4.

Front End Data Acquisition

1. Adjust the simulator so that the BP waveforms are zero. 

2. Re-adjust the simulator so that it is simulating BP waveforms. If you 
have hooked up the simulator as recommended, you should see 
pressures in the window.

3. Verify that the correct ECG waveforms are present at the top of the 
window.

4. Verify that intracardiac inputs are present. Hook simulator ECG 
outputs to catheter input modules.
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Troubleshooting the RAU

RAU Description 

This section is designed to clarify operation and troubleshooting of the 
RAU and its interfacing with the Mac-Lab/CardioLab system. The RAU 
is also called the “Front End”. Introductory material on the system 
configuration is followed by specific symptom-dependent troubleshooting 
techniques. Front end data, ECG, and invasive blood pressures, are 
acquired by using a TRAM module installed in an RAU.

Each system is shipped with either one or two TRAM modules capable of 
providing up to 12 ECG waveforms and up to 4 pressure waveforms. Note 
that the system RAUs for earlier MAC-LAB units are different from the 
Mac-Lab/CardioLab system RAU. They cannot be interchanged. Older 
RAUs have room for three TRAMs (one was not functional). 

The system RAUs have room for only two. The system RAU receives its 
power and data via a single cable rather than via separate power and 
data cables. The system RAU does not have an on/off switch.

TRAM modules in the RAU

The TRAM modules are installed in the RAU that is mounted in the 
procedure area. Power for the RAU comes from the Console. 

RAU Interconnection
The TRAM series of modules, used with the system RAU, has only one 
indicator, the power-on indicator.

If the system is operating with one TRAM module, it must be in the slot 
A position (top slot) in the RAU. Otherwise, there are no ECG 
waveforms.

The RAU receives its power from the IEB.

Data Transmission 
The serial data from and to the TRAM module is communicated via a 
DB-15 connector on the rear DB connect board on the IEB. The cable also 
carries power for the RAU. The data is then communicated to the 
COMMS board.

The COMMS board must be working in order for the system to initialize. 
The error message “No TRAM module” appears on the review monitor 
window if communication with the TRAM fails. 

RS-422 serial communication at a rate of 115 K baud is used between the 
RAU and the COMMS board.
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Pressure Waveforms 
Individual waveforms may be removed from the monitor window by 
selecting that pressure and turning off the pressure. This removes the 
trace. 

Channel is labeled, but no pressure values are listed:
If there is a label, but no pressure numbers, and a transducer is 
connected, a zeroing procedure may be required.

Channel is labeled, but no pressure values or waveforms:
If a pressure site label is present, but there are no pressure numbers, a 
waveform may or may not be present. Check the pressure gain of the 
system.
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Troubleshooting the Video Processing 

General Information 

The system video consists of one or more color monitors. For most 
configurations, two are mounted on the workstation and at least one is 
mounted in the catheterization procedure lab. At the desk are the real-
time and review monitors. In the catheterization procedure lab is a 
remote monitor, which is a slave of the other monitors.

The review monitor displays waveforms and system-related information 
and allows the technician to operate the system via the menu bar at the 
top of the window. 

The real-time monitor displays real-time data, such as ECG and blood 
pressure waveforms. The monitor in the catheterization procedure lab 
can display either workstation monitor signal, allowing the doctor to 
track monitoring and measurement functions.

MENU +- POWER POWER SWITCH

POWER INDICATOR

+ BUTTON (Next Choice)

- BUTTON (Previous Choice)

MENU (also ACCEPT)

D-SUB Mini 15 Pin Connector

Red

Green/Sync

Blue

H/HV

V

AC IN Connector

V H/HV B G/SYNC RAC IN D-SUB

PK1
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Monitor Description 
All monitors are color monitors that are controlled by the video boards in 
the computer. The monitors themselves are not serviced by GE Medical 
Systems Service, but are sent back to the manufacturer for repairs. 
However, there is a window calibration procedure that includes 
brightness and position of the tracings. Several brands of monitors have 
been used. All are essentially the same, but have different controls.

Installation Checklist
� Be sure that the ventilation openings are not blocked or covered.
� Do not place the monitor near a heating appliance or in direct 

sunlight.
� Do not expose the monitor to moisture of any kind, as this may result 

in electrical shock or fire hazard.
� Route the power cord and cables so that they will not be walked on, 

tripped on, or rolled over. The monitors should be powered via the AC 
outlets in the lab or should be connected to one of the outlets on the 
IEB.

� Never use a monitor if the power cord has been damaged.
� Unplug the monitor and clean the window as needed with a small 

amount of a mild glass cleaner sprayed on a soft cloth. Never spray 
cleaner directly on the window as it may penetrate the monitor 
enclosure.

� Never open the enclosure. There are no user-serviceable parts inside. 
Risk of serious shock hazard! Refer all monitor problems to GE 
Service personnel.
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Video Failure Modes 

Color Distortion 
Demagnetize the monitor window by pressing the degauss switch, 
which generally is located just below the monitor window or can be found 
by pressing the MENU button. 

One or More Colors Missing on Monitor 

1. Confirm that cabling for all three colors is connected to the monitor 
and that the cabling is properly connected to the rear interconnection 
panel and to the Video/Writer board in the console.

2. If the problem moves to the other monitor, then replace the defective 
board. 

3. Otherwise, replace the monitor. 

Video Signal on One Monitor is Distorted or Missing:

1. If video signals are not present, verify that monitor is receiving 
power.

2. Take the video cable from the back of the working monitor and plug 
it into the monitor with the bad signal. This will verify that the 
monitor works.

3. If the step above produces a good image, try replacing the video cable 
from the VIDMUX to the monitor.

4. If problem continues, replace cable from the associated video signal 
input on the VIDMUX to correct video board the computer.

5. If the problem persists, the problem may be with the system 
hardware.
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Thermal Writer Problems

Thermal Writer Starts to Print, then Stops on its Own
Check and clean dust from the paper sensor by using canned air. Paper 
sensor is located on the left side of the top of the paper slot. If the 
thermal writer still fails to work properly, get assistance from Technical 
Support.

Thermal Writer Outputs Blank Sheets of Paper
Check and clean dust from the paper sensor by using canned air. Paper 
sensor is located on the left side of the top of the paper slot. If the 
thermal writer still fails to work properly, get assistance from Technical 
Support.

Thermal Writer Does Not Print (Blank Sheets Only)
If the thermal writer prints only blank sheets of paper, the paper may be 
installed upside down. Try flipping paper end for end. The top side of the 
paper should mark easily if scratched. Verify that the correct paper is 
being used. If the thermal writer still does not work correctly, get 
assistance from Technical Support.

Paper Jams During Printing
Verify that correct paper is being used. If the thermal writer still does 
not work correctly, get assistance from Technical Support. 

Thermal Writer Does Not Print, Makes Machine Gun Noise
A machine gun noise indicates a possible hardware problem. Get 
assistance from Technical Support. Replace the thermal writer.
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Troubleshooting the Thermal Writer 

Thermal Writer Description 

The system uses a direct digital writer with an 8.5-inch thermal print 
head. The paper is a plain, fan-fold style with no pre-printed grid. The 
system prints the necessary grid at the same time as it prints the 
waveforms and text. The thermal writer can run at four speeds: 5, 25, 50, 
and 100 mm/sec. Paper is stored in a slot backed by a paper strap that 
slides in and out for ease of replacement. 

The thermal writer release button, which disengages the print head and 
opens the door, must be pressed before closing the door as well. When the 
door is open the 26.5 volt power is removed from the printhead, but not 
from the thermal writer control board. The 5 volt power is still on the 
print head. The print head assembly is located inside and above the door. 
This allows easy access for cleaning and replacement.

Repairing the Thermal Writer

Generally, the only in-field repair of the thermal writer is to replace the 
print head or anti-static brush. Replacing the printer engine in its 
bracket requires the use of a fixture, and so is performed only at the 
factory. Likewise, the electrical adjustment is only done at the factory. 
This is different from older MAC-LAB procedures.

Thermal Writer Failure Modes 
Chart paper will not queue. Thermal writer runs extra sheets of blank 
paper.

� The queuing sensor could be dirty. Clean the queuing sensor by 
blowing air across it. 

Erratic or no chart paper drive 
� If the paper does not advance, or it advances erratically and there is 

no error message, check the fixed and movable cables that connect 
along the side of the writer drawer. Confirm that there is a solid 
connection.

� Verify that all required conditions are met to enable the thermal 
writer. 
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Printing too light or too dark 
If the thermal print head voltage is too low, the printing may be too light, 
and the traces may fade prematurely. If the voltage is too high, the 
printing may be too dark and the life of the print head will be shortened. 
Voltage adjustments must be performed at the factory.

� Check the thermal paper quality. Some non-GE thermal papers are 
more heat-sensitive than others. 

� Check print head voltage to ensure that it is in range: 24V to 27V.
� If there is no other reason, replace the Thermal Writer. 

White line running across the printing 
� Clean the print head and the print roller. If the lines still occur and 

they are obscuring the tracings, replace the print head. 

RAU Failure Modes

ECG labeled, but no ECG data
These symptoms indicate no communications with the TRAM modules. 
Confirm that each TRAM module is installed and that the RAU is 
plugged in. 

Check that the cable is connected on the back of the RAU (DB-15 
connector) and is connected on the rear DB connect board on the IEB 
(DB-15 connector). 

Is the power-on LED on the TRAM module illuminated? Try switching 
the position of the TRAM modules. 

BP sites are labeled, but no pressure numbers or waveforms 
This condition indicates that a transducer needs to be zeroed or replaced. 
Rezero this BP by selecting the correct channel and pressing the Zero 
button. This could also be a TRAM module problem. 

BP waveforms are present, but no ECG waveforms 
Some patients require skin preparation, including abrasion, depending 
on their skin type. 

If the BP waveforms are present, and the ECG cable is properly 
connected, ensure that the ECG waveforms have not been turned off.

If the ECG waveforms are selected, are not turned off, and still are not 
present, suspect a TRAM module failure. 

ECG waveform is present, but one or both BPs are missing 
Has the BP trace been turned off at the keyboard? Try rezeroing and 
replacing the corresponding transducer. This situation also could be a 
TRAM module failure.
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Server UPS Troubleshooting

The following tables provide troubleshooting information for the Tower 
UPS. For more detailed information, see the OEM manuals included 
with the UPS.

For troubleshooting recommendations for the rack-mount server UPS, 
see the OEM manuals.
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During Start

After Start

Symptom Possible Cause Suggested Action

UPS will not 
start

No Utility Power Check Power at the Utility power receptacle or 
contact a qualified electrician.

UPS Power cord 
disconnected

Connect the power cord.

UPS input circuit 
breaker open

Press the circuit breaker button to reset. If the 
breaker trips repeatedly, contact an authorized 
service provider (high models only).

LED 5 is red 
(Site wiring 
fault)

Utility power receptacle 
ungrounded or no 
ground wire in UPS 
power cord

Contact a qualified electrician.

Line and neutral wires 
reversed in utility power 
receptacle or in UPS 
power cord

For units factory-configured for 208V, the Site 
Wiring Fault function has been disabled. If 
reconfiguring a 230V unit to operate at 208V, the 
Site Wiring Fault function must be manually 
disabled (high models only).

LED 10 is red 
(Battery 
Service)

Battery voltage is low 
because the UPS has 
been out of service for 
a long period

Allow the UPS to charge the batteries for 24 
hours. Initiate a self-test: if LED 10 does not turn 
off, replace batteries.

The UPS was powered 
on with the Sleep mode 
disabled, draining the 
batteries

Utility voltage has returned to the voltage range 
for which the UPS has been configured. The 
UPS is supplying utility power. The audio alarm 
should be reset.

Symptom Possible Cause Suggested Action

Audio Alarm Alarm condition exists Identify the red LED associated with this alarm 
condition. Check this troubleshooting guide to 
determine the cause of the alarm.

LED 1 is red 
(Input power)

Utility voltage is too 
high

The utility voltage is higher than the UPS 
operating range. The UPS switches to battery 
power. If this happens repeatedly, update the 
configuration.

LED 1 is 
flashing red

Alarm may need to be 
reset

The utility voltage has returned within the UPS 
operating range. Press the TEST/ALARM 
RESET button.
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LED 4 is red 
(Input power)

Utility voltage is too low The utility voltage is lower than the UPS 
operating range. The UPS switches to battery 
power. If this happens repeatedly, update the 
configuration. Contact a qualified electrician to 
make sure that utility power is suitable for the 
UPS.

LED 4 is 
flashing red

Alarm may need to be 
reset

The utility voltage has returned within the UPS 
operating range. Press the TEST/ALARM 
RESET button.

UPS frequently 
switches 
between utility 
and battery 
power

Utility power variations The utility voltage is frequently outside the UPS 
operating range. Update the configuration. 
Contact a qualified electrician to make sure that 
utility power is suitable for the UPS.

LED 11 is red Protected devices are 
exceeding the UPS 
power rating

Remove one or more devices to reduce the 
power requirements.

(UPS may switch from 
utility to battery power)

Make sure that the devices are not defective.

LED 9 is red 
(Battery 
Charge)

Low battery voltage If the UPS is supplying battery power, save 
current work and shut down the system. Allow 
the batteries to charge. If the UPS is supplying 
utility power, no user intervention is required. 
Allow the batteries to charge.

Insufficient 
warning of low 
batteries

Battery service 
required

Allow batteries to charge for 24 hours, then 
initiate self-test. If LED 10 is red, replace 
batteries.

Shutdown Delay 
configuration 
inappropriate

Update the Shutdown Delay from 5-seconds to 
3-minutes. Use Compaq Power Management 
Software to specify a suitable delay.

LED 10 is red 
(Battery 
Service)

Potential battery failure 
detected

Allow batteries to charge for 24 hours, then 
initiate self-test. If LED 10 is red, replace 
batteries.

New batteries 
improperly connected

Check connections.

LED 10 is 
flashing red; 
audio alarm 
cannot be 
silenced

Internal UPS over-
voltage condition exists

Shut down the UPS. Contact an authorized 
service provider.

Symptom Possible Cause Suggested Action
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UPS Alarm Conditions

Silencing an Audio Alarm
To silence the alarm, press the TEST/ALARM RESET button.

� Even though an audio alarm may be silenced, the condition that 
caused the alarm may still exist. For information on procedures 
to follow if the UPS detects an alarm condition, see the 
Troubleshooting chapter or the UPS manual.

� If a utility power failure caused the alarm (AC Input LED 1 or 
LED 4 red), the alarm will be silenced after utility power is 
restored.

Alarm 
Condition

LED Activity Can be disabled?

Utility power 
failure

LED 1 or LED 4 red Yes

Site wiring faulty LED 5 on red Yes

Battery service LED 10 on red Yes

Internal UPS 
over voltage

LED 10 flashing red No
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TRAM-net 4A LED Troubleshooting Chart

Use the following chart to determine if the TRAM-net 4A is functioning 
properly. This chart refers to LEDs on the Processor Acquisition PCB. 
For problems, refer to the appropriate manual for more information 
about troubleshooting a patient monitor and TRAM-net housing 
together.

������
“I hear talking on my TRAM-net” LED flashes:

� with the “I am talking on TRAM-net” LED and
� alone when someone else is talking.

Processor Acquisition PCB Indicators

LED/Color Signal Name Function Condition

DS6/Green Power Indicator Proper Operation
� Visible on TRAM-net 4A front 

bezel (lower left)

� On Continuous: normal operation
� Flashing Quickly (2Hz): ADC Error
� Flashing Slowly (0.5Hz): watchdog time-outs
� LED Off: power off, supply fault, RAC FPGA 

configuration fault

DS5/Red Network Activity I hear talking on TRAM-net � On mostly steady: TRAM-RAC connected
� Flickers low: TRAM-net not connected (I hear myself 

talk)

DS4/Green Transmit Enable I am talking on TRAM-net � Flickers occasionally: when talking
� On continuous: while graphing

DS3/Yellow Error Detect I detect an error on this PCB � Off: normal operation

DS2/Red RAC COMM 80C152 COMM Processor is OK � Flashes with DS1 (twice per second): normal 
operation

DS1/Red RAC DAS 80C31 DAS Processor is OK � Flashes with DS2 (twice per second): normal 
operation
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CardioLink Utilities Troubleshooting

The information below should be used when errors are encountered with 
the CardioLink Utilities software. Currently, the components are 
Archive, Restore and Purge. Most errors are logged in the Windows NT 
Application Log. Errors documented in the Windows NT Application log 
will be identified in the error box displayed in the Utilities user interface.

Error Solution

DB Version Error Archive utility has detected a Clab database version 
different that expected. Upgrade Mac-Lab/CardioLab 
software to 5.1D or 5.2 as applicable.

One of the study paths is invalid (viewed on Mac-Lab/
CardioLab machine)

Attempting to review study while archive is in progress. 
Wait for archive to complete, then restore study if 
necessary.

Study skipped because it is in use Study is currently being accessed from an acquisition or 
review system. Study will be skipped for this archive

Study on Acquisition System Study has been skipped because it has not been 
archived to the server. Run archive generator (AG.exe) 
on the acquisition system before attempting to archive 
patient.

Error writing to purgelog or archivelog tables Utilities software could not write to the archivelog or 
purgelog files. Files are either missing or corrupt. 
Contact technical support.

Minimum free space exceeded There is not enough free space in the archive area to 
continue the archive process. Free up space in the 
archive area, or reduce the amount of free space 
required in the utility.

Study skipped because is has just be restored Recently restored studies will be skipped in the archive 
process.

Insufficient disk space Archive area has run out of disks space. Free up disks 
space in the archive area or select a different archive 
area in the utility.

Invalid Archive Path Archive path no longer exists or is inaccessible. Contact 
your network administrator.
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Recovery Procedures: 

For your notes



Revision E Mac-Lab/CardioLab 6-3
2007623-079

Recovery Procedures: CardioLink Server (5.2)

CardioLink Server (5.2) 

Introduction

This section contains instructions for re-imaging the Server for Disaster 
Recovery and Restoring Data from Backup for a CardioLink 5.2 Server. 
The re-image procedure should be used in the event of catastrophic 
server failure to restore the server to its state previous to problems 
occurring. The “Restore data to the server” on page 6-22 should be used 
when there is a need to only restore the database or patient data in the 
event of data corruption or suspected data corruption. 

������
This procedure can only be run if there is a current 5.2 tape backup.

Sections “Ensure 5.2 backup tapes exist” through “Backup LMT Custom 
Reports” assume that the server operating system is accessible. If the 
server cannot be booted completely, skip to section “Re-Image Server (G3 
Only)” on page 6-9, or “Re-Image Server (G1 and G2 Only)” on page 6-15 
depending on the type of server being reimaged.

Required Parts

Not all of the software listed below may be installed on a particular 
server.

Part Number Description Required for

2017591-001 G3 Server Image CD G3 Servers

2024636-001 MEGA SERVER PARTITION UPGR TOOL 5.2 CD G3 Server

2007041-001 Image Cast Boot Floppy G1/G2 Servers

2007004-002 Low-End Server Image CD v1B G1 Servers

2007005-002 Mid-Level Server Image CD v1B G1 Servers

2007006-002 High-End Server Image CD v1B G1 Servers

2009336-001 Low-End Server Image CD v1B G2 Servers

2009338-001 Mid-Level Server Image CD v1B G2 Servers

2009340-001 High-End Server Image CD v1B G2 Servers

2006556-008 Prucka CardioLink version 1.1D CD G1/G2 Servers

2015220-001 Core Update CD G1/G2 Servers

2015222-001 CardioLink 5.2 CD G1/G2/G3 Servers

2023718-001 HP/Sony AIT Driver CD G1/G2/G3 Servers

2015474-001 LMT 1.3C Server CD G1/G2/G3 Servers

2015472-001 LMT 1.3C Client CD G1/G2/G3 Servers
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Ensure 5.2 backup tapes exist

Before reimaging, ensure a full set of 5.2 (both full and incremental) 
backup tapes are available. 

������
Any studies performed since the last backup must be reviewed 
from the optical drive after the disaster recovery procedure is 
completed.

Stop data replication on the server

Perform this procedure if the server is still running. If not, skip to 
“Replace the Server Hard Drive (if applicable)” on page 6-9

1. At the server, log in as mlcltechuser.

2. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

3.  Under SQL Server Group, navigate to and highlight the server.

4. Select Tools > Replication > Disable Publishing.

5. Click Next.

6. Select Yes, disable publishing on [Server name] and click Next.

7. Click Next in the Confirm Dropping of Publications window.

8. Click Finish in the Completing the Disable Publishing and 
Distribution Wizard window.

9. Click OK.

10. Right-click the server name and select Refresh.

11. Expand the server.

12. Verify the Replication Monitor is NOT visible.

13. Close the SQL Server Enterprise Manager window.

2017867-001 LMT Backup/Restore Utility CD G1/G2/G3 Servers

2006961-001 LMT Options Floppy Disk G1/G2/G3 Servers

2017869-001 LMT and ML-CL Serial Number Update CD G1/G2/G3 Servers

N/A GEMS Advanced Security Floppy Disk (should be on-site) G1/G2/G3 Servers

Part Number Description Required for
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Stop data replication and disable networking at each acquisition 
system

Ensure replication on the old server is stopped before completing this 
procedure (see “Stop data replication on the server” on page 6-4).

Stop replication

1. At the Acquisition system, log in as mlcltechuser.

2. Right-click the My Computer icon from the Desktop and select 
Explore.

3. Navigate to D:\Gemms\Prucka\Network

4. Double-click StopRepl.bat 

A Command Prompt window opens and the file runs.

5. Press the Enter key when prompted to press any key.

Disable networking

1. Double-click the GE Medical Systems icon on the Desktop.

2. Select Administration > System Settings from the main menu. 

3. Browse to the File Paths section.

4. Uncheck the Enable Network Storage checkbox.

5. Click Close.

6. Close all open windows.

7. Repeat the “Stop Replication” and “Disable Networking” steps on 
each Acquisition system.

Back up custom lists and reports

This procedure is done in case the custom lists and reports are lost. It 
may be completed at any Acquisition system.

Backup Custom Lists
1. Double-click the GE Medical Systems icon to start the Mac-Lab/

CardioLab application.

2. In the Navigator window, select Utilities > Export Lists.

3. Click Next in the Data Export Wizard window. 

4. Select the backup location and click OK.

5. Click OK when the Success message is displayed.
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Backup Custom Reports

1. In the Navigator window, select Utilities > Export Report Formats.

2. Click Next in the Report Export Wizard window. 

3. Select the backup location and click OK.

4. Click OK when the Success message is displayed.

5. Close all open windows.

Record system information at the server

Perform this procedure if the server is still running.

1. At the Server, log in as mlcltechuser.

2. Right-click the Network Neighborhood icon on the desktop and select 
Properties.

3. Select the Identification tab and record the computer name and the 
domain/workgroup in the table below.

A sample table is shown below. You may also want to take screen 
captures of each tab and save them into the backup folder to ensure 
all information is captured exactly.

4. Select the Protocols tab.

5. Highlight the TCP/IP Protocol and click Properties. Record the IP 
Address, subnet mask and default gateway information.

6. Select the DNS tab and record any DNS servers listed.

7. Select the WINS Address tab and record any WINS servers listed.

8. Record whether the Enable lmhosts lookup checkbox is checked.

Use the table below:

Network Settings

Computer Name

Domain/Workgroup

IP Address ______-______-______-______

Subnet Mask ______-______-______-______

Default Gateway ______-______-______-______

DNS Server ______-______-______-______

______-______-______-______
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9. Click OK to close the TCP/IP Properties window.

10. Click Close to close the Network Properties window.

11. Click No at the restart computer message (if appears)

Record Microsoft security patches installed

Perform this procedure if the server is still running.

1. Navigate to Start > Settings > Control Panel 

2. Double-click Add/Remove Programs.

The base image includes the following patches:

� Windows NT 4.0 Hotfix (Q29944440)
� Windows NT 4.0 Service Pack 6

3. Record all other Microsoft security patches listed.

Record LMT information

Perform this procedure if the server is still running.

1. Check for LMT database.

If the LMT database is installed, Lab Management Tools 1.3 Server 
is listed in the Add/Remove software window.

2. Check for LMT client. If the LMT client is installed, Lab 
Management Tools 1.3 Client is listed in the Add/Remove software 
window. If the client is installed check the version:

a. Select Start > Programs > Lab Management Tools 1.3 Client > 
Lab Management Tools 1.3 Client.

b. Log in as sa with a blank password.

c. From the Main menu select Help About. Check the build number

� 0055 = Version 1.3C
� 0054 = Version 1.3B

d. Close Help window and then the LMT application.

3. Check for LMT serial number update.

If the LMT serial number update is installed, Mac-Lab/CardioLab 
5.2 SP1 is listed in the Add/Remove software window.

4. Close all open windows.

WINS Server ______-______-______-______

______-______-______-______

Enable lmhosts? Yes/No

Network Settings
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Check for advanced security

Perform this procedure if the server is still running.

1. Select Start > GE Security Mode.

2. One of two security options is displayed:

� Enable Advanced Security. This option indicates the system is at 
standard security. No action is required. Continue with the next 
procedure.

� Reset to Standard Security. This option indicates the system is at 
Advanced Security. To continue, the Gems Advanced Security 
floppy is required (it should be available at the site--check with 
the system administrator).
If the floppy is unavailable, all systems must be changed back to 
Standard Security and then re-promoted to Advanced Security 
(with the assistance of the facility). 
����

Refer to the 5.2 Advanced Security Guide for more 
information.

Record job schedules

Perform this procedure if the server is still running. Use the table below 
to record job schedules:

1. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

2. Navigate to and expand the server.

3. Navigate to Management > SQL Server Agent > Jobs.

4. Right click on the first job listed in the table above and select 
Properties.

5. Select the Schedules tab.

6. Record the job schedule in the table above.

7. Click OK to close the Job Properties window.

8. Repeat steps 4-7 for each job listed in the table.

9. Close Enterprise Manager.

Job Date Time

Backup Master and MSDB 
databases

Database Maintenance

Enterprise Backup

Full Tape Backup

Incremental Tape Backup
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Backup LMT Custom Reports

Skip this procedure if the customer is not using LMT Custom reports or 
the customer has previously backed up the clink_drk.mdb file. The 
customer is responsible for backing up the clink_drk.mdb file because the 
is not backed up as part of the INW backup procedure or the optical 
backup performed earlier.

������
This file must be saved to a network storage location. If 
necessary, contact the system administrator for an appropriate 
location.

1. Right-click My Computer and select Explore.

2. Navigate to D:\Program Files\Gems\Lmt\Client\Resource Kit.

3. Right-click clink_drk.mdb and select Copy.

4. Navigate to the network storage location folder.

5. Right-click on the folder and select Paste.

Replace the Server Hard Drive (if applicable)

�������
LOCK OUT/TAG OUT

Use appropriate Lock Out/Tag Out procedures before 
performing any service on potentially energized 
equipment.

�������
Electrostatic discharge (ESD) can damage electronic 
components. Be sure you are properly grounded before 
opening any equipment.

Ensure the new hard drive is exactly the same as the old one (type, size, 
etc.). Consult GE Technical support with any drive replacement 
questions.

Re-Image Server (G3 Only)

Perform this procedure only for a G3 server. For G1/G2 servers, go to 
“Re-Image Server (G1 and G2 Only)” on page 6-15

Insert the G3 Server Image CD (p/n 2017591-001) and reboot the 
server.
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1. At the!!Warning!! This utility will re-image this.... screen, press any 
key to continue with the re-image.

2. The Symantec Ghost 7.5 screen will appear monitoring the progress 
of the image process. This screen will appear twice, once for the 
image and once for the CRC.

3. The CardioLink Imaging Manager screen will appear, verify that it 
states:

Image: Success

CRC: Success

4. Press any key to continue, the system will reboot.

5. When the computer begins to reboot remove the G3 Server Image 
CD.

������
After the computer reboots, a message stating Additional files will 
now be setup and configured. Your system will reboot several times 
during this process. You will be notified when this process is complete. 

6. At the message “Would you like to change the Windows NT 4.0 
License number” click Cancel.

7. At the windows script host message “This utility can be run from 
d:\gemms\prucka\ntos\image\gems_lic.vbs” click OK.

8. Once the message Setup has completed, click OK and continue with 
the configuration. Proceed with the Repartition of the Hard Drive 
section if you have reimaged a high-end mega server (D:\ storage 
capacity approximately 675GB), otherwise proceed to the “Load AIT 
tape driver” on page 6-21.

Repartition the Hard Drive
Perform the next procedure only if the server hard drive capacity is more 
than 500 GB.

������
To find the approximate hard drive capacity of the server, open the 
server and add together the drive sizes listed on each drive label. 
Then subtract one drive. 

For example, the capacity of a G3 server with six 146 GB drives

6 x 146 GB = 876 GB

876 GB - 146 GB = 730 GB (approximate capacity)

If the hard drive capacity is not greater than 500 GB skip this section 
and go to “Load AIT tape driver” on page 6-21.

Required parts: Mega Server Partition Upgrade 5.2 CD (p/n 
2024636-001)

1. Log in as mlcladmuser (contact GE Technical Support or the 
system administrator for password information).



Revision E Mac-Lab/CardioLab 6-11
2007623-079

Recovery Procedures: CardioLink Server (5.2)

2. Insert the Mega Server Partition Upgrade 5.2 CD (p/n 2024636-
001) into the drive.

3. Right-click My Computer and select Explore.

4. Navigate to the CD and double-click PreUpgrade.bat.

A command window opens with a prompt to press any key to 
continue. 

5. Press Enter.

The pre-upgrade scripts run. When complete, a prompt to press any 
key is displayed.

6. Press Enter.

The command prompt window closes and the system reboots.

7. Log in as mlcladmuser (contact GE Technical Support or the 
system administrator for password information).

8. Go to Start > Programs > Administrative Tools (Common) > Disk 
Administrator

The Disk Administrator loads. 

9. Click OK at the confirmation screen.

10. Click Yes at the confirmation window to write a signature on Disk 0.

Wait for the Disk Administrator to complete this process.

11. Right click on the D: drive and select Delete (see Figure 001).

Figure 001

12. Click Yes to the All data will be lost confirmation message.

The partition name changes from Data (D:) to Free Space.
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13. Right click on the Free Space partition and select Commit Changes 
Now…(see Figure 002).

Figure 002

Click Yes in the confirmation window.

14.  Click OK to confirm the disk was updated successfully.

15. Right-click on the Free Space space and select Create (see Figure 
003).

Figure 003

16. Click Yes in the confirmation window.

Ensure the Create partition of size is set to the maximum (see Figure 
004).
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Figure 004

17.  Click OK.

18. Click Yes in the confirmation window.

19. Right-click Unformatted Space and click Commit Changes Now...(see 
Figure 005).

Figure 005

20. Click Yes in the confirmation window.

21. Click OK.

22. Right-click on the Unknown space and select Format (see Figure 
006).
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Figure 006

23. The Format D:\ window is displayed. Change the File System from 
FAT to NTFS and check the Quick Format box. Then click Start (see 
Figure 007). 

Figure 007

24. Click OK in the Warning window to format the disk.

25. Click OK to Format Complete.

26. Close the Format D:\ window.

Verify the Disk Administrator window shows the following (see 
Figure 008).
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Figure 008

27. Close the Disk Administrator Window.

28. Right-click on My Computer and select Explore.

29. Navigate to the CD and double-click PostUpgrade.bat.

A command window opens with a prompt to press any key to 
continue. 

30. Press Enter.

The post-upgrade scripts run. When complete, a prompt to press any 
key is displayed.

31. Press Enter.

The command prompt window closes.

32. Remove the CD from the drive.

33. Restart the system to ensure all the services restart.

34. Skip the next procedure and go to “Load AIT tape driver” on page 6-
21.

Re-Image Server (G1 and G2 Only)

1. Insert the ImageCast Boot Floppy and Image CD and reboot the 
server.

a. For G1 servers:

� High End Server Image CD v1B (PN: 2007006-002)
� Mid Level Server Image CD v1B (PN: 2007005-002)
� Low End Server Image CD v1B (PN: 2007004-002)

b. For G2 servers:
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� High End Server Image CD v2A (PN: 2009340-001)
� Mid Level Server Image CD v2A (PN: 2009338-001)
� Low End Server Image CD v2A (PN: 2009336-001)

2. After Image Cast wizard comes up, select Image file to Disk.

3. After Select Image Type screen, select Restore Entire Image and click 
Next.

4. At the Selected Image Type screen, select the Browse button. Select 
the C: drive and then select the IMC file for system being configured. 
Select OK.

5. At the Selecting File screen, confirm the IMC file selection. Select 
Next.

6. At the Select Partition screen, click Next.

7. At the Select Post Configuration File screen, verify that nothing is 
selected. Select Next.

8. At the Select Destination screen, select Drive 1 and click Next.

9. At the Select Advanced Options screen, select Automatically Resize 
Partition. Select Next.

10. At the Ready to Begin screen, select Image. Select Continue in the 
warning screen.

11. When the image process begins, eject the boot disk from the floppy 
drive and allow the server to reboot twice.

12. After the system reboots, login as Administrator; password: 
changeme. Verify that the image was transferred to the server.

Setup User Properties on Server

1. Select Start > Programs > Administrative Tools (Common) > User 
Manager for Domains.

2. In the User Manager dialog box, double click on Administrator.

3. In the User Properties dialog box, change the password to cardiolab! 
(lower-case).

4. Deselect: User must change password at the next login.

5. Select: User Cannot Change Password and Password Never Expires.

6. Select the Groups button.

7. In the Groups Membership dialog box, verify that the Administrator 
account to be a member of the Administrators group.

8. If the Administrator is not a member of the Administrators group, 
select Administrators in the Not Member of list, and select the Add 
button.

9. Click OK. 

10. At the User Properties window, click OK.
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Install SQL Service Pack 3 (G1 Only)
Perform this procedure on a G1 server only. Otherwise skip to “Install 
CardioLink 1.1D” on page 6-17.

1. Insert Prucka CardioLink version 1.1D CD into the CD-ROM 
drive.

2. Launch the file: \SQL SP3\setup.bat file. 

����
If setup detects that this Service Pack has already been installed, 
select No to the message: Would you like to continue, then 
proceed to “Install CardioLink 1.1D” on page 6-17.

3. In the Welcome window, select Next.

4. In the Software License Agreement window, select Yes.

5. In the Connect to Server window, select the radio button: The SQL 
Server System administrator login information (SQL Server 
authentication).

6. Enter the password for the sa login: <blank>. Select Next. A 
message box appears: Validating Password. Please wait.... 
Installation process starts. This takes a few minutes.

7. Select Next in the start copying files box.

8. A message box appears: You have a blank password for the sa login. 
This is a security risk. Select OK.

9. In the Authentication mode dialog box, select the Mixed Mode radio 
button, and check the Blank Password (not recommended) checkbox. 
Select Next.

10. In the Setup complete dialog box, select the radio button: Yes, I want 
to restart my computer now. Select Finish.

11. The system reboots itself.

12. Log in as Administrator; password: cardiolab!

Install CardioLink 1.1D

1. In Windows NT Explorer, locate the CD-ROM drive.

2. Select the Setup.exe file.

3. When you start the Setup.exe file, the Welcome window appears, 
select Next to continue.

4. At the Maintenance Options window, verify that the CardioLink 
Server radio button is selected and click Next

5. Leave the sa password as blank, and select Next.

6. If a read-only file detected box appears, select Yes.

����
Ignore any error messages that may be displayed in the MS-DOS 
window.



6-18 Mac-Lab/CardioLab Revision E
2007623-079

Recovery Procedures: CardioLink Server (5.2)

7. To restart your computer, select the first radio button. A reboot is 
necessary for the changes to take effect.

����
If error messages are displayed, please refer to the Installation 
troubleshooting sections of this manual.

8. Select Finish.

Install Server Core Update
If the system has mapped drives under the Administrator account, the 
drives MUST be disconnected before running the Core Update procedure.

If the Core Update procedure produces any errors that are not 
documented in this manual, contact Technical Support.

The core update will update the third party software on the system. 
These updates are being performed to optimize the system security for 
all third party applications.

The system will automatically reboot several times throughout this 
update.

1. Insert the Core Update CD into the CD drive on the Server.

����
The message, cpmgmt.dll initialization failed because Windows 
is shutting down... may appear, click OK. At the End Task 
window, click End Task. Accept these message and allow core 
update to continue.

����
The message, Cannot find the file ’F:\Setup.exe’ (or one of its 
components). Make sure the path and filename are correct and 
that all required libraries are available may appear, leave the CD 
in the drive, click OK to the message, and reboot the system 
(Start > Shutdown > Restart). 

2. The Core Software Update 5.2 InstallShield will begin. 

3. At the Welcome screen, read the security message and click Next to 
continue. 

4. At the Enter Password window, enter the SA password and click 
Next.

����
The SA password should be blank unless changed by the 
Administrator.

5. At the Enter Password window for the administrator password, type 
cardiolab! and click Next.

6. At the Information window, click Yes.

7. The Setup Status window appears monitoring the progress.

8. If the Microsoft Office 2000 SR-1 Premium error message appears, 
click Ignore.

9. At the message, All required patches have been installed, click OK.
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10. At the Installation Complete window, click Finish.

����
A list of the software updates installed by the core update is 
located in the install log: 
D:\Gemms\Prucka\Setup\GEMS_Install.log

11. Remove the Core Update CD from the CD drive.

Upgrade CardioLink 5.2

1. Insert the CardioLink version 5.2 CD into the CD-ROM drive.

2. In Windows NT Explorer, locate the CD-ROM drive.

3. Double-click the Setup.exe file.

4. In the Maintenance Option window, select the Update CardioLink 
Version 5.2 radio button and click Next to continue.

5. In the Maintenance Options window, verify that the CardioLink 
Server radio button for the server setup type is selected and select 
Next.

6. At the Warning message, click Yes.

7. The Setup Status window will appear with a progress bar.

8. At the SA Password window, enter the sa password and select Next.

����
The SA password should be blank unless changed by the system 
Administrator.

9. At the Installation Complete window, check the Yes, I want to restart 
my computer now radio button and click Finish. A reboot is necessary 
for the changes to take effect. 

10. After server reboots, log in as mlcltechuser

����
See system administrator for password information

Install CardioLink Utilities

1. Right-click on My Computer and select Explore.

2. Navigate to E:\CardioLink Utilities Install and double-click 
Setup.exe.

3. Click Next at the Welcome screen.

4. Ensure the Archive Utility option is selected in the Setup Type screen 
and click Next.

5. Enter gemssqladmin in the Password textbox and click Next.

The software installs the necessary files. It will take approximately 3 
to 5 minutes for installation to complete. A completion window is 
displayed.

6. Click Finish. A reboot is not required.

7. Remove the CardioLink version 5.2 CD from the CD-ROM drive.
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Configure pcAnywhere Callers List (G1 Only)
Perform the steps below to configure the Callers list in pcAnywhere to limit remote 
access to the mlcltechuser user only.

1. Select Start > Programs > Symantec pcAnywhere.

2. Right-click GE Remote Support icon and select Properties.

3. In the Connection Info tab, verify the MultiTech Systems MT5634ZBA and the 
TCP/IP connection checkboxes are checked.

4. In the Settings tab, verify the Launch with Windows and Run Minimized 
checkboxes are checked.

5. In the Callers tab, select the Use pcAnywhere authentication with pcAnywhere 
privileges radio button.

6. Highlight the GEMMS caller and then click the X icon to delete the caller.

7. Click Yes to confirm.

8. Select the Use pcAnywhere authentication with pcAnywhere privileges radio 
button.

9. Click the New Item icon.

10. In the Identification tab, select the Group radio button.

11. In the Domain drop down box, select the [computer name].

12. In the Account drop down box, select the MLCLTECHGRP. 

13. Click OK.

14. Click OK.

15. Close the pcAnywhere window.

Configure pcAnywhere Callers List (G2 Only)
It is recommended that pcAnywhere Version 10 is on the Mac-Lab/CardioLab 
system to provide remote service support for your Mac-Lab/CardioLab system by 
GE Medical Systems Information Technologies service personnel.

Perform the steps below to configure the Callers list in pcAnywhere to limit remote 
access to the mlcltechuser user only.

1. Select Start > Programs > Symantec pcAnywhere.

2. Right-click GE Remote Support icon and select Properties.

3. In the Connection Info tab, verify that the MultiTech Systems MT5634ZBA and 
the TCP/IP connection are checked

4. In the Settings tab, verify the Launch with Windows and Run Minimized 
checkboxes are checked.

5. Select the Callers tab.

6. In the Name field, click GEMMS to highlight this caller.

7. Click the X icon to delete the caller.

8. Select Yes to confirm.

9. In Authentication type drop down box, select NT.
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10. Click the New Item icon.

11. In the Identification tab, select the Group radio button

12. In the Domain drop down box, select the <computer name>.

13. In the Account drop down box, select the MLCLTECHGRP 

14. Check the Global NT users and groups defined in Local NT groups checkbox.

15. Click OK.

16. Click OK.

17. Close the pcAnywhere window.

Load AIT tape driver

Required parts: HP/SONY AIT Driver NT CD (p/n 2023718-001).

Perform this procedure only if a Sony AIT-2 or AIT-3 Tape drive is 
installed. If Compaq AIT tape drive is installed, skip this procedure and 
go to “Restore data to the server” on page 6-22.

1. Log in as mlcltechuser.

2. Select Start > Settings > Control Panel and double-click Tape 
Devices.

The Install Driver window is displayed.

������
If SONY SDX-500V or SONY SDX-700C is not listed in the 
Install Driver window, the Sony AIT drive is not installed. Go 
to the next procedure, “Restore data to the server” on page 6-
22.

3. Insert the HP/SONY AIT Driver NT CD (p/n 2023718-001) into the 
CD-ROM drive.

4. Click Have Disk.

5. Click Browse. 

6. Navigate to the E:\Sony AIT Drive and click Open.

7. Click OK.

8. Select Sony AIT Tape Drive (NT 4.0) and click OK.

9. Click OK.

10. Select the Drivers tab in the Tape Devices window.

11. Highlight Compaq AIT driver and click Remove.

12. Click Yes to the confirmation message.

13. Click OK.

14. Remove the CD.
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Restore data to the server

	�
����
Continue with the remaining recovery procedures only if 
you are restoring data to the server. If there is no data to 
restore, follow the server installation procedures in the 
CardioLink Installation Instructions.

Rename the Server 

The server must have the same name as it had prior to re-imaging. If the 
rename is not needed, skip to section “Configure Network Settings” on 
page 6-26.

Change the NT name
Perform these steps only if the server name was not CLINK_2.

1. Right-click Network Neighborhood and select Properties.

2. Go to the Identification tab and select Change.

3. Change the computer name to name of the server that was recorded 
in “Record system information at the server” on page 6-6 and click 
OK.

4. Click OK to the confirmation message.

5. Close the Network Properties window.

6. Click Yes at the Reboot the Server message.

The server reboots.

7. Accept any error messages and log in as mlcltechuser.

Run the Rename utility
Perform these steps only if the server name was not CLINK_2. 

	�
����
LOSS OF DATA —  If an error occurs and the rename 
utility exits before it entire rename process is complete, 
the server Rename utility must be run again to rename 
the server back to its old name. 

Then run Rename utility again to change the server to the 
new name.

1. Insert the 5.2 CardioLink CD (p/n 2015222-001) into the CD drive.

2. Right-click My Computer and select Explore.

3. Navigate to E:\Server Rename Install and double-click setup.exe.

The Welcome screen is displayed.
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4. Click Next.

The Setup Type window is displayed.

5. Verify Rename Server is selected and click Next.

6. Click Yes to the confirmation message.

7. Click OK to the information message.

8. Click Finish to restart the computer.

9. Log in as mlcltechuser.

10. Right-click My computer and select Explore.

11. Navigate to E:\Server Rename Install and double-click setup.exe.

The Welcome screen is displayed.

12. Click Next

The Setup Type window is displayed.

13. Verify Rename Server is selected and click Next.

14. Click OK to the information message.

15. Launch Enterprise Manager under Start > Programs > Microsoft 
SQL server 7.0 and verify the new CardioLink server computer name 
is registered and working (denoted by a green arrow).

16. Verify there is no registration for CLINK_2 by highlighting the SQL 
Server Group. If the new name is not displayed and CLINK_2 is still 
registered, then perform the following steps:

a. Under the SQL Server Group, right-click the entry for CLINK_2 
and select Delete SQL Server Registration. Select Yes to confirm.

b. Right-click SQL Server Group and select New SQL Server 
Registration.

c. Select Next.

d. From the Available Server window, select the new name of the 
CardioLink server and select Add and then select Next.

e. Verify the Windows NT account information radio button is 
selected, then select Next.

f. Verify the Add to existing group radio button is selected, then 
select Next.

g. Select Finish and verify the new CardioLink server name is 
registered successfully.

17. Remove the CD from the drive.
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Edit timeserv.ini
Check the timeserv.ini file in the C:\WinNT directory to verify the server 
name is correct.

1. Right-click My Computer and select Explore.

2. Navigate to C:\Winnt and double-click to open timeserv.ini.

3. Scroll down in the file to find the line PrimarySource = \\ 
[CardioLink Server Name]. Verify the [CardioLink Server Name] is 
the new server name. If it is not, perform the following steps:

a. Edit the PrimarySource = value to \\ [CardioLink Server Name] 
and save the file.

b. Select Start > Run, and type in timeserv -update.

c. Select Start > Run, and type in timeserv -automatic.

d. Reboot the server to commit timeserv changes.

Correct SNMP traps
Perform this procedure only if the server name is not CLINK_2.

1. Right-click on Network Neighborhood icon and select Properties.

2. Select the Services tab.

3. Select SNMP service, then select Properties.

4. Select the Traps tab.

5. Remove the entry for CLINK_2.

6. Select Add and enter the new name of the CardioLink server. Select 
Add.

7. Select OK on Microsoft SNMP Properties window.

8. Select Close on the Network window.

9. Close the Control Panel window.

Configure Insight manager
Perform this procedure only if the server name is not CLINK_2.

1. Open the Compaq Insight Manager: Start > Programs > Compaq 
Insight Manager > Compaq Insight Manager.

2. From the main menu, select Setup > Device List.

3. In the Responsible Device list, highlight the entry for CLINK_2 then 
select Remove.

4. Click the IP Device List button.

5. Select New.

6. Enter into the Device name field the new name of the CardioLink 
server. Check the box for WINS/DNS IP Address Resolution and 
then select the Add button. Select Close.
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7. In the IP Device List window, highlight the entry for CLINK_2 and 
then select Remove. Select OK.

8. In the List all Devices list, highlight the entry for CLINK_2 then 
select Delete. 

9. Select Yes.

10. If the new server name is not already in the Responsible Device list, 
select on the new name of the server from the List of All Devices 
window, and select Add. 

Confirm the Responsible Device List displays the new CardioLink 
server name.

11. Select OK.

12. Verify the new CardioLink server has a green status in the Device 
List 1 window.

Reconfigure pcAnywhere
Perform this procedure only if the server name is not CLINK_2.

1. Double-click the pcAnywhere shortcut icon on the desktop.

2. Right-click the GE Remote Support icon and select Properties.

3. Select the Callers tab.

4. Verify Authentication type is NT.

5. Delete any existing users.

6. Right-click in the whitespace and select New.

7. In the Identification tab, select the Group radio button.

8. In the Domain field, select the local server name.

9. In the Account field, select the MLCLTECHGRP and click OK.

10. Click OK.

11. Close pcAnywhere.



6-26 Mac-Lab/CardioLab Revision E
2007623-079

Recovery Procedures: CardioLink Server (5.2)

Configure Network Settings 

The network must be configured on all systems. Configure using the 
workgroup member setup, immediately following, or “Domain Member 
Setup” on page 6-26. If you are unsure of the setup, contact the hospital 
system administrator GE Technical Support.

Workgroup Member Setup
����

For optimum security, GE Medical Systems Information 
Technologies recommends that the CardioLink server and all 
associated Acquisition and Review systems be configured as 
members of an independent workgroup.

1. Right-click Network Neighborhood and select Properties.

2. In the Identification tab, select the Change button.

3. Verify that the Workgroup option radio button is selected.

4. Enter the workgroup (recorded earlier) as the name of the Workgroup 
to join and select OK.

5. At the Workgroup Welcome message, select OK.

6. Select Close.

7. Select Yes at the message: Do you want to restart your computer now?
8. Login as an mlcltechuser

����
See system administrator for login information

9. Proceed to “Configure Settings” on page 6-27.

Domain Member Setup
Perform this procedure only if the server must be set up as a domain 
member (i.e., is not a workgroup member).

Adding the CardioLink server and all associated Acquisition and Review 
systems to the customer’s domain is NOT recommended.

1. In the Identification tab, select the Change button.
2. Verify that the Domain option button is selected.
3. Enter the name of the Domain to join.
4. Verify that the Create Computer Account in the Domain box is 

checked.
5. Enter the User Name and Password of an account with the ability to 

add a computer to the domain, and select OK.
������

An account with the ability to add a computer to a domain is 
typically a domain administrator account. The IT department 
must enter the User Name and Password, unless this 
information is provided to GE Medical Systems personnel.

6. Select Yes at the message: Are you sure you want to move this 
computer?
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7. At the domain welcome message, select OK.
8. Select Close.
9. Select Yes at the message: Do you want to restart your computer now?
10. Login as an mlcltechuser

����
See system administrator for login information.

Configure Settings

1. Right-click Network Neighborhood and select Properties.

2. Select the Protocols tab.

3. Highlight the TCP/IP Protocol, and select the Properties button.

4. Setup IP Address information:

a. If a static IP address is used, obtain the IP Address from the 
hospital IS/IT department and verify that the Specify an IP 
Address option button is selected and continue to step 5. 

b. If connecting to a DHCP network and setup in a workgroup, an 
indefinite lease is required from the hospital’s IS/IT department 
to ensure that the settings configured in the lmhost file will be 
current at all times. Select the Obtain an IP Address from a 
DHCP server button and proceed to step 8 to setup LMHOSTS.

����
If the hospital CANNOT provide an INDEFINITE lease, a 
static IP address is required.

c. If connecting to a DHCP network and setup in a domain, proceed 
to step 6 to setup the DNS server.

5. Enter the IP Address, Subnet Mask, and Default Gateway.

6. If a DNS server was previously configured, proceed with this step 
otherwise skip to the next step.

a. Select the DNS tab.

b. Select Add for the DNS Service Search Order.

c. Enter the IP Address for the DNS server, and select Add. Repeat 
this step as needed.

d. Select Add for the Domain Suffix Search Order.

e. Enter the TCP/IP Domain Suffix and click Add. Repeat this step 
as needed.

7. If a WINS server was previously configured, proceed with this step 
otherwise skip to the next step.

a. Select the WINS Address tab.

b. Enter the IP Address of the Primary WINS Server.

c. Enter the IP Address of the Secondary WINS Server, if one 
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exists.

d. Verify that the Enable DNS for the Windows Resolution checkbox 
is unchecked, unless you are told to check it by the network 
administrator.

8. If LMHOSTS was previously configured, proceed with this step 
otherwise skip to the next step.

a. Select Start > Run.

b. Type Notepad in the Run window and click OK. 

c. Type the following for each CardioLink server, Acquisition 
system, and Review station in the network:

IPADDRESS<Tab>COMPUTERNAME<Tab>#PRE

example:
192.168.2.1 CLINK_2 #PRE
192.168.2.2 ACQ_1 #PRE
192.168.2.3 REV_1 #PRE
3.20.118.172 REV_2 #PRE

����
The #PRE command will preload the information into cache.

d. Insert a floppy disk into the a:\ drive.

e. Select File > Save As. Be sure to change the file extension to .txt

f. Save the file host.txt

g. Select the WINS Address tab in the Microsoft TCP/IP Properties 
window.

h. Uncheck the Enable DNS for Windows Resolution checkbox.

i. Verify that the Enable LMHOSTS Lookup checkbox is checked.

j. Click the Import LMHOSTS button.

k. Browse to and select the host.txt file on the a:\ drive and click 
Open.

l. At the information box, Do you want to continue? click Yes.

9. Select OK at the bottom of the Microsoft TCP/IP Properties window.

10. Select Yes at the message: Do you want to restart your computer now?

11. Log in as an mlcltechuser.

����
See system administrator for login information.
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Restore the CardioLink Database from BackupTape

	�
����
LOSS OF DATA -- The data restore procedures following 
will overwrite any existing data on the server. The 
existing data on the server must be backed up before 
restoring the data 

This procedure can only be run if there is a current 5.2 tape backup. If 
backups are located on an enterprise backup location, use the 
appropriate procedure in “Enterprise Backups” on page 6-31.

����
In order to successfully restore the disk to its latest state, remember 
to restore the most recent full tape (weekly) backup first and then 
each successive incremental (daily) backup.

For example: If a system failure occurs on Thursday, in order to 
restore the system to its most recent state, one must first restore the 
last full tape backup from the previous Friday and then restore each 
incremental backup from Monday, Tuesday and Wednesday.

1. Launch the Backup Utility from Start > Programs > Administrative 
Tools (Common) > Backup.

2. Insert the data cartridge to restore.

3. Open the tapes screen by selecting the Tape button.

4. From the tapes screen, double click on the Tape icon. The following 
dialog box should appear:

5. After the catalog is loaded, the tapes screen should display the 
contents of the tape.

6. From the tape screen, select the items by checking the checkboxes 
next to D:\ to restore all data (by description & set number) from the 
Drive D:.

7. Select the appropriate set.

PK 3
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8. After selecting the folders from tape, select on the Restore button. 
The Restore Information screen appears.

9. Specify restore settings as follows:

a. Select Restore File Permissions.

b. Select Verify After Restore.

c. Type the path and filename to specify the log file as 
d:\GEMMS\Prucka\NetConfig\clabrestore.log

d. Select the option Summary Only.

10. Select OK to begin Restore Process.

������
If the message Confirm File Replace appears, select Yes to All to 
continue. This message will only appear during the restore of the 
daily tape backups.
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11. Verify that the restoration is complete by viewing the Restore Status 
screen.

12. Select OK on Restore Status screen.

13. Remove the tape.

����
Repeat steps 2 - 12 for each data cartridge to restore.

14. Exit the backup utility after restoring the desired data cartridges.

15. Skip the next procedure and continue with “Install LMT server” on 
page 6-37

Enterprise Backups

If restoring from enterprise backup, use the appropriate procedure 
following:

� “Restore from a Veritas Backup” on page 6-31
� “Restore from ArcServe Backup” on page 6-32
� “Restoring Database and Study Data from the Enterprise 

Network” on page 6-33
� “Using Veritas Backup Exec Remote Agent for Windows NT” on 

page 6-34
� “Using ArcServe Windows NT Enterprise ED. v6.5 Bld 600” on 

page 6-35

Restore from a Veritas Backup
If using Enterprise backup software with a domain authentication, 
ensure that the domain user that is used for the backup is a member of 
the MLCLADMGRP on the CardioLink Server. If the user is not made a 
member of the MLCLADMGRP the backup restoration will NOT 
successfully run.

PK 5
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Before attempting to restore server data using Veritas, the Veritas 
Remote Agent must be installed on the CardioLink server. See the 
CardioLink Operator’s Manual for detailed instructions on installing the 
agent.

� Both the Daily and Weekly Restore sets will include the user 
databases files from 
D:\GEMMS\Prucka\Database\Maintenance\Backup and the 
patient studies folder from the path 
D:\GEMMS\Prucka\Studies.

� Daily Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup
D:\GEMMS\Prucka\Studies

� Weekly Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup
D:\GEMMS\Prucka\Studies

Restore from ArcServe Backup
If using Enterprise backup software with a domain authentication, 
ensure that the domain user that is used for the backup is a member of 
the MLCLADMGRP on the CardioLink Server. If the user is not made a 
member of the MLCLADMGRP the backup restoration will NOT 
successfully run.

Before attempting to restore server data using ArcServe, the ArcServer 
Remote Agent must be installed on the CardioLink server. See the 
CardioLink Operator’s Manual for detailed instructions on installing the 
agent.

� Both the Daily and Weekly Restore sets will include the user 
databases files from 
D:\GEMMS\Prucka\Database\Maintenance\Backup and the 
patient studies folder from the path 
D:\GEMMS\Prucka\Studies.

� Daily Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies

� Weekly Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies

16. Execute the DB restore utility by selecting 
D:\gemms\prucka\netconfig\GEMS_RestoreClab.bat.

17. Press any key to continue with the restore operation.

18. Select OK to message The backup file has been restored.

19. Reboot server to restart process.

20. Navigate to Start > Microsoft SQL Server 7.0 >Enterprise Manager 
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21. In Enterprise Manager, navigate to:

       Clink_2->Databases>Clab>Tables>DetailVersion

22. Right-click on Detail Version table, select Open Table > Return All 
Rows from the menu.

23. From the newly opened Data, Set the NetVersion and 
MachineDBVersion fields to 0.

24. Exit from Enterprise manager.

25. Run the file D:\GEMMS\Prucka\Network\stoprepl.bat from the 
server.

Restoring Database and Study Data from the Enterprise Network
If using Enterprise backup software with a domain authentication, 
ensure that the domain user that is used for the backup is a member of 
the MLCLADMGRP on the CardioLink Server. If the user is not made a 
member of the MLCLADMGRP the backup restoration will NOT 
successfully run.

Before restoring study data from tape backup, replication must be 
disabled as follows:

1. Select Start>Programs>Microsoft SQL Server 7.0>Enterprise 
Manager.

2. Enterprise Manager launches. Expand the SQL Server Group.

3. Highlight <Clink_2> or the <Server_Name>.

4. Select Tools>Replication>Disable publishing.

5. Select Next in the Disable Publishing and Distribution Wizard 
window.

6. Select Yes to disable publishing on <Server_Name>, and select Next.

7. At Confirm Dropping of Publications window, select Next and then 
select Finish.

8. In the SQL Server Enterprise Manager successfully disable window, 
select OK. 

9. Delete the file history.log from D:\Gemms\Prucka\Netconfig folder.

10. Select the <Ctrl + ALT + Delete> keys.

11. Select the Task Manager button.

12. Select the Processes tab.

13. Select the process NetMsgSender.ex.

14. Select the End Process Button.

15. Select Yes to the Task Manager Warning message.

����
Make sure you have a backup of the existing studies before 
continuing.
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16. Delete all items under the D:\Gemms\Prucka\Studies folder.

Using Veritas Backup Exec Remote Agent for Windows NT
� Both the Daily and Weekly Restore sets will include the user 

databases files from 
D:\GEMMS\Prucka\Database\Maintenance\Backup and the 
patient studies folder from the path 
D:\GEMMS\Prucka\Studies as per the figure below.

� Daily Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies

� Weekly Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies
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Using ArcServe Windows NT Enterprise ED. v6.5 Bld 600
� Both the Daily and Weekly Restore sets will include the user 

databases files from 
D:\GEMMS\Prucka\Database\Maintenance\Backup and the 
patient studies folder from the path 
D:\GEMMS\Prucka\Studies as per the figure below.

� Daily Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies

� Weekly Restore Selection
Select the 
D:\GEMMS\Prucka\Database\Maintenance\Backup 
D:\GEMMS\Prucka\Studies

17. Execute the DB restore utility 
D:\gemms\prucka\netconfig\GEMS_RestoreClab.bat.

18. Press any key to continue with the restore operation.

19. Select OK to message The backup file has been restored.

20. Run the file D:\GEMMS\Prucka\Network\Stoprepl.bat.

21. Reboot Server to restart process.

22. On each acquisition system, run the file 
D:\GEMMS\Prucka\Network\stoprepl.bat.

23. Restart replication by running the replication utility. On the server, 
select D:\Gemms\Prucka\Netconfig, and double click on the 
PEICreate_Replica.exe file. The log-in dialog box launches.

24. Type in: 

User Name: sa

Contact the GE Technical Support or the System Administrator 
for current password information
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25. Select OK.

26. In the Select System for Replication dialog box:

From the System list, select: <LOCAL-SERVER-NAME>.

a. Select the Add button.

b. Make sure the server is selected for the type of system.

c. The <LOCAL-SERVER-NAME> appears in the Network list.

From the System list, select each <ACQUISITION-SYSTEM-
NAME>.

a. Select the Add button.

b. Make sure acquisition system is selected as the type of system.

c. The <ACQUISITION-SYSTEM-NAME> appears in the Network 
list.

27. Select OK.

28. Select Yes to the message: Please make sure you have created a 
master list.

29. Wait for the processes to stop running.

30. The message appears: Do you want to move existing studies form the 
acquisition system: <CUSTOMER-ACQUISITION-SYSTEM-
NAME> to the server?

Select Yes if any of the following conditions are true:

� If you are adding a single acquisition system to the network 
environment for the first time.

� If there are studies on the system that need to be moved to the 
server.

� If this system has been removed from the network and studies 
were performed.

� If this system has been removed from the network and lists were 
edited.

����

If Yes is selected and a message appears warning All Lists will be 
Deleted, DO NOT CONTINUE. Select No to consolidate.

Select No if any of the following conditions are true:

� If the acquisition system is currently on the network.

� If the acquisition system was removed from the network and no 
studies or list modifications were performed. A message will 
appear to warn of duplicate lists. If it is certain that no list 
modifications have been made, select Yes to continue, otherwise 
do not continue and select Yes to Consolidate.

31. Select OK on the Replication Started message window.
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32. Run the batch file D:\Gemms\Prucka\Netconfig\Synclist.bat. This 
will synchronize the server database with the new acquisition 
system.

33. Reboot the server.

����

After the replication is re-started at the end of restore process, the 
user will be able to locate the patient studies that were restored from 
tape on the Network catalog on acquisition machines and will be able 
to review or continue the studies.

Install LMT server

If the LMT server was previously installed on the server before re-
imaging perform this procedure. If it was not, skip this procedure and go 
to “Re-Install Microsoft security patches” on page 6-39.

1. Insert the LMT 1.3 Server Install CD (p/n 2015474-001) into the 
drive.

2. Right-click on My Computer and select Explore.

3. Navigate to the E:\ drive and run Setup.exe.

The Password window is displayed.

4. Contact the GE Technical Support or the System Administrator for 
current login information and press Next.

����
The password may have been changed. Verify with the system 
administrator the password is still the one listed above.

5. Click Next at the Welcome window.

6. Click Next at the Choose Destination window.

The installation takes about 10 minutes.

7. Click Finish.

8. Remove the CD from the drive.

Install LMT client

If the site uses Scheduled Reports, the LMT client must be installed on 
the server.

1.Insert the LMT 1.3 Client Install CD (p/n 2015472-001) into the 
drive.

2. Right-click on My Computer and click Explore.

3. Navigate to the E:\ drive and run Setup.exe.

If the Welcome window is displayed, skip the next step. If the setup 
aborts, Pervasive SQL 2000 has not been installed yet. Perform the 
next step.



6-38 Mac-Lab/CardioLab Revision E
2007623-079

Recovery Procedures: CardioLink Server (5.2)

4. Install Pervasive SQL 2000:

a. Navigate to the E:\Pervasive.

b. Double-click onSetup.exe.

c. Click Next the Welcome window.

d. Click Yes at the Software License window.

e. Click Next at the Setup Type window.

f. Click Next at the Select Installation Directory window.

g. Click Next at the Pervasive System Analyzer window.

Wait for the System Analysis to complete. 

h. Click Next.

i. Click Next at the Analyzer Results window.

When the Results Analysis is complete, the Start Copying 
window is displayed.

j. Click Next.

Files are copied and a configuration runs. When complete, the 
Transactional Engine Test window is displayed.

k. Select the I do not want to run radio button and click Next.

l. Select the I do not want to run radio button and click Next at the 
The Relational Engine window.

m. Uncheck the read me checkbox and click Finish in the Finish 
window.

When the Pervasive SQL 2000 install is complete, reboot the 
system, login as mlcltechuser, and go back to step 2 and restart 
the LMT client installation.

5. Click Next at the Welcome window. 

6. Click Next. at the Select Options window.

7. Click Next at the Program Folder window.

Files are copied.

8. Uncheck both checkboxes and click Finish at the Completion window.

9. Remove the CD.

10. Reboot the server.

11. Log in as mlcltechuser (contact the GE Technical Support or the 
System Administrator for current login information).

12.  Select Start > Programs > Microsoft Access.

An End User License Agreement screen is displayed.

13. Click Accept.
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14. Close Microsoft Access.

15. Launch the LMT application from the shortcut on the desktop.

16. Click the Utilities button at the login window.

17. Select Re-link database tables and click OK at the LMT Table Relink 
window.

Install LMT Backup/Restore utility

1. Insert the LMT Backup/Restore Utility Install CD (p/n 2017867-
001) into the drive.

The Welcome window is displayed.

����
If the CD does not auto run, click the setup.exe file on the CD.

2. Click Next.

The Complete window is displayed.

3. Click Finish.

4. Remove the CD from the drive.

Re-Install Microsoft security patches

Instructions for downloading and installing Microsoft security patches 
are listed by product type on Support Central. Download and install all 
previously installed patches (as recorded before in “Record Microsoft 
security patches installed” on page 6-7).

Restore the GEMS Registry Key

1. Right-click My Computer and select Explore. 

2. Navigate to D:\Gemms\Prucka\Database\Maintenance

3. Double click the file GEMS_REGRES.cmd

4. Type Y and press the Enter key at the confirmation screen.

5. Click OK to the confirmation message.

Restore the clab database

1. Navigate to D:\Gemms\Prucka\NetConfig.

2. Double-click on: GEMS_Restoreclab.bat.

3. Press the Enter key when prompted to press any key.

The restore script runs. 

4. Press Enter again when prompted.
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5. Reboot the server.

6. Log in as mlcltechuser (contact the GE Technical Support or the 
System Administrator for current login information).

7. Select Start > Programs > Microsoft SQL Server 7.0 >Enterprise 
Manager 

8. In Enterprise Manager, navigate to: Microsoft SQL Servers > SQL 
Server Group > [Server Name] > Databases > clab > Tables

9. Right-click Detail Version table, and select Open Table > Return all 
rows from the menu.

10. From the newly opened table, set the NetVersion to 0 (zero) and 
MachineDBVersion fields to 00 (double zero).

11. Close the Detail Version table.

12. Close Enterprise Manager. 

13. Right-click My Computer and select Explore.

14. Navigate to D:\Gemms\Prucka\Network 

15. Double-click stoprepl.bat.

16. Ignore the error message and press the Enter key to continue.

Restore LMT database

Perform this procedure only if the LMT database is available.

1. Navigate to D:\Gemms\Prucka\Database\Maintenance\Backup.

2. Right-click on: clinkbackup.bak and select Copy.

3. Navigate to the D:\Program Files\Gems\Lmt\Maintenance\Backup 
folder.

4. Right-click and select Paste.

5. In the D:\Program Files\Gems\Lmt\Maintenance folder, double-
click Gems_Restoreclink.

A login screen is displayed.

6. Log in as username: sa (contact the GE Technical Support or the 
System Administrator for current login information).

A command window opens.

7. Press Enter as required.

Install Serial Number update

Perform this procedure only if the Serial Number update was previously 
installed on the old server.

1. Log in as mlcltechuser (contact the GE Technical Support or the 
System Administrator for current login information).
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2. Insert the Serial Number Update CD (p/n 2017869-001) into the drive.

����
If the CD does not auto run, double-click the setup.exe file on the 
CD.

3. Click Next. at the The Welcome window.

4. Click Next in the Start Copying Files window is displayed.

5. Check the I will run this CD on all systems in the network environment 
checkbox, and click Finish.

6. Remove the CD.

Restore LMT Custom Reports

Skip this procedure if the customer is not using LMT Custom reports. If 
the customer is using LMT Custom Reports, restore the customer backup 
of the clink_drk.mdb file (or the file backed up earlier in “Backup LMT 
Custom Reports” on page 6-9) as indicated below.

1. Right-click My Computer and select Explore. 

2. Navigate to the location of the clink_drk.mdb file that was recorded 
in “Backup LMT Custom Reports” on page 6-9.

3. Right-click on the clink_drk.mdb file and click Copy.

4. Navigate to D:\Program Files\Gems\Lmt\Client\Resource Kit. 

Create this directory if it does not exist.

5. Paste clink_drk.mdb into the Resource Kit folder.

Verify time and time zone

Verify the time and time zone on the server are set correctly.

Register Acquisition systems

1. Log in as mlcltechuser.

2. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

3. Expand the SQL Server group and highlight the [Server].

4. Right-click SQL Server Group and select New SQL Server 
Registration.

5. At the Welcome to the Register SQL Server Wizard, select Next.

6. From the list of Available Servers, highlight the networked 
Acquisition systems one at a time.

If the system does not exist in the list, type in the computer name, 
and click Add. The system name appears on the Added servers list on 
the right side.
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7. Click Next.

8. Select the SQL Server login information radio button that was 
assigned by the system administrator (SQL Server authentication) 
and click Next.

9. Select the Login automatically using my... radio button and enter 
username: sa (Contact GE Technical Support for current login 
information).

10. Click Next.

11. Select the Add the SQL Server (s) to an existing SQL Server group 
radio button. and click Next.

The system name is displayed in the server group list.

12. Click Finish.

The status shows <SYSTEM-NAME> Registered successfully.

13. Click Close.

14. Verify the <SYSTEM-NAME> appears on the left panel of the 
Enterprise Manager under the SQL Server Group and the 
communication is established with the server (indicated by a green 
arrow).

15. Verify all systems are connected to the network and registered on the 
CardioLink Waveform Server in Enterprise Manager. All systems 
should be visible directly from the Network Neighborhood.

16. Close Enterprise Manager.

Enable for advanced security

If Advanced Security was previously enabled, it must be re-enabled.

1. Insert the Gems Advanced Security floppy disk

2. Select Start > GE Security Mode.

3. Select Enable Advanced Security mode.

4. Remove the floppy from the drive.

Run the Replication utility

1. Right-click My Computer and select Explore. 

2. Navigate to D:\Gemms\Prucka\NetConfig.

3. Double-click PEICreate_Replica.exe file.

A login window is displayed.

4. Log in as username: sa (contact the GE Technical Support or the 
System Administrator for current login information).

5. Click OK.
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6.  Select the server name in the System list in the System for 
Replication dialog box.

7. Click Add.

Ensure Server is selected for the type of system.

8. Click OK.

The server system name is displayed in the Network list.

9. Select each Acquisition system name from the System list.

10. Click Add.

Ensure the Acquisition system is selected for the type of system.

11. Click OK.

The [Acquisition system name] is displayed in the Network list.

12. Repeat for all the Acquisition systems added to the network. After 
adding all acquisition systems, select OK.

13. Click Yes at the message: Please ensure you have created a master 
list. 

Wait for the processes to stop running. The following messages is 
displayed for each acquisition system added: Do you want to move 
existing studies from the acquisition system: <ACQUISITION-
SYSTEM-NAME> to the server?

14. Click No to the consolidation message.

15. Click Yes at the continue window.

The replication process runs in the background.

16. Select OK at the Replication Started window.

17. Reboot the server and then all Acquisition systems.

Any studies done on the Acquisition systems when not connected to 
the CardioLink server must be added to the network by reviewing 
each study from the optical disk and then closing it.

Setup file paths at each Acquisition system

1. At the Acquisition system, log in as mlcltechuser (contact the GE 
Technical Support or the System Administrator for current login 
information).

2. Double-click the GE Medical Systems icon on the desktop to start the 
ML/CL application. 

If the message Optical path specified is not valid is displayed, click 
OK.

3. Select Administration > System Settings from the Main menu. 
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4. If prompted for an administrator login, log in as mlcladmuser 
(contact the GE Technical Support or the System Administrator for 
current login information).

5. Browse to the File Paths section.

6. Verify the Enable Acquisition checkbox is checked. Check the Enable 
Network Storage checkbox. 

7. Click Browse.

8. Browse to the CardioLab server and select the PruckaStudies share 
as the network storage path.

9. Click Close.

10. Change the catalog view to Network. 

11. Verify all studies are visible.

12. Close the ML-CL application.

Push emergency cases to the server

At all Acquisitions systems review and close any emergency cases (i.e., 
studies performed while the system was out of replication) from the 
optical disk.

Re-link LMT tables

Perform this procedure only if LMT is installed.

1. At the Acquisition or Review system, run the LMT application.

2. Click the Utilities button at the Login window.

3. Click the Relink Database Tables button.

4. Click OK to start relinking.

 A confirmation message indicates the tables are relinked 
successfully.

5. Click OK to close the application.

6. Repeat steps 1-5 for all LMT Clients.

Restore ACC access /PedCath/Personal Files

At the server, restore any AccAccess/PedCath/Personal files, if available, 
back to their respective folders.
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Schedule reports

This procedure is required only if reports are used on the server.

1. Log in as mlcltechuser (contact the GE Technical Support or the 
System Administrator for current login information).

2. Select Start > Programs > Administrative Tools (Common) > User 
Manager for Domains.

3. Double-click the MLCLADMGRP.

4. Click Add.

5. Highlight the SQLAgentCmdExec user and click Add.

6. Click OK.

7. Click OK.

8. Close User Manager

9. Log out of the server and log in as:
User name:SQLAgentCmdExec
Password: clab

10. Select Start > Settings > Printers.

11. Select the desired printer as Default for this user.

12. Start the LMT application, and select OK at the Microsoft Access 
user identification window.

13. Relink the tables for the SQLAgentCmdExec. (See “Re-link LMT 
tables” on page 6-44).

14. Logoff the server.

15. Log in as mlcltechuser (contact the GE Technical Support or the 
System Administrator for current login information).

16. Select Start > Programs > Administrative Tools (Common) > User 
Manager for Domains.

17. Double-click the MLCLADMGRP.

18. Highlight the SQLAgentCmdExec user.

19. Click Remove.

20. Close User Manager.

Verify the LMT application installed correctly

1. Verify the D:\Program Files\Gems\LMT\Client folder was created 
and that files exist in the directory. If this directory is not present, 
restart the computer.

2. Select the Start/Settings/Control Panel/Data Sources(ODBC) 
options, and select the System DSN tab. Verify that the installation 
created a system DSN named ClinkSQL in the ODBC Configuration.
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3. Highlight CLinkSQL, and click the Configure button.

4. Verify the Name field is set to CLinkSQL.

5. Verify the Server field is set to the local machine name. If you are 
installing multiple clients to one data source, verify that this field is 
set to the central file server machine name.

6. Click the Next button, and verify the With SQL Server authentication 
using a login ID and the password entered by the user checkbox is 
selected.

7. Verify the checkbox Connect to SQL Server to obtain default settings 
for the additional configuration options is selected.

8. Verify the Login ID is sa and enter the contact the GE Technical 
Support or the System Administrator for current login information.

9. Click the Next button, and select the checkbox: Change the default 
database to:. 

10. Select the clink database from the pull-down menu. Accept all other 
defaults on this page.

11. Click the Next button.

12. Click the Finish button.

13. Click the Test Data Source button in the ODBC Microsoft SQL Server 
Setup window.

14. Verify that the message is displayed: Tests Completed Successfully!

15. Click OK and close the ODBC configuration windows and the control 
panel window.

16. Verify that the CLINK.MDF and CLINK.LDF files exist in the 
D:\MSSQL7\Data folder.

Verify the modem connection and PC Anywhere

1. Identify the phone number for the server analog line.

2. Launch pcAnywhere, and begin the host operation through the 
modem.

3. Use technical support or clinical applications to modem into the 
server.

Reconfigure hospital shares and mapped drives

Re-map hospital shared and mapped drives as recorded in “Record 
system information at the server” on page 6-6, if available. Otherwise, 
contact the hospital administrator for additional information
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Reconfigure SQL Jobs

Reconfigure SQL jobs as recorded in “Record job schedules” on page 6-8.

1. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

2. Under the SQL Server Group, navigate to and expand the server.

3. Under the server, navigate to Management > SQL Server Agent > 
Jobs

4. Right-Click on a job and select Properties.

5. Select the Schedules tab and click New Schedule.

6. Enter the name for the schedule (i.e., the name of the SQL job) and 
click Change.

7. Edit the schedule to match the schedule recorded earlier and click 
OK.

8. Click OK.

9. Click OK.

10. Repeat for remaining jobs.

Run DB Maintenance Job

1. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

2. Under the SQL Server group, navigate to (and expand) the server.

3. Under the server, navigate to Management > SQL Server Agent > 
Jobs.

4. Right-click the Database Maintenance job and click Start Job.

A confirmation window is displayed.

5. Click Start.

Wait for the Maintenance job to complete before continuing with the 
next step.

����
This job can take up to 30 minutes to run. The status will not 
automatically update. To view the status, right-click the job and 
select Refresh job. When the job is completed Succeeded is 
displayed in the Last Run Status column.

6. Check the NT Application log to verify the job ran with no errors.

If any errors occurred, contact Technical Support.
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Setup Archive Generator

The archive generator moves study data from the local acquisition 
systems to the CardioLink server to preserve hard drive space on the 
local acquisition systems. 

This should take place in the middle of the night. For this process to 
occur without any problems, ensure that the acquisition system is not 
turned off.

To configure the archiving of studies to the CardioLink server:

1. Expand the SQL Server group, click to expand the acquisition system 
that is scheduling the archive generator task.

2. Expand the Management folder.
3. Expand the SQL Server Agent.
4. Click Jobs.
5. Right-click Run archive generator.
6. Choose Properties.
7. Select the Schedule tab.
8. Click Edit and update the schedule.

�������
If the time for the archive generator process is set at the 
same time on more than one acquisition system, the 
studies will not be moved.

����
If the archive generator process is triggered off during a study in 
progress, that specific study will not be archived to the server 
until the next archive generator process is executed.

9. Click OK.
10. Save the new schedule.
11. Click OK to save the changes to the job.

Run a full tape backup

1. Insert a tape into the tape drive.

2. Select Start > Programs > Microsoft SQL Server 7.0 > Enterprise 
Manager.

3. Under the SQL Server group, navigate to (and expand) the server.

4. Under the server, navigate to Management > SQL Server Agent > 
Jobs.

5. Right-click the Full Tape Backup job and click Start Job.

A confirmation window is displayed.

6. Click Start.

7. Check the NT Application log to verify the job ran with no errors.If 
any errors occur, contact Technical Support.
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CardioLink Network Functional Checkout Procedure

1. Ping all of the acquisition workstations and client computers 
connected to the server.

2. Run Insight Manager on the server.

3. Open the Device List, and double click on the <CardioLink Server 
Name> in the list.

4. Ensure that all of the highlighted devices are green. If they are not, 
select the Recovery button and select the Integrated Log button. 

5. If the failures do not require action during the initial installation 
(some errors may be present from the manufacturing process), select 
each of the failure messages, and select Mark Repaired.

6. After all of the log entries are marked as repaired, it may take 
several minutes for the status marker to change colors to green in 
the device list.

7. Create a test patient on one of the CardioLab or Mac-Lab acquisition 
systems.

8. Verify a restored study can be reviewed on an Acquisition or Review 
system.

9. Review the patient on each acquisition and review systems from the 
network catalog.

a. Set the Navigator catalog on the acquisition system to Network. 
The catalog will display a list of studies cataloged on the 
CardioLink Server.

b. Highlight the desired study and Review the study.

10. Test Modem Connection:

a. Identify the phone number for the server analog line.

b. Launch pcAnywhere, and begin the host operation through the 
modem.

c. Use technical support or clinical applications to modem into the 
server.



6-50 Mac-Lab/CardioLab Revision E
2007623-079

Recovery Procedures: CardioLink Server (5.2)
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Diagrams/Drawings/Illustrations

Chassis Front View 

5 1/4” Optical Drive 

CD ROM Drive

Power Switch

Floppy Drive

Reset Switch

3 1/2”Optical Drive
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Chassis Back View CD-ROM Drive 

PK2
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Optical Drive - 3 1/2 

PK3
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RS422 PCI Card

PK4
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Optical Drive - 5 1/4 

PK6
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Back Panel Showing Slots for CardioLab/Mac-Lab Computers
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Slots for CardioLab/Mac-Lab Computer with RS422 or TRAM-net 
Card

Table 1. Slot Descriptions with RS422 Card

Slot Reference Description Part Number

Slot 2 Reference 2 Digital Input 2003238-001

Slot 3 Reference 3 COM 10/V-Synch 2003240-001

Slot 4 Reference 4 PCI Card, RS422 or TRAM-net 2003245-001 or 2009937-
001

Slot 5 Reference 5  Image Card 2003243-001

Slot 6: Reference 6 Video Card 1 (Real-Time) 2003236-001

Slot 7 Reference 7 Video Card 2 2003236-001

Slot 8 Reference 8 Acquisition COMMS 2002886-001
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Back Panel Showing Slots for CardioLab/Mac-Lab Computers 
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Slots for CardioLab/Mac-Lab Computer with PSI Card

Table 2. Slot Descriptions with PSI Card

Slot Reference Description Part Number

Slot 2 Reference 2 Digital Input 2003238-001

Slot 3 Reference 3 COM 10/V-Synch 2003240-001

Slot 4 Reference 4 PSI SCSI Controller Card 2003338-001

Slot 5 Reference 5 Image Card 2003243-001

Slot 6: Reference 6 Video Card 1 (Real-Time) 2003236-001

Slot 7 Reference 7 Video Card 2 2003236-001

Slot 8 Reference 8 Acquisition COMMS 2002886-001



Revision E Mac-Lab/CardioLab 7-13
2007623-079

Drawings and Parts List: Diagrams/Drawings/Illustrations

Thermal Writer 

PK8

PK9
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Remote Acquisition Unit (RAU) with TRAM 

PK10

A
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RAU Rear Panel 

PK11

ANALOG
OUTPUT

EXTERNAL
POWER

RS-422
PORT

Connect 
RAU Power/Data Cable 

417335-004

Route cable down 
through cable clamp 
and through cable
opening on bottom
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RAU 

PK12
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RAU 

PK13
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Connections for the NT CardioLab/Mac-Lab Computer

This diagram shows the connections between the following components: 
the NT CardioLab/Mac-Lab computer, the COMMS Interface box, the 
Analog Output Breakout box, and the External VIDMUX box

 005
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This diagram shows the connections between the following components: 
the NT CardioLab/Mac-Lab computer, the COMMS Interface box, and 
the back panel of the DOS Cardiolab workstation

PK15
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CardioLink Server Airflow Requirements
Compaq rack-mountable servers draw cool air in through the front door 
and exhaust warm air out the rear door of the server. Therefore, the front 
door of the rack must be adequately ventilated to allow ambient room air 
to enter the cabinet and the rear door must be adequately ventilated to 
allow the warm air to escape from the cabinet. Do not block the 
ventilation apertures. Leave at least 2 to 3 feet in front and behind the 
server for ventilation.

������
If all of the vertical space in the rack is not filled by components, the 
gaps that are left cause a change in airflow through the rack and 
across the components. These gaps should be covered with blanking 
panels.

Rack-Mount Server Front View

Item Name

1 UID switch and LED

2 Internal system health LED

3 External system health LED

4 Network LED

5 Power button/LED assembly

6 Diskette Drive (behind media door)

7 Removable media area

8 Hot-plug SCSI hard drive bays (SCSI IDs o through 5)



Revision E Mac-Lab/CardioLab 7-21
2007623-079

Drawings and Parts List: Diagrams/Drawings/Illustrations

Rack-Mount Server Back View

Item Name

1 PCI expansion slots

2 VHDCI SCSI connector

3 Video connector

4 Parallel connector

5 RJ-45 connector

6 USB connectors

7 Torx T-15 too

8 UID switch and LED

9 Serial connector B

10 Auxillary VDHCI SCSI blank

11 Mouse connector

12 Keyboard connector

13 Serial connector A

14 Primary hot-plug power supply

15 Serial number

16 Secondary hot-plug power supply bay
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Rack-Mount Server UPS

The rack-mount server uses an R3000 XR universal power supply.

Item Name

1 Battery compartment

2 Control Buttons

3 LED display
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Rack Mount Server UPS Rear View

Item Name

1 REPO port

2 ERM connector

3 Communications port/open slot

4 Load segment 1

5 Load segment 2

6 Load segment 3

7 Load segment circuit protectors

8 Compaq PDU output (L5-30) receptable (Load segment 
1)

9 Cord retention clip attachment locations

10 Ground bonding screw

11 Power cord with L5-30 plug
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TRAMnet Communication

TRAMnet communication permits connection to the TRAM-RAC housing 
and other bedside peripherals. The TRAMnet communication is one form 
of local area network that provides a data and power link from the 
monitor to peripheral devices. The connector makes a communication 
processor available for the peripheral devices. The TRAMnet controller 
processor is built into the communication PCB assembly which frees up 
the main processor in the monitor.

To avoid confusion, consider TRAMnet communication as a small area 
network (SAN) contained in one room or at the patient bedside. For more 
details about communication networks, refer to the appropriate monitor 
service manual.

TRAM-RAC 4A Housing

Shown below is a TRAM-RAC 4A housing with a TRAM module and one 
BP and one BP/Dual Temperature module inserted. 

The TRAM-RAC 4A housing has three communication connectors:
� The 15-pin yellow color-coded connector is used for analog output,
� The two 9-pin blue color-coded connectors are for:

� TRAMnet communication with a patient monitor,
� TRAMnet hub,
� remote control, or
� an additional TRAM-RAC housing.

The number of peripheral devices is dependent upon the software version 
of the host monitor. When you use an optional power supply, there is an 
additional hidden connector on the back panel for the power supply 
connection.
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Below are examples of the rear label of the TRAM-RAC 4A housing with 
and without a power supply. Further explanation about connection and 
labeling of the male and female TRAMnet connectors is found on the 
following pages.

TRAM-RAC with Power SupplyTRAM-RAC without Power Supply
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Analog Output Connection

The analog out connector is provided for customized uses for other 
peripheral devices. The yellow color-coded 15-pin connector provides an 
analog output waveform signal.

Note the parameter numbers indicated on the front of the TRAM-RAC 
4A housing.
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When a TRAM or discrete parameter module is inserted into the 
housing, the slot number of the parameter and its analog output 
waveform is available at a designated pin of the analog out connector. 
Refer to the list below

������
The TRAM module must be in the top slot in order to receive the 
TRAM signals listed below.

������
The superscript number 1 indicates that this signal remains 
unchanged after entering the TRAM-RAC 4A housing and is 
controlled by TRAM module software. All other signals are generated 
by the DAC (digital-to-analog converter) on the TRAM-RAC 4 
interface PCB assembly.

Table 1. Analog Output Signals

Analog Output 
Pin

Signal Name
Bezel Number 

For BP

Pin 1 Signal Ground for TRAM Waveforms –

Pin 2 Trace 1 TRAM1

Pin 3 TRAM BP3 or SPO2 Value TRAM1

Pin 4 Slot 1 Discrete Module Waveform A 1

Pin 5 TRAM ART 1 or BP1 TRAM

Pin 6 Slot 3 Discrete Module Waveform A 6

Pin 7 Slot 4 Discrete Module Waveform A 8

Pin 8 Signal Ground for Discrete Module Waveforms

Pin 9 TRAM ECG II TRAM1

Pin 10 TRAM ECG V TRAM1

Pin 11 TRAM BP4 or RESP TRAM1

Pin 12 Slot 1 Discrete Module Waveform B 2

Pin 13 TRAM BP2 or SPO2 Waveform TRAM

Pin 14 Slot 3 Discrete Module Waveform B 5

Pin 15 Slot 4 Discrete Module Waveform B 7
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Ordering Parts

Introduction

The parts lists and assembly drawings in this chapter supply enough 
detail for you to order parts for the assemblies that are considered field 
serviceable. If you require additional information, schematic diagrams, 
or troubleshooting assistance, contact technical support.

Orders for new installations should be made using the system Site 
Survey and Price List. 

To order parts, contact Service Parts at the address or telephone number 
on the “How to Reach Us” insert provided at the beginning of this 
manual.
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Part Number Description Quantity

Computer

2011646-

00
1

00
2

00
3

00
4

00
5

00
6

00
7

00
8

00
9

421572-028 Ethernet Cable 1 1 1 1 1 1 1 1 1

2003587-001 Muticonductor DB44 M-m 2.5ft cable 1 1 1 1 1 1 1 1

2003677-001 Vsynch HD DB15F to HD DB15M and PS2 Cable 1 1 1 1 1 1 1 1

2003339-001  Image Cable Accessories Kit 1 1 1

2003887-001  Optical Disk FAT 16FMT DRV3 MLAB 230MB V1A 1 1

2011646-00X  Mac-Lab/CardioLab 1.0GB BCM Computer 1 1 1

2002886-003  Communications board 1 1 1 1 1 1 1 1

2003240-001 CABLE ASSY, 9PIN RIBBON W/2X5 TO DB9M 1 1 1 1 1 1 1 1

2003338-001  PSI SCSI Controller Card 1 1

2011111-001 Speaker Jumper Harness for TRAM-net 1 1 1

2011129-001  -1FT Ethernet Patch Cable 1 1 1

2003888-001 Formatted Optical Disk 2.6 GB 1 1 1 1 1 1 1 1 1

Workstations

2002459-004 Monitor Cart - 32 inch
32w x 32.5h x 30d w/casters or feet

1

2002459-001 Small Workstation - 32 inch
32w x 32.5h x 30d w/casters or feet

1

2002459-002 Medium Workstation - 40 inch
40w x 32.5h x 30d w/casters or feet

1

2002459-003 Large Workstation - 60 inch
60w x 32.5h x 30d w/ casters or feet

1

Printers

2015205-001 4200 Printer 1

2007078-001 2200 D Printer 1

6119-101 12 ft. Parallel Printer Cable 1

2003403-001 Printer Paper (A4 size) 1

9242-101 Printer Paper (8 1/2 x 11) 1

2004142-001 Digital Image Printer 1
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2004192-001 Image Printer Parallel Switch Box 1

2004194-001 Digital Image Printer Paper (A6 size) 1

2004193-001 6’ Parallel Printer Cable 1

Monitors

2000594-019 17” CRT (Compaq U7550) 1

2012980-001 19” CRT (Sony CPD-6420) 1

2010311-001 20” CRT (Sony CPD-6520) 1

2013547-002 18” LCD (NEC 1880SX) 1

2006144-001 20” LCD (E120 L771) (Sharp LL-T2020 B)

2003442-001 100 ft. DB15MHD-DB15MHD Video Cable 1

Hardware Options

2007557-002 ASSY 16 Channel Analog out with Breakout Box 1

2003408-001 50 ft. RF Option Cable 1

2003250-001 50 ft. COAX BNC-BNC Cable 1

2003412-001 BNC-BNC Barrell Connector 1

2003250-001 Image Capture Cable 1

2007023-001 Scroll Mouse 1

422310-001 GE Mousepad 1

2003417-001 Barcode Scanner 1

2003236-001 Matrox G200 Video Card 1

2003243-001 Matrox Pulsar Image Card 1

2003340-001 5.25” Internal Optical Disk Drive 1

2003341-001 3.5” Internal Optical Disk Drive 1

2003245-001 RS422 TRAM Card 1

2009937-001 TRAM-net to Ethernet Card 1

2001323-001 External speakers for TRAMnet 1

2003238-001 SCSI Cable Assembly 1

Part Number Description Quantity
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Compaq ML370 G1 Server

2006397-001  3KVA Power Conditioner Rack Mountable 1

2002241-001 Modem Multitech Analog 56K Global 220V 1

2005992-001 Memory DIMM SDRAM PC133 128MB ECC ML370 G1 1

2005992-002 Memory DIMM SDRAM PC133 256MB ECC ML370 G1 1

2005165-001  Smart Array Controller MOD Kit Option 1

2002664-005 HD HOT PLUG 36.4 GB WIDE ULTRA3 SCSI 1

2002664-006 HD HOT PLUG 18.2 GB WIDE SCSI 1

413627-005 Tape Drive DAT DDS3 GRAY 1

413629-001 Mounting Kit DDS-2 DAT 1

421572-012 Keyboard with Trackball 1

451572-0281 Ethernet Cable 1

419248-001 Cross over Cable 1

2004072-001 Modem Cable 1

Rack

2005993-001 Compaq ML370 G1 Rack Server 1

Network Switch

2001084-002 10/100 Network Switch 1

Isolation Transformer

2004195-001 Isolation Transformer 600 VA 1

Compaq ML370 G2 Server

2008887-001 Compaq ML370 G2 Rack Server 1

2005992-006 Memory DIMM SDRAM PCI33 256 MB 1

2005165-002 Smart Array SI Controller ML370 G2 1

2002664-005 HD HOT PLUG 36.4 GB WIDE ULTRA3 SCSI 1

2002664-006 HD HOT PLUG 18.2 GB WIDE SCSI 1

413627-005 Tape Drive DAT DDS3 GRAY 1

421572-012 Keyboard with Trackball 1

2002241-001 Modem Multitech Analog 56K Global 220V 1

2004072-001 Modem Cable 1

2006397-001  3KVA Power Conditioner Rack Mountable 1

Part Number Description Quantity
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2001084-002 10/100 Network Switch 1

451572-0281 Ethernet Cable 1

419248-001 Cross over Cable 1

Part Number Description Quantity
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Specifications

Special Instructions for Using Equipment

The remote monitor is powered through a separate isolation transformer, 
which is independently connected to a wall outlet to maintain leakage 
currents at medical grade levels. The laser printer is powered through 
the IEB/Workstation power supply. 

Table 1. Electrical Specifications

Item Description

Equipment Class Class I

Degree of Protection Against Ingress of 
Water

Ordinary

Mode of Operation Continuous

Power

Frequency 50/60 Hz

Maximum Current Draw 9.6/4.8 Amps at 115 Volts; 4.8 Amps at 230 Volts (945 Kcal/hr)

Chassis Leakage Current < 100 µA

Maximum Cumulative Load for AC 
Distribution Subsystem

1100VA

Fuse

Thermal Writer 3.15A, fast blow 5 x 20 mm

Specified ECG signal amplitude accuracy +/-5%

Specified ECG time base accuracy +/-5%
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Table 2. Equipment Type

Item Description

CardioLab/Mac/Lab System Console Type B

CardioLab II Plus Amplifier Class I, Type CF

Display Monitors Type B

Tram Module Surface ECG Defibrillator-proof Type CF

Tram Module Internal ECG Defibrillator-proof Type CF

Tram Module Noninvasive Blood 
Pressure

Defibrillator-proof Type CF

Tram Module Invasive Blood Pressure Defibrillator-proof Type CF

Tram Module Temperature/Cardiac 
Output

Defibrillator-proof Type CF

Tram Module Oxygen Saturation Type B or defibrillator-proof Type BF

Table 3. Thermal Writer

Technology Instant load thermal array printer. 
User selectable: A4 and STD (8.5x11) paper

Paper Type Thermal, perforated, fan fold, 300 sheets per pack

Paper Size A size 215 mm (8.5 in) x 280 mm(11 in)
A4 size 210 mm (8.27 in) x 297.5 mm (11.7 in)

Resolution 200 dpi (vertical) x 1000 lines/sec; (horizontal) dedicated local printing 
200 x 200 dpi generic printing

Channels 3, 6, or 12 channels

Frequency Response 
(-3 dB point)

HPF: 0.01 (or 0.05 Hz.)
LPF: 150, 100, 40, or 20 Hz. User Selectable

Line Filter 50.0 or 60.0 Hz Notch filter. User Selectable.

Baseline Roll Filter Cubic Spline

Noise/Artifact filter Finite Residual Filter (FRF)

Sensitivity 2.5, 5, 10, or 20 mm/mV (+/- 5%). User selectable.

Speeds  5, 12.5, 25, and 50 mm/sec (+/- 2%). User selectable.
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Table 4. Display Monitors (Real-Time, Review, Local or Remote)

Item Description

Quantity Real-Time - up to 2
Review - up to 2
Image - up to 2
Switched Video - 1

Size 17-inch 
18-inch
19-inch
20-inch
21-inch

Type 1280 x 1024 for 17” & 18” 
1600 x 1280 for 19”, 20”, & 21”

Sweep speed 5 - 400 mm/s (Real-Time monitor)
5 - 1600 mm/s (Review monitor)

Sweep Speed Accuracy 10%

Frequency Response 0 to 40 Hz

Table 5. Safety

Item Description

Handling of Disposable Supplies and Other 
Consumables

Use only parts and accessories manufactured or recommended by 
GE.

Follow manufacturer’s instructions for use for disposable/
consumable product.

Follow local environmental guidelines concerning the disposal of 
hazardous materials.

Maintenance Frequency Recommended user daily visual inspection and cleaning as 
necessary.

Recommended monthly and annual maintenance by qualified 
technical personnel.

See maintenance section of this manual for details.

Repair Guidelines Calibration instructions, equipment descriptions, and all other 
service information to repair those parts of the equipment 
designated as field repairable by qualified technical personnel is 
available in the MAC-LAB system for Cardiac Catheterization 
Service manual.

Upon request, GE will provide circuit diagrams and component 
parts lists for printed circuit boards deemed repairable by qualified 
technical personnel.
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Environmental

Classifications/Standards
� Classified by Underwriters Laboratories, Inc., with respect to electric 

shock, fire and mechanical hazards only in accordance with 
UL 2601-1

� Meets or exceeds CAN/CSA C22.2 No 601-1-M90
� Meets or exceeds IEC 601-1
� Meets or exceeds Japanese Safety and Performance Standards
� European Union Medical Device Directive (CE Mark)

������
For detailed information about the TRAM modules, see the 
TRAM 100-850 A and SL Service Manual (p/n 404422-065).

������
hPa is a measure of atmospheric pressure. One hPa (hectopascal) 
is equivalent to one millibar. At sea level the standard 
atmospheric pressure is 1013.25 hPa or millibars, and is equal to 
29.92 inches or 760 mmHg (millimeters of Mercury).

Table 6. Transport and Storage Conditions

Item Description

Temperature -40o C to +60o C

Relative Humidity 10% to 100% non-condensing

Pressure 500 hPA (mbar) to 1060 hPA (mbar)

Table 7. Operating Conditions

Item Description

Temperature +15o C to +30o C

Relative Humidity 95% non-condensing

Pressure 700 hPA to 1060 hPA
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Table 8. Equipment Type

Equipment Type Height/Length Width Depth Weight

TRAM (all models) 3.2 inches
8.1 cm

4.5 inches
11.4 cm

11.6 inches
29.5 cm
Need 5” (12.7 cm) 
front clearance for 
cables

4.7 lbs
2.1 kg

CardioLab II Plus Amplifier
32/64 channel
96/128 channel

9.5 inches
14.0 inches

14.0 inches
14.0 inches

14.0 inches
14.0 inches

22 lbs
25 lbs

CPU 18.9/47.3 in/cm 8.3/20.8 lbs/kg 18/45 in/cm 43/20 in/cm

IEB 24.5/61.3 in/cm 11/27.5 lbs/kg 21/53 in/cm 75/34 in/cm

Table 9. Remote Acquisition Unit (RAU)

Item Description

RAU Cabinet Accommodates one or two TRAM modules
With Table Mount 
or Floor Mount
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Table 10. Processing

Item Description

ECG 12-lead with ST analysis (Mac-Lab only)

Respiration Impedance method (1 — 200 breaths per minute range)

Cardiac Output Thermal Dilution, Calculated, and Estimated Fick (Mac-Lab only)

Invasive Pressure 4 channels with means (-98 to 350 mmHg range)

Non-invasive Pressure Automatic and Manual modes (Oscillometric)

Pulse Oximetry Saturation range 0 — 100% (accuracy 90 — 100%; ±1.5%)

IECG 8 channels, 16 inputs (6000 Hz per channel)
(CardioLab only)
32 channel (Clab II Plus), 16 channels, 32 inputs (1000Hz per channel)
64 channel (Clab II Plus), 48 channels, 96 inputs (1000Hz per channel)

Table 11. Analog Output Cable for TRAMs (Defib Sync Cable)

The Analog Output cable interfaces to the 6-pin LEMO connector on the front panel of the 200, 500, and 
600 TRAM modules. The cable is 15’ long and is terminated for the TRAM connection only. 

Pin No. Wire Color Signal Name
INput

OUTput
Volts/Units

1 White Software Selectable OUT 1V/mV

2 Black Signal Ground

3 Red Digital Sync Pulse (Factory Set) OUT

4 Green Return Marker Pulse In IN

5 Yellow Analog Ground

Table 12. Analog Input Cable for TRAMs (External Analog Signal)

The Analog Input cable is designed to interface an external analog signal to one of the BP inputs on the TRAM module. This 
enables the MAC-LAB system to display that signal on the BP channel to which it is connected. The cable is 15’ long and is 
terminated for the TAM connection only. 

Pin No. Wire Color Signal Name
INput

OUTput
Volts/Units

1 Red Analog Signal IN 1 V/100 mmHg

2 Black Signal Ground
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Table 13. Analog Output Connector J4 (RAU)

Pin No. Sign Al

1 MOD B BP 4

2 MOD B BP 2

3 GND

4 GND

5 GND

6 GND

7 GND

8 GND

9 GND

10 MOD B ART BP

11 MOD B RESP/ECGV

Table 14. Analog Output Connector J4 (RAU)

Pin No. Sign Al

12 MOD B TRC2/ECG1

13 MOD B TRC1/ECG2

14 MOD B SYNC ECG

15 MOD A RESP

16 MOD A BP 3

17 MOD A BP 2

18 MOD A ART BP

19 MOD A RESP/ECGV

20 MOD A ECG V1

21 MOD A ECG Lead II

22 MOD A ECG Lead II

23 B SYNCECGRTN

24 MOD A ECG Lead II

25 MOD B BP 3
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Table 15. CardioLink Archive Waveform ML370 G2 Server

Hardware Option Low-End
2006433-003

Mid-End 
2006433-002

High-End 
2006433-001

Processor 933 MHz 933 MHz 933 MHz

Memory 256 MB 512 MB 512 MB

Added Controller N/A Integrated Smart Array Integrated Smart Array

RAID N/A RAID 5 RAID 5

Storage Capacity One 18.2 GB Hot Pluggable Ultra 
3 SCSI

Three 36.4 GB Hot Pluggable Ultra 
3 SCSI

Six 36.4 GB Hot
Pluggable Ultra 3 SCSI

Tape Drive 12/24GB DDS-s DAT Drive 12/24GB DDS-s DAT Drive 12/24GB DDS-s DAT Drive

CD-ROM High Speed IDE CD-ROM High Speed IDE CD-ROM High Speed IDE CD-ROM

Table 16. CardioLink Archive Waveform ML370 G3 Server

Hardware Option Low-End
2016992-003

Mid-End 
2016992-002

High-End 
2016992-001

Processor 2.8GHz Xeon 2.8GHz Xeon 2.8GHz Xeon

Memory 1GB / 200MHz 1GB / 200MHz 1GB / 200MHz

Added Controller Smart Array 641 Smart Array 641 Smart Array 641

RAID RAID 0 RAID 5 RAID 5

Storage Capacity One 72 GB Hot Pluggable Ultra 3 
SCSI

Three 146 GB Hot Pluggable 
Ultra 3 SCSI

Six 146 GB Hot Pluggable Ultra 3 
SCSI

Tape Drive AIT2 Drive (50/100 GB) AIT3 Drive (100/200 GB) AIT3 Drive (100/200 GB)

CD-ROM High Speed IDE CD-ROM High Speed IDE CD-ROM High Speed IDE CD-ROM

Remote System Support 56K modem or VPN 56K modem or VPN 56K modem or VPN

Table 17. SCSI Drive Locations

SCSI ID and Bay location. 2006433-001 2006433-002 2006433-003

SCSI ID 0 (this is the bottom bay in 
the Drive array cage)

36.4 GB hot 
swappable drive.

36.4 GB hot swappable 
drive.

18.2 GB hot swappable 
drive.

SCSI ID 1 36.4 GB hot 
swappable drive.

36.4 GB hot swappable 
drive
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SCSI ID 2 36.4 GB hot 
swappable drive.

36.4 GB hot swappable 
drive

SCSI ID 3 36.4 GB hot 
swappable drive

SCSI ID 4 36.4 GB hot 
swappable drive

SCSI ID 5 36.4 GB hot 
swappable drive.



A-12 Mac-Lab/CardioLab Revision E
2007623-079

Appendix A – Technical Specifications: CardioLink Server G1

CardioLink Server G1

Table 18. CardioLink Server 

CardioLink Server

Dimensions

Height 8.67 in. / 22.02 cm

Depth 22.75 in / 57.78 cm

Width 19.0 in / 48.26 cm

Weight

No drives installed 50.0 lb / 22.68 kg

Input Requirements

Rated input voltage 100 to 240 VAC

Rated input frequency 50 to 60 Hz

Rated input current 6A (110V) to 3A (220V)

Rated input power 550W

BTUs per hour 1880

Power Supply Output Power

Rated steady-state power 325W

Maximum peak power 350 W

Temperature Range

Operating 50°F to 95°F / 10°C to 35° C

Shipping -22°F to 122°F / -30°C to 50°C

Relative Humidity (noncondensing)

Operating 8% to 90%

Nonoperating 5% to 95%

Wet Bulb Temperature

Maximum 101.7°F / 38.7°C

Connector Interfaces

Integrated Dual Channel Wide Ultra2 
SCSI Controller on Port 1 (internal 
and external) and Port 2 (internal 
only)

Hot-plug keyboard

Mouse

Serial 2

Parallel

IDE Interface for CD-ROM drive
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NC31163 Fast Ethernet NIC 
Embedded 10/100 WOL with RJ-45 
Interface

Video

Operating Voltage Settings (Low-
Voltage Models)

120V (User selectable for 100, 110, 120, 127 V via front panel)

Power Out (VA/Watts) 2880 / 2700

Input Connection NEMA L5-30P

Output Connection (1)L5-30R; (6)5-15R

UPS R3000 XR

Unit Dimensions 3.50 x 19.0 x 24.5in / 89 x 483 x 622 mm

Shipping Dimensions 14 x 32 x 38.5 in / 356 x 813 x 978 mm

Unit Weight 82 lb / 37 kg

Shipping Weight: 105 lb / 48 kg

Electrical. Input

Voltage Range  100, 110, 120, and 127V selectable via front panel

Frequency  50/60 Hz

Online Efficiency  96%

Surge Suppression  High Energy 6500A peak

REPO:  Remote Emergency Power-Off disables AC power to load

Electrical Output

Online Regulation  -10% to +6% of nominal voltage

On battery Regulation  +5% of nominal voltage

Voltage Wave Form  Sine wave

Output Protection  Re-set table circuit protectors

Environmental and Safety

Operating Temperature  50× F to 104× F / 10× C to 40× C

Transit Temperature  -13× F to 131× F / -25× C to 55× C

Storage Temperature  32× F to 77× F / 0× C to 25× C

Humidity (Operation)  20% to 80% (non-condensing)

Humidity (Non-Operating)  5% to 95%

Operating Altitude  Up to 6,562 ft / 2000 m above sea level

Transit Altitude  49,212 ft / 15,000 m above sea level

Safety Markings  FCS, UL, CSA, VDE, NEMKO, FIMKO, DEMKO, SEMKO, NOM

Safety Certifications  UL1778; CSA22.2 No.107.1, No.107.2, No.950; CB Bulletin No.86AI; EN50091-1; 
EN60950; EMKO-TSE207/95; NOM-019-SCFI-1993

EMC Markings  FCC; CISPR; VCCI; CE

Table 18. CardioLink Server  (Continued)
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Rack for CardioLink Server

Emissions  FCC CFR 47, Part 15 Class A, EN50091-2

Immunity  IEC 801-2, IEC 801-3, IEC 801-4, IEC 801-5

Surge Suppression  Conforms to IEEE 587B and ANSI C62.41

REPO Port  Meets NEC code 645-11 intent and UL requirements

Network Switch 2001084-001

Eight 10/100 Base-Tx Autosensing Ports

Auto-Negotiating Full and Half Duplex

Store-and Forward Switching

Connectors 8 RJ-45 Ports ((MDI/MDUX Selectable on Prot 8)

Dimensions

Width 220 mm (8.7 in.

Height 54.6 mm (2.1 in.) 

Depth 185.4 mm (7.3 in)

Power 16.6 VA

Standards

Functional/EMC ISO 8802; IEEE 802.3; EMC; EN 55022-1;FCC PART 15 CLASS B; ICES-003 CLASS B; 
CSA C108.8 CLASS B; VCCI CLASS B; AS/NZS 3548 CLASS B

Safety UL 1950; 60950 CSA 22.2 #950

Table 18. CardioLink Server  (Continued)

Table 19. Rack for CardioLink Server 

Dimensions (H x D x W)

Total Cabinet Area 49.5 x 33.25 x 23.25 in / 1257.3 x 844.55 x 590.55 mm

Shipping 56.63 x 48 x 32 in / 1438.4 x 1219.2 x 812 mm

Weight

Operating 176 lb / 79.89 kg

Shipping 225 lb / 102.13 kg

Color

Opal Beach Gray
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CardioLink Server G2

System Specifications

The CardioLink rack-mount server is a Compaq ProLiant ML370 
Generation 2 (G2) server.

ProcessorsTwo 1.26 GHz

Item Description

Processors Two 1.26 GHz

System Memory 2 GB

Expansion Slots Eight I/O expansion slots

Media Bays IDE CD-ROM drive
3 1/2”, 1.44 MB diskette drive
DLT Tape Drive

Keyboard The keyboard connector is hot-pluggable. Any standard keyboard 
can be plugged in without powering down the system or causing 
keyboard errors.

Mouse The keyboard uses an integral trackball that is plugged into the 
standard mouse port on the rear of the CPU.

Video Integrated ATI Rage XL PCI
Video Controller with 8MB

High-Availability Features Hot-Plug Redundant Power supplies
Redundant fans
RAID support with Smart Array Family controllers

System Management Integrated Management Log (IML) provides a detailed log of key 
system events. This log is accessible through Compaq Insight 
Manager.

Fans Three redundant hot-swappable fans.

Power Supply Redundant power supply: 500-W at 110V, 700-W at 220V
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Additional information, updates and the most current information on 
Compaq hardware is available at http://www.compaq.com.

Compaq Server Standard Features (Rack)

Feature Specification

Model Number Compaq Proliant ML370 Generation 2 (G2)

System Memory 2 GB

Hard drive capacity � 100 GB Tower / 300GB Rack
� 300 GB (11 x 36.4 RAID 5 with Hot Spare)

Processor 1.26 GHz

Cache Memory 512 KB second level ECC cache (full speed)

Video/Graphics Integrated ATI Rage XL Video Controller with 8mb SDRAM Video 
memory

Network Controller (2) Compaq NC 3123 Fast Ethernet NIC

Diskette Drive 1.44 MB

CD ROM 40x IDE

Power supply 500 Watt Redundant Dual

Interfaces Parallel 1, Serial 2, Pointing Device (Mouse) 1, Graphics 1, 
Keyboard 1, External SCSI (for tape only) 1, Network RJ-45 2, 
USB Ports 2

Tape Drive DLT, DDS-3

Storage Controller Integrated Dual Channel Wide Ultra3 SCSI Adapter and Compaq 
Smart Array 5i Controller Option Kit.
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Rack Server Specifications

Feature Metric Units English Units

Dimensions

Height 22.07 cm 8.69 in

Depth 65.41 cm 25.75 in

Width 48.26 19.0

Weight

No drives installed 23.05 kg 50.8 lb

Power supply input

Rated input voltage 90 to 264 VAC

Rated input frequency 47 to 63 Hz

Rated input current 7.3 A (110v) / 3.6 A (220v)

Rated input power 800W

BTU’s per hour 2732

Power supply output

Rated steady-state power 500 W

Maximum peak power 550 W for up to two minutes

Rated output voltages +5., +3.3, +12 (VDC)

Rated auxiliary voltage +5 VDC

Temperature range

Operating 5 to 35 degrees C 41 to 95 degrees F

Shipping -40 to 50 degrees C -40 to 185 degrees F

Relative humidity (noncondensing)

Operating 5% to 95% 5% to 95%

Non-operating 5% to 95% 5% to 95%

Maximum wet bulb temperature 38.7 degrees C 101.7 degrees F
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 LaserJet 4200 Printer

Table 20. HP LaserJet 4200 Printer

GEMMS PN 2015205-001

Manufacturer/Model Hewlett Packard / Q2425A

Description HP Laserjet 4200 Printer, 48 MB RAM
PostScript Level 2, HP PCL 6, 120V
Included: Toner cartridge, 500-sheet paper tray, power cord, drivers, and documentation.

Speed 17 pages per minute (ppm)
133 MHz RISC microprocessor
First page out = 15 seconds
“RIP ONCE” capability with 16 MB or hard disk option.

Resolution 600 dpi 
Level 2 emulation (PS) 
HP FastRes 1200 (PCL6, PS) 
HP ProRes 1200 at engine speed (17 ppm) (PCL6, PS) 

Typefaces 100 Scalable TrueType (80 built-in, 30 via HP FontSmart) Euro symbol 

Memory Options 48 MB RAM standard

Optional Memory 4, 8, 16, MB EDO DIMMs
4, 8, 16, 32, 64 MB SDRAM DIMM

Mass Storage Options 2 and 4 MB Flash DIMMs 
Greater than 1GB hard disk

Expansion Slots 3 100-pin DIMM slots
2 enhanced I/O (EIO) slots

Interface Bidirectional IEEE 1284-compliant parallel 
RS232 9-pin serial Paper Handling Connector (PHC) 

Optional Networking 10Base-T and 10Base-2
100Base-TX
Token Ring
LocalTalk 

 Paper Trays 100-sheet Tray 1 
Size: 76 x 127 mm to 2
16 x 356 mm
(3 x 5 inches to legal) 

500-sheet Tray 2,3
Size: letter, legal, A4 

Paper Path Straight through from Tray 1 to Rear
Output Bin or to Top Output Bin

Output Capacity 250-sheet Top Output Bin 
50-sheet Rear Output Bin

 Paper Handling Options Duplexer, Envelope Feeder, Optional
500-sheet Universal Tray Assembly
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Physical Specifications

Height 366 mm (14.4 inches)

Width 412 mm (16.4 inches)

Depth 439 mm (17.3 inches)

Depth (trays/rear output bin open) 100.76 cm (39.67 inches)
100.76 cm (39.67 inches)

Weight (without toner cartridge) 20 kg (45 lb)

Electrical specifications

Printer State
Printing
Standby 
PowerSave (default activation
time, 30 minutes) 
Off

Power Consumption (average, in watts) 
580 watts
<27 watts

<25 watts

Minimum recommended circuit capacity

Voltage
100-127 Volts 
220-240 Volts 

Amps 
8 amps 
4 amps 

Power requirements (acceptable line 
voltage) 100-127 Volts; (±10% 

50-60 Hz, (+/-2 Hz)

Environmental specifications

Condition
Operating Temperature

Relative Humidity

Specification
10 to 32 degrees C (50 to 91 degrees F)

20% to 80% RH

Acoustic emissions (per ISO 9296)

Condition
 
Printing, 35 ppm 
PowerSave

Specification

Lwad = 6.8 bels (A) 
 Lwad = 4.0 bels (A) 

Safety certifications

Safety CSA, UL, NOM-1-NYCE, FCC Part 15B Class B, Canada

Table 20. HP LaserJet 4200 Printer (Continued)
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EMC

Supplementary Information: The product herewith complies with the requirements of the following Directives and carries 
the CE-marking accordingly: 

the EMC directive 89/336/EEC 

the Low-Voltage Directive 73/23/EEC 

[1] The product was tested in a typical configuration with Hewlett-Packard Personal 
Computer Systems. 

[2] This Device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: This device may not cause harmful interference, and this device 
must accept any interference received, including interference that may cause undesired 
operation.

Table 20. HP LaserJet 4200 Printer (Continued)

CISPR 22:1993+A1 / EN
55022:1994 Class B (1) 
EN 50082-1:1992 
IEC 801-2:1991 / prEN
55024-2:1992 - 
IEC 801-3:1984 / prEN
55024-3:1991 - 
IEC 801-4:1988 / prEN
55024-4:1992 -

4 kV CD, 8 kV
AD 
4 V/m 
0.5 kV Signal 
Lines 
1.0 kV Power
Lines

IEC 1000-3-2:1995 / EN61000-3-2:1995 
IEC 1000-3-3:1994 / EN61000-3.3:1995 
FCC Title 47 CFR, Part 15 Class B (2)) /
ICES-003, Issue 2 / VCCI-2 (1)) 
AS / NZS 3548:1992 / CISPR 22:1993 Class
B (1))
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HP 2200 D 

Table 21. HP LaserJet 2200 D Printer

GEMMS PN 2007078-001

Manufacturer/Model Hewlett Packard 2200 D

Speed 19 pages per minute (ppm)
133 MHz RISC microprocessor
First page out = 15 seconds

Resolution 1200 x 1200 dpi 

Memory Options 8 MB standard; expansion available up to 64 MB

Media Handling and Weights Tray 1: up to 100 sheets 
Tray 2 up to 250-sheets 

Interface 1 bi-directional parallel port (IEEE 1284 ECP-compliant, B-size); 1 fast infrared port (IrDA 
compliant); 1 LocalTalk port of r Macintosh and 1 Enhanced Input Output) EIO) slot; HP 
JetSend enabled (Ir and EIO only)

Physical Specifications

Width and Depth 16 x 10 x 17.1 in. (405 x 255 x 435 mm)

Power 100/127 V; AC 50/60 Hz

Weight 29 lb (14 kg)

Table 22. IEB Dimensions

Dimensions: Power
Height
Width
Depth

100 V, 50/60 Hz; 120 V, 50/60 Hz; 240 V, 50/60 Hz
24.5 in
11 in
21 in

Table 23. CPU Dimensions

Dimensions: Power
Height
Width
Depth

Auto Switching:100-120 4.6A, 60 Hz; 200-240 2.3A, 50 Hz
19 in
8.5 in
18 in
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Purpose

The purpose of this procedure is to enable CardioLink trained service 
personal to be able to successfully change the computer machine name 
of a CardioLink server. There are two sections: The first are instructions 
on changing a server name that has not yet been installed and is still at 
the manufactured base image. The second are instructions for changing 
the name of a server that has had CardioLink software installed, or has 
been in replication. Please use the appropriate sections when 
doing the conversion.

	�
����
An Administrator MUST run the server rename 
procedure. Failure to do so will cause the server rename 
to FAIL because the user may not have enough 
privileges. 

Special Notes

1. Applying this kit will alter the current CardioLink disaster recovery 
process. If for any reason the server is re-imaged to the production 
base server image in the event of a recovery, then the server 
computer name will be set back to CLINK_2. In these cases, this kit 
must be reapplied to the server with the exact server computer name 
that was used prior to the re-image of the server and before any other 
software or database restores are reinstalled onto the server.

2. For version 1.1D ONLY, once this kit has been applied to an existing 
CardioLink 1.1C environment, the rename utility CD must be re-run 
on the server after that environment is updated to CardioLink 1.1D. 
This is in order to correct the system files to the current server name 
that were installed with the CardioLink 1.1D update. Again, this 
action is to only update the system files, not to change the server 
name again.

����
If any user errors are reported while running the server rename 
utility and the utility exits uncompleted, then the server computer 
name must be re-named back to the previous computer name and the 
server rename utility must be re-run to correct the system state. 
Then the server must be named to the desired name and the server 
rename utility must be run once more.
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Equipment needed

� For version 1.1D
� Rename Server Utility CD (PN: 2012484-001)

� For version 5.2
� CardioLink CD (PN: 2015223-001)

Reference documentation:

� Centricity CardioLink Installation/Upgrade Instructions
� Centricity CardioLink Operator’s Manual

Customer Notification

During this conversion procedure, the CardioLink server will be renamed 
and will require that replication be stopped and all clients moved into 
stand alone mode for a short period of time.   After conversion, it is 
extremely important that all clients be properly redirected to the new 
server name to prevent possible patient data loss.
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New Server Install

����
Please follow these steps carefully and precisely.

After the server hardware has been installed and setup, perform the 
following steps to rename the server before installing any other software.

1. Verify that the server is at the base image by checking that the D: 
drive has no gemms or program files folder.

2. At the CardioLink server using the network applet in the control 
panel, select the Change button and change the CardioLink server 
computer name to the new name. 

3. Select OK in the identification window. Select OK in the information 
window, then select Close. Select Yes to restart the computer. Allow 
the system to reboot and logon as an administrator.
������

See system administrator for login information

4. Using the CD, run setup to reinstall SQL 7.0 and correct the master 
database server name. Use the following steps:

For version 1.1D:
a. Insert the Rename Server Utility CD.
b. Run E:\setup.exe.
c. Select Next at the welcome window.
d. Verify that the radio button for Rename Server (Reinstall SQL) is 

selected, then select Next.
e. Verify that setup has detected the new server name correctly and 

then select Yes to confirm.
f. Setup will begin file copy, reinstall SQL 7.0, and correct the 

master database server.
g. Setup will display an Information dialog box indicating that This 

utility must be re-run after the CardioLink application has been 
installed. Select OK.
������

This process may take 5 to 10 minutes.
h. Once this step completes, select Yes, I want to restart my 

computer now. Select Finish to restart the server. Logon as an 
Administrator.
������

See system administrator for login information

For version 5.2:
a. Insert the CardioLink CD.
b. Run E:\Server Rename Install\setup.exe.
c. Select Next at the welcome window.
d. Verify that the radio button for Rename Server (Reinstall SQL) is 

selected, then select Next.
e. Verify that setup has detected the new server name correctly and 

then select Yes to confirm.
f. Setup will begin file copy, reinstall SQL 7.0, and correct the 

master database server.
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g. Setup will display an Information dialog box indicating that This 
utility must be re-run after the CardioLink application has been 
installed. Select OK.
������

This process may take 5 to 10 minutes.
h. Once this step completes, select Yes, I want to restart my 

computer now. Select Finish to restart the server. Logon as an 
administrator.
������

See system administrator for login information
5. Launch Enterprise manager under Start > Programs > Microsoft 

SQL server 7.0 and verify that the new CardioLink server computer 
name is registered and working denoted by a green arrow. Also verify 
that there is no registration for CLINK_2. If the new name does not 
appear and there remains a registration for CLINK_2, then perform 
the following steps:
a. Under the SQL Server Group, right click on the entry for 

CLINK_2 and select Delete SQL Server Registration. Select Yes 
to confirm.

b. Right click on SQL Server Group and select New SQL Server 
Registration.

c. Select Next at the next window.
d. From the available server window, select the new name of the 

CardioLink server and select Add. Select Next.
e. Verify that the Windows NT account information radio button is 

selected, then select Next.
f. Verify that the add to existing group radio button is selected, 

then select Next.
g. Select Finish and verify that the new CardioLink server name is 

registered successfully.
6. Using the network applet under control panel, correct the SNMP 

traps to the new server name. Use the following steps:
a. In the Network window, select the Services tab.
b. Select on SNMP service, then select Properties.
c. In the SNMP Properties window, select the Traps tab.
d. Under the Trap Destination window, remove the entry for 

CLINK_2.
e. Select Add and enter the new name of the CardioLink server. 

Select Add.
f. Select OK on SNMP Properties window.
g. Select Close on the Network window.

7. Correct Insight manager’s console to monitor the new name of the 
CardioLink server and remove the old device name for CLINK_2. 
Use the following steps:
a. Open Insight manager by selecting Start > Programs > Compaq 

Insight Manager > Compaq Insight Manager.
b. From the top pull down menus, select Setup > Device List.
c. In the Responsible Device list, highlight the entry for CLINK_2 

then select Remove.
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d. Select the IP Device List button.
e. Select the New button.
f. Enter into the Device name field the new name of the CardioLink 

server. Check the box for WINS/DNS IP Address Resolution and 
then select the Add button. Select Close.

g. In the IP Device list window, highlight the entry for CLINK_2 
and then select Remove. Select OK.

h. In the List all Devices list, highlight the entry for CLINK_2 then 
select Delete. Select Yes.

i. If the new server name is not already in the Responsible Device 
List, select on the new name of the server from the List of All 
Devices window, and select Add. Confirm that the Responsible 
Device List shows the new CardioLink server name.

j. Select OK.
k. Verify that in the Device List 1 window, the new CardioLink 

server is shown and has a green status.
8. After the rename process has been run, reboot server and proceed 

with the CardioLink installations as currently documented in the 
CardioLink installation manual and then perform the following 
steps:
a. After the CardioLink application has been installed on the 

server, the server rename utility CD must be re-run on the server 
in order to correct the system files to the current server name 
that were installed by CardioLink. Verify that when the rename 
utility is re-run, an information dialog box displays Update of the 
backup scripts is now set to the current server name and a 
message that This utility is now complete.
������

This step is just to rerun the server rename utility to update 
system files and NOT to change the server name.

b. After the CardioLink application has been installed, edit the 
timeserv.ini file in the C:\WinNT directory with the following 
steps on the server and all acquisition and review systems.

c. Edit the PrimarySource = value to \\ <CardioLink Server 
Name>.

d. Select Start > Run, and type in timeserv -update.
e. Select Start > Run, and type in timeserv -automatic.
f. Reboot all machines to commit timeserv changes.
����

Please complete the attached “CardioLink Server Rename 
Record” on page B-15 and fax to Technical Support for their 
records (561-575-5055).

9. Proceed to “System Functional Checkout Procedure” on page B-14.



B-8 Mac-Lab/CardioLab Revision E
2007623-079

Appendix B – CardioLink Server Rename: Re-name Installed Server

Re-name Installed Server

����
Please follow these steps carefully and precisely. Mistakes may cause 
loss of customer data.

1. Please write down the current server name:______________________.

2. Run the Archive Generator manually 
D:\gems\Prucka\network\ag.exe on all acquisition machines to 
move all studies to the server. Verify that it ran successfully and that 
all client system catalogs are clear of any studies.

3. Perform a full backup of the database and patient study directory as 
described on the CardioLink operators manual. Refer to the weekly 
backup section.

�������
The following step 4 must be run prior to launching the 
rename utility.

4. Disable replication on the server as described in the CardioLink 
Installation/Upgrade Instructions.

5. Run on all acquisition clients the following two files in order. 

a. D:\gemms\Prucka\network\stoprepl.bat.

b. CD Rom\Gems_Replicationcheck.bat (found on Rename Server 
Utility CD.)

c. Be sure confirmation that it is ok to proceed is received after 
running this check.

6. Move all client machines (acquisition and review) to stand-alone by 
un-checking Enable network storage under Administration > System 
Settings > File Paths. Then place them at the NT desktop.

7. On the server, run the file GEMS_replicationcheck.bat from the 
utility CD and verify that it displays a message that The replication 
check has passed. It is OK to proceed.

8. At the CardioLink server using the network applet in the control 
panel, select the Change button and change the CardioLink server 
computer name to the new name. 

9. Please record new server name:__________________________________.

10. Select OK in identification window. Select OK in the information 
window, then select Close. Select Yes to restart the computer. Allow 
the system to reboot and logon as an administrator.

������
See system administrator for login information.

����
You will see a message on reboot Your SQL Server installation is 
either corrupt or has been tampered with, (unknown package ID). 
Please rerun setup. Click OK.
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11. Using the appropriate CD, run setup to reinstall SQL 7.0 correct the 
master database server name and clab database location pointers. 
Use the following setup.

For version 1.1D
a. Insert the Rename Server Utility CD.
b. Run E:\setup.exe.
c. Select Next at the welcome window.
d. Verify that the radio button for Rename Server (Reinstall SQL) is 

selected, then select Next.
e. Verify that setup has detected the new server name correctly and 

then select Yes to confirm.
f. Setup will begin file copy, reinstall SQL 7.0, and correct the 

master database server and clab database location pointers. 
������

This process may take 5 to 10 minutes.
g. Setup will display an information dialog box indicating that 

backup scripts were set to the new server name and the utility 
must be rerun on this server if the CardioLink application is 
later updated.

h. Once this step completes, select Yes, I want to restart my 
computer now. Select Finish to restart the server. Logon as 
Administrator.

For version 5.2
a. Insert the CardioLink CD.
b. Run E:\Server Rename Install\setup.exe.
c. Select Next at the welcome window.
d. Verify that the radio button for Rename Server (Reinstall SQL) is 

selected, then select Next.
e. Verify that setup has detected the new server name correctly and 

then select Yes to confirm.
f. Setup will begin file copy, reinstall SQL 7.0, and correct the 

master database server and clab database location pointers. 
������

This process may take 5 to 10 minutes.
g. Setup will display an information dialog box indicating that 

backup scripts were set to the new server name and the utility 
must be rerun on this server if the CardioLink application is 
later updated.

h. Once this step completes, select Yes, I want to restart my 
computer now. Select Finish to restart the server. Logon as an 
administrator.
������

See system administrator for login information.
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12. Launch Enterprise manager under Start > Programs > Microsoft 
SQL server 7.0 and verify that the new CardioLink server computer 
name is registered and working as denoted by a green arrow. Also 
verify that there is no registration for CLINK_2 or the previous 
server name. If the new name does not appear and there remains a 
registration for CLINK_2 or the previous server name, then perform 
the following steps:

a. Under the SQL Server Group, right click on the entry for 
CLINK_2 or the previous server name and select Delete SQL 
Server Registration. Select Yes to confirm.

b. Right click on SQL Server Group and select New SQL Server 
Registration.

c. Click Next at the Welcome window.

d. From the Available Server window, select the new name of the 
CardioLink server and select Add. Click Next.

e. Verify that the Windows NT account information radio button is 
selected, then select Next.

f. Verify that the add to existing group radio button is selected, 
then select Next.

g. Select Finish and verify that the new CardioLink server name is 
registered successfully. 

13. If LMHOSTS files are used for name to IP resolutions, correct the file 
at C:\WINNT\SYSTEM32\DRIVERS\ECT by editing the line 
entry for CLINK_2 or the previous server name to the new server 
name on the server and all client machines and reboot all machines 
for the change to take effect. If LMHOST files were not used proceed 
to Step 14.
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14. After all machines are rebooted, launch Network Neighborhood and 
verify all machines can browse the new named CardioLink server.

15. Using the network applet under control panel, correct the SNMP 
traps to the new server name. Use the following steps:

a. In the Network window, select the Services tab.

b. Select on SNMP service, then select Properties.

c. In the SNMP Properties window, select the Traps tab.

d. Under the Trap Destination window, remove the entry for 
CLINK_2 or the previous server name.

e. Select Add and enter the new name of the CardioLink server. 
Click Add.

f. Click OK on SNMP Properties window.

g. Select Close on the Network window.

16. Correct Insight manager’s console to monitor the new name of the 
CardioLink server and remove the old device name for CLINK_2 or 
the previous server name. Use the following steps:

a. Open Insight Manager by selecting Start > Programs > Compaq 
Insight Manager > Compaq Insight Manager.

b. From the top pull down menus, select Setup > Device List.

c. In the Responsible Device List, highlight the entry for CLINK_2 
or the previous server name, then select Remove.

d. Select the IP Device List button.

e. Select the New button.

f. Enter into the Device name field the new name of the CardioLink 
server. Check the box for WINS/DNS IP Address Resolution and 
then select the Add button. Select Close.

g. In the IP Device List window, highlight the entry for CLINK_2 or 
the previous server name and then select Remove. Select OK.

h. In the List all Devices list, highlight the entry for CLINK_2 or the 
previous server name, then select Delete. Select Yes.

i. If the new server name is not already in the Responsible Device 
List, select on the new name of the server from the List of All 
Devices window, and select Add. Confirm that the Responsible 
Device List shows the new CardioLink server name.

j. Select OK.

k. Verify that in the Device List 1 window, the new CardioLink 
server is shown and has a green status.

17. On the CardioLink server delete the file 
D:\gemms\Prucka\NetConfig\history.log.
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18. Assure that each acquisition system is registered in Enterprise 
Manager and perform the following tasks on EACH registered 
acquisition system:

a. Open Enterprise Manager

b. Expand the Server by clicking the + 

c. Expand the Security folder

d. Expand Linked Server

e. In the Linked Server folder, right-click on the old server name.

f. In the pop-up menu, click Delete.

g. In the Confirmation windows (both delete of server and remote 
logins will also be dropped), click Yes.

h. Close Enterprise Manager.

19. After the server has been renamed and the DB utilities have 
successfully run, restart replication as described in the Centricity 
CardioLink Installation/Upgrade Instructions. When asked to 
consolidate, select No and confirm Yes for all acquisitions systems.

20. Edit the timeserv.ini file in the C:\WinNT directory with the 
following steps on the server and all acquisition and review systems.

a. Edit the PrimarySource = value to \\ <CardioLink Server 
Name>.

b. Select Start > Run, and type in timeserv -update.

c. Select Start > Run, and type in timeserv -automatic.

21. Redirect all clients (Acquisition and Review) network storage path 
the new name of the CardioLink server. Under Administration > 
System Settings > File Paths, set Network Storage Path to \\<New 
Name of CardioLink Server>\PruckaStudies and check Enable 
network storage.

22. For systems that had LMT installed on the CardioLink server, the 
ODBC settings need to be corrected to the new server name and the 
tables re-linked. Perform the following steps on the server first and 
then all clients using LMT:

a. Launch the Control Panel applet for Data Sources (ODBC).
b. Select the tab for System DSN.
c. In the System Data Sources list, highlight the entry for 

CLinkSQL then select the Configure button.
d. In the Sever DSN Configuration window, change the Which SQL 

Server do you want to connect to? to be the new name of the 
CardioLink server from the pull down select list (if it is not listed 
type in the name), then select Next.

e. Leave the existing settings on How should SQL Server verify. 
Select Next.

f. Verify that the Change the default database to: is still set to 
clink, then select Next.

g. Then select Finish.
h. Select the Test data Source button and verify that test completed 
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successfully. Select OK on the test window.
i. In the New ODBC window, select OK.
j. In the ODBC Data Source Administrator window, select OK.
k. On LMT Client computers, launch the LMT applications and at 

the login window select the Utilities button then select the button 
to Re-Link Database Tables. Select OK.

l. Verify these steps are run on the server and all clients.
23. Reboot server and all client computers.

����
If there were any Enterprise backup tasks created for this 
CardioLink server they will need to be redirected to the new server 
name. In addition if there were any PCAnywhere LAN links to this 
server they will also need to be redirected to the new server name.

����
Please complete the attached worksheet “CardioLink Server Rename 
Record” on page B-15 and fax to Technical Support for their records 
(561-575-5055).

24. Proceed to “System Functional Checkout Procedure” on page B-14.
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System Functional Checkout Procedure

1. Using Network Neighborhood, verify that all client computers can 
browse the new server name and that the server can browse the 
client computers.

2. Launch Enterprise Manager under Start > Programs Microsoft SQL 
server 7.0 and verify that all systems including the new server name 
are registered and working (denoted by green arrow) and that there 
is no entry for CLINK_2 or the previous server name.

3. Verify that the Replication Monitor shows no errors in Enterprise 
Manager.

4. Verify that all client computers have their network storage path 
redirected to the new server name and that no systems show the 
error CardioLink Server unavailable. 

5. Verify from one Acquisition computer that a previously created 
network study can be reviewed.

6. Verify from one Review computer that a previously created network 
study can be reviewed.

7. Verify from one Acquisition computer that a new test patient study 
can be created and is automatically displayed on other system’s 
network catalogs.

8. Verify that items from the lists can be entered into the log of this test 
patient.

9. Verify that list replication is still functioning by making a change to 
the list and checking that the change is reflected on other systems.

10. Verify from one review station that the new test patient can be 
reviewed.

11. Verify at the CardioLink server that the Insight manager shows the 
new name of the server in the device list and has a green status.

12. Verify at one of the client computers that LMT application can be 
launched and that the previous data is still accessible.

13. Perform a full backup of the database and patient study directory as 
described on the CardioLink operators manual. Refer to the weekly 
backup section.
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CardioLink Server Rename Record

Hospital Name: 
________________________________________________________________

Address: 
_____________________________________________________________________

City: _____________________________  State: __________  Zip:_________________

Site Contacts:

I.S. Contact/Lab Manager: __________________________ 

Title: ___________________

Phone: ______________

Server Rename Data:

Date of Change:________________________________________________

Compaq Server Serial Number:___________________________________

Name of Server prior to Rename:___________________________________

Name of Server after Rename:_____________________________________

Print and fax to Technical Support the following two log files as well as 
this worksheet:

1. D:\gemms\prucka\Setup\Gems_SvrRename.log

2. D:\gemms\Prucka\Database\maintenance\log\Gems_SvrNameChanger.log

GE Medical Systems Contacts:

Field Engineer: 
________________________________________________________________

*Fax number for Technical Support is 561-575-5055.



B-16 Mac-Lab/CardioLab Revision E
2007623-079

Appendix B – CardioLink Server Rename: CardioLink Server Rename Record



Revision E Mac-Lab/CardioLab Index-1
2007623-079

Index



Index-2 Mac-Lab/CardioLab Revision E
2007623-079



Revision E Mac-Lab/CardioLab Index-3
2007623-079

Index

Numerics
120 VAC, 50/60 Hz 4-11
240 VAC, 50/60 Hz 4-11
32 A-7
96 A-7

A
A4 paper A-18
AC Line Voltage Test 4-11
AC line voltage tests 4-3
Amp 3-4
amplifier 1-7
Analog A-8
Assembly Block Diagram 3-4, 3-8, 3-10
Assembly Descriptions 3-3

B
bent prongs or pins 4-4
bioelectric 1-7
Block Diagram 3-4, 3-8, 3-10
board components 4-4
bodily fluids, exposure to 4-4
BP Cuff 3-6, 3-9
burn damage 4-4

C
cables 4-7
Cardiac A-8
cartridge

toner A-18
cellular 1-7
Chapter Content 1-6
Chassis 7-4
check fuses 5-7
Checkout Procedure 5-8
Circuit Boards, inspecting 5-6
Class 1-7
cleaning 4-6

exterior spills 4-9
interior of console 4-9
Remote Acquisition Unit 4-9
TRAM 4-9

cleaning solution 4-4
Cleaning the Exterior 4-4
Cleaning the Interior 4-6
cleaning the unit 4-3
Color distortion 5-13
color distortion 5-4
colors missing 5-13
common causes for failure 5-3
Components 3-3, 3-6, 3-9
condensation 4-4
connectors 4-9
console

cleaning interior 4-9
Console/RA Unit Error Messages 5-15

contamination 4-4
continuity 4-13
Control Room 3-6
cracks 4-4

D
damage 4-4
Data 5-8
Data Transmission 5-9
debris 4-4, 5-3
Degree A-3
device

name 1-17
digital voltmeter 4-11
disassembly 3-6, 3-9
Disassembly Guidelines 4-6
discoloration 4-4
disconnected cables 5-3
disformation 4-4
Diskette drive 4-4
Domestic Electrical Safety Tests 4-11

E
ECG 5-8, 5-16, A-3, A-8
ECG data missing 5-16
electromagnetic 1-7
electrosurgical 1-7
EMC

HP LaserJet 4050N A-20
Environmental Specifications A-6
environments 4-3
Equipment 4-13, A-3
equipment 4-6

cleaning interior 4-9
equipment failure 5-3
Error Messages

No Module 5-9
Errors

No Boot Up 5-4
ESU 1-7
European 1-7
exposed metal surfaces 4-13
exterior spill

cleaning up 4-9

F
fading traces 5-16
Failure Modes

No display, system appears not to initialize 5-7
Remote Acquisition Unit 5-16
Video 5-13
Writer 5-15

failure of leakage test 4-12
FCC compliance

HP LaserJet 4050N printer A-20
First Things to Ask 5-3



Index

Index-4 Mac-Lab/CardioLab Revision E
2007623-079

floppy disk drive 5-7
floppy disk drive failure 5-7
Front End (see Remote Acquisition Unit) 5-9
Front End Data Acquisition, checkout 5-8
Functional Checkout Procedure 5-8
Fuse A-3
Fuses, inspecting 5-6

G
grid, paper 5-15
Ground Continuity 4-13
Ground continuity test 4-3
ground continuity, out of range 4-13
ground straps 4-4
ground wire 4-3
Ground Wires/Wiring, inspecting 5-6

H
hard disk drive failure 5-7
hardware connectors 4-5
harmful chemicals 4-4
hospital emergency power 3-4, 3-7, 3-10
how to

read label 1-17
HP LaserJet 4050N printer A-18, A-21

I
I/O Connectors and Cables, inspecting 5-6
IEB 3-4, 4-10, 5-3, 5-4, 5-8
IECG A-8
inappropriate diskettes 5-4, 5-5, 5-8, 5-9, 5-10, 5-11, 5-

12, 5-13, 5-15, 5-16
Inspecting 4-3
inspecting circuit boards 5-6
inspecting fuses 5-6
inspecting ground wires/wiring 5-6
inspecting I/O connectors and cables 5-6
inspecting interface cables 5-6
inspecting mounting hardware 5-6
inspecting power source 5-6
Inspection and Cleaning 4-3
Integrated 4-4
Intended Audience 1-3
interface cable 4-5
Interface Cables, inspecting 5-6
Invasive A-8

L
leakage 1-8, 4-12
Leakage Current Test Diagrams ??–4-13
Leakage Current Tests 4-12
leakage tester 4-12
Leakage tests 4-3
licensed 1-8
line conditioner 3-4, 3-7
line wire 4-3

loose components 5-3

M
machine gun noise 5-14
magnetic material 4-4
Maintenance 4-13, A-5
maintenance 4-8

annual 3-3, 3-6, 3-9, 4-3, 4-6, 4-7, 4-8, 4-9, 4-12
maintenance guidelines 4-3
Maintenance Schedule 4-3
Manual Purpose 1-3
manual revision 1-5
manuals, related 1-7, 1-8, 1-11, 1-16
manufacturer’s responsibility 1-7
menu bar 5-11
missing BP 5-16
missing hardware 4-4, 5-3
moisture 4-4
monitor servicing 5-12
monitors 5-11, 5-12

color change 5-4
installation checklist 5-12
no signal 5-5
went black 5-5

mounting bracket 4-5
Mounting Hardware, inspecting 5-6

N
name of device 1-17
neutral wire 4-3
Non A-8

O
oil 4-4
Operating Instructions 1-18
Optical 7-6, 7-8
out of range, ground continuity 4-13
overheated component 4-4

P
pacemakers 1-7
paper 5-15

jamming 5-14
upside down 5-14

paper speed 5-15
paper storage 5-15
parts 7-28
Patient Leads 3-3, 3-6, 3-9
Power A-3
power cord 4-3, 4-5
Power Source, inspecting 5-6
Power Up Failure Modes 5-7
Precautions 4-4
Pre-service Procedures 4-3
Pressure A-6
pressure values missing 5-10



Revision E Mac-Lab/CardioLab Index-5
2007623-079

Index

pressure waveforms
deleting or removing 5-10

preventative 4-10
preventive 4-6
preventive maintenance 4-3
print head

cleaning 4-8
print head assembly 5-15
printed circuit boards 4-4
printer

HP LaserJet 4050N A-18, A-21
printing

paper jams 5-14
too dark 5-16
too light 5-16

Procedure Room 3-3, 3-6, 3-9
product code 1-17
Pulse A-8

Q
queuing problems 5-15
queuing sensor 5-15

R
RAU 4-9, 5-9, 5-16, A-7
real-time data 5-11
Recommended Maintenance 4-3
Relative A-6
Remote Acquisition Unit 3-3, 3-6

cleaning 4-9
Troubleshooting 5-9

Repair A-5
Required Tools 4-3
resistance 4-13
Respiration A-8
Reviewing the Assembly 3-4, 3-7, 3-10
RF 1-7
RS 5-9
RS422 7-7
RS422 serial 5-9

S
safety

warnings 1-12
safety messages 1-11
serial data

TRAM 5-9
serial number 1-17
Service 7-28
service 4-13
Simulator 3-9
simulator 5-8
skin prep 5-16
Socketed components 4-4
software not loading 5-7
soldered components 4-4

solvent 4-4
Special Instructions for Bringing Equipment into Use A-

3
spills 4-3
Sweep A-5
symptoms 5-3
System Initialization 5-8
System Locked Up 5-4

T
Technical 5-14
Temperature A-6
Test Considerations 4-12
Theory of Operation 3-4, 3-8, 3-10
thermal 4-8
thermal printer

feeds blank paper 5-15
white line problem 5-16

thermal writer
paper advance problem 5-15

Thermal Writer Problems 5-14
Toggle keys 4-4
toner cartridge A-18
Tools, required 4-3
TRAM 4-9, 5-3, 5-8, 5-16, A-7
Tram A-4
TRAM module 5-9
TRAM module placement 5-9
transducer 5-10
transducer zeroing 5-16
Troubleshooting 5-1

Remote Acquisition Unit 5-9
Troubleshooting the Video Processing 5-11
Troubleshooting the Writer 5-15
TrueType fonts A-18

U
Uninterruptible Power Supply (UPS) 2-12

V
Video Assemblies 5-13
Video Buffer PCB 7-14
Video Processing

Troubleshooting 5-11
Visual Inspection 4-4, 5-3

W
wall outlet 5-3
warning

equipment 1-12
waveform display 5-11
Writer 7-13

Troubleshooting 5-15
Writer Failure Modes 5-15
writer release bar 5-15



Index

Index-6 Mac-Lab/CardioLab Revision E
2007623-079





http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com
http://www.gemedical.com

	Contents
	1 Introduction 1-1
	Document Information 1-3
	Revision History 1-3
	Manual Purpose 1-3
	Intended Audience 1-3
	Related Manuals 1-3
	Statement of Indications for Use 1-5
	Chapter Content 1-6

	Safety Information 1-7
	Electromagnetic Compatibility and Interference 1-7
	Responsibility of the Manufacturer 1-7
	General 1-8
	Equipment Symbols 1-10

	Conventions 1-11
	Safety Messages 1-11
	Definitions 1-11

	Danger, Warnings, and Cautions 1-12
	Service Information 1-16
	Service Requirements 1-16
	Equipment Identification 1-17
	Equipment Identifications Table 1-17

	Required Tools and Supplies 1-18
	Power Input Requirements 1-18


	2 Equipment Overview 2-1
	Acquisition Computer with Workstation 2-3
	Central Processing Unit (CPU) 2-3
	General Description 2-4
	Standard Equipment 2-4
	Additional Systems 2-5
	Optional Equipment 2-5
	CardioLink Server 2-5
	Software 2-5

	MotherBoard 2-7
	Component Boards 2-7

	Integrated Electronics Box (IEB) 2-11
	Introduction 2-11


	3 Installation 3-1
	Installation 3-3
	CardioLab 2000/4000/7000 3-3
	Mac-Lab 2000/4000/7000 3-6
	ComboLab 2000/4000/7000 3-9
	Integrated Electronics Box 3-12
	CardioLink Diagram 3-13

	Changing the SA Password 3-14
	On Server 3-14
	On Acquisition and Review Systems 3-14


	4 Maintenance 4-1
	Introduction 4-3
	Recommended Maintenance 4-3
	Operator’s Maintenance Schedule 4-3
	Pre-service Procedures 4-3
	Environmental Protection 4-3

	Inspection and Cleaning 4-4
	Precautions 4-4
	Daily Visual Inspection 4-4

	General Maintenance 4-6
	Cleaning the Exterior 4-6
	Cleaning the Monitor Screens 4-7
	Cleaning EP Cables 4-7

	Monthly Maintenance 4-8
	Cleaning the Print Head 4-8

	Annual Maintenance 4-9
	Cleaning the Interior 4-9
	Inspect All Cables, Plugs, and Connectors 4-9
	Cleaning the RAU and TRAM 4-9

	Preventative Maintenance 4-10
	Domestic Electrical Safety Tests 4-11
	AC Line Voltage Test 4-11
	Ground Continuity 4-13
	Maintenance/Repair Log 4-13
	Maintenance/Repair Log Table 4-14


	5 Troubleshooting 5-1
	Introduction 5-3
	Initial Inspection 5-3
	Visual Inspection 5-3

	General Troubleshooting for the System 5-4
	Problems 5-4

	Functional Checkout Procedure 5-8
	Introduction 5-8
	System Initialization 5-8
	Front End Data Acquisition 5-8

	Troubleshooting the RAU 5-9
	RAU Description 5-9
	TRAM modules in the RAU 5-9

	Troubleshooting the Video Processing 5-11
	General Information 5-11
	Video Failure Modes 5-13

	Thermal Writer Problems 5-14
	Troubleshooting the Thermal Writer 5-15
	Thermal Writer Description 5-15
	Repairing the Thermal Writer 5-15
	RAU Failure Modes 5-16

	Server UPS Troubleshooting 5-17
	During Start 5-18
	After Start 5-18
	UPS Alarm Conditions 5-20

	TRAM-net 4A LED Troubleshooting Chart 5-21
	CardioLink Utilities Troubleshooting 5-22

	6 Recovery Procedures 6-1
	CardioLink Server (5.2) 6-3
	Introduction 6-3
	Required Parts 6-3
	Ensure 5.2 backup tapes exist 6-4
	Stop data replication on the server 6-4
	Stop data replication and disable networking at each acquisition system 6-5
	Back up custom lists and reports 6-5
	Record system information at the server 6-6
	Record Microsoft security patches installed 6-7
	Record LMT information 6-7
	Check for advanced security 6-8
	Record job schedules 6-8
	Backup LMT Custom Reports 6-9
	Replace the Server Hard Drive (if applicable) 6-9
	Re-Image Server (G3 Only) 6-9
	Re-Image Server (G1 and G2 Only) 6-15
	Load AIT tape driver 6-21
	Restore data to the server 6-22
	Rename the Server 6-22
	Configure Network Settings 6-26
	Restore the CardioLink Database from BackupTape 6-29
	Enterprise Backups 6-31
	Install LMT server 6-37
	Install LMT client 6-37
	Install LMT Backup/Restore utility 6-39
	Re-Install Microsoft security patches 6-39
	Restore the GEMS Registry Key 6-39
	Restore the clab database 6-39
	Restore LMT database 6-40
	Install Serial Number update 6-40
	Restore LMT Custom Reports 6-41
	Verify time and time zone 6-41
	Register Acquisition systems 6-41
	Enable for advanced security 6-42
	Run the Replication utility 6-42
	Setup file paths at each Acquisition system 6-43
	Push emergency cases to the server 6-44
	Re-link LMT tables 6-44
	Restore ACC access /PedCath/Personal Files 6-44
	Schedule reports 6-45
	Verify the LMT application installed correctly 6-45
	Verify the modem connection and PC Anywhere 6-46
	Reconfigure hospital shares and mapped drives 6-46
	Reconfigure SQL Jobs 6-47
	Run DB Maintenance Job 6-47
	Setup Archive Generator 6-48
	Run a full tape backup 6-48
	CardioLink Network Functional Checkout Procedure 6-49


	7 Drawings and Parts List 7-1
	Diagrams/Drawings/Illustrations 7-4
	Chassis Front View 7-4
	Chassis Back View CD-ROM Drive 7-5
	Optical Drive - 3 1/2 7-6
	RS422 PCI Card 7-7
	Optical Drive - 5 1/4 7-8
	Back Panel Showing Slots for CardioLab/Mac-Lab Computers 7-9
	Slots for CardioLab/Mac-Lab Computer with RS422 or TRAM-net Card 7-10
	Back Panel Showing Slots for CardioLab/Mac-Lab Computers 7-11
	Slots for CardioLab/Mac-Lab Computer with PSI Card 7-12
	Thermal Writer 7-13
	Remote Acquisition Unit (RAU) with TRAM 7-14
	RAU Rear Panel 7-15
	RAU 7-16
	RAU 7-17
	Connections for the NT CardioLab/Mac-Lab Computer 7-18
	Rack-Mount Server Front View 7-20
	Rack-Mount Server Back View 7-21
	Rack-Mount Server UPS 7-22
	TRAMnet Communication 7-24
	TRAM-RAC 4A Housing 7-24

	Ordering Parts 7-28
	Introduction 7-28
	Appendix A - Technical Specifications A-1


	Specifications A-3
	Special Instructions for Using Equipment A-3
	Environmental A-6

	CardioLink Server G1 A-12
	CardioLink Server A-12
	Rack for CardioLink Server A-14
	CardioLink Server G2 A-15
	System Specifications A-15

	LaserJet 4200 Printer A-18
	HP LaserJet 4200 Printer A-18
	Physical Specifications A-19
	Electrical specifications A-19
	Minimum recommended circuit capacity A-19
	Environmental specifications A-19
	Acoustic emissions (per ISO 9296) A-19
	Safety certifications A-19

	HP 2200 D A-21
	HP LaserJet 2200 D Printer A-21
	Physical Specifications A-21
	Appendix B - CardioLink Server Rename B-1


	Purpose B-3
	Special Notes B-3

	Equipment needed B-4
	Customer Notification B-4

	New Server Install B-5
	Re-name Installed Server B-8
	System Functional Checkout Procedure B-14
	CardioLink Server Rename Record B-15
	Index Index-1



	1 Introduction
	Document Information
	Revision History
	Manual Purpose
	Intended Audience
	Related Manuals
	Statement of Indications for Use
	Mac-Lab System
	CardioLab System

	Chapter Content

	Safety Information
	Electromagnetic Compatibility and Interference
	Responsibility of the Manufacturer
	General
	Equipment Symbols

	Conventions
	Safety Messages
	Definitions

	Danger, Warnings, and Cautions
	Service Information
	Service Requirements
	Equipment Identification
	Equipment Identifications Table

	Required Tools and Supplies
	Power Input Requirements


	2 Equipment Overview
	Acquisition Computer with Workstation
	Central Processing Unit (CPU)
	General Description
	Standard Equipment
	Additional Systems
	Optional Equipment
	CardioLink Server
	Software
	Operating System
	Application
	Accessory Software


	MotherBoard
	Component Boards
	Video PCI Expansion Cards
	RS422 PCI Expansion Card
	Imaging PCI Expansion Card - Optional
	COMMS ISA Expansion Card
	SCSI PCI Expansion Card - Optional
	SCSI Drive Subsystem
	USB Port (part of IEB Box)
	Optical Drive 2.6GB
	Optical Drive 320MB
	TRAM-net to Ethernet conversion board


	Integrated Electronics Box (IEB)
	Introduction
	Isolation Transformer (part of IEB Box)
	Uninterruptible Power Supply (UPS)
	Modem
	Modem Power Supply (part of IEB Box)
	Video Multiplexer (VID/MUX) for IEB
	VID/MUX Power Supply (part of IEB Box)
	DB Connect Circuit Board
	Thermal Overcurrent Circuit Breaker
	ON/Standby Switch
	Rack-Mounted UPS for CardioLink Server



	3 Installation
	Installation
	CardioLab 2000/4000/7000
	Components
	Catheterization Procedure Room
	Reviewing the Assembly

	Mac-Lab 2000/4000/7000
	Connecting System Components
	Components
	Catheterization Procedure Room
	Control Room
	Reviewing the Assembly

	ComboLab 2000/4000/7000
	Connecting System Components
	Components
	Catheterization Procedure Room
	Reviewing the Assembly

	Integrated Electronics Box
	CardioLink Diagram

	Changing the SA Password
	On Server
	On Acquisition and Review Systems


	4 Maintenance
	Introduction
	Recommended Maintenance
	Operator’s Maintenance Schedule
	Pre-service Procedures
	Environmental Protection

	Inspection and Cleaning
	Precautions
	Daily Visual Inspection

	General Maintenance
	Cleaning the Exterior
	Cleaning the Monitor Screens
	Cleaning EP Cables

	Monthly Maintenance
	Cleaning the Print Head

	Annual Maintenance
	Cleaning the Interior
	Inspect All Cables, Plugs, and Connectors
	Cleaning the RAU and TRAM

	Preventative Maintenance
	Domestic Electrical Safety Tests
	AC Line Voltage Test
	120 VAC, 50/60 Hz
	240 VAC, 50/60 Hz
	Leakage Current Tests
	Special Test Considerations

	Ground Continuity
	Special Considerations

	Maintenance/Repair Log
	Maintenance/Repair Log Table


	5 Troubleshooting
	Introduction
	Initial Inspection
	Visual Inspection

	General Troubleshooting for the System
	Problems
	No Boot Up
	System Does Not Boot
	Multiple Monitors Change Colors
	Monitor Went Black (No Signal)
	Inspection List
	Power On Failure Modes


	Functional Checkout Procedure
	Introduction
	System Initialization
	Front End Data Acquisition

	Troubleshooting the RAU
	RAU Description
	TRAM modules in the RAU
	RAU Interconnection
	Data Transmission
	Pressure Waveforms


	Troubleshooting the Video Processing
	General Information
	Monitor Description
	Installation Checklist

	Video Failure Modes
	Color Distortion
	One or More Colors Missing on Monitor
	Video Signal on One Monitor is Distorted or Missing:


	Thermal Writer Problems
	Thermal Writer Starts to Print, then Stops on its Own
	Thermal Writer Outputs Blank Sheets of Paper
	Thermal Writer Does Not Print (Blank Sheets Only)
	Paper Jams During Printing
	Thermal Writer Does Not Print, Makes Machine Gun Noise

	Troubleshooting the Thermal Writer
	Thermal Writer Description
	Repairing the Thermal Writer
	Thermal Writer Failure Modes
	Erratic or no chart paper drive
	Printing too light or too dark
	White line running across the printing

	RAU Failure Modes
	ECG labeled, but no ECG data
	BP sites are labeled, but no pressure numbers or waveforms
	BP waveforms are present, but no ECG waveforms
	ECG waveform is present, but one or both BPs are missing


	Server UPS Troubleshooting
	During Start
	After Start
	UPS Alarm Conditions
	Silencing an Audio Alarm


	TRAM-net 4A LED Troubleshooting Chart
	CardioLink Utilities Troubleshooting

	6 Recovery Procedures
	CardioLink Server (5.2)
	Introduction
	Required Parts
	Ensure 5.2 backup tapes exist
	Stop data replication on the server
	Stop data replication and disable networking at each acquisition system
	Back up custom lists and reports
	Backup Custom Lists
	Backup Custom Reports

	Record system information at the server
	Record Microsoft security patches installed
	Record LMT information
	Check for advanced security
	Record job schedules
	Backup LMT Custom Reports
	Replace the Server Hard Drive (if applicable)
	Re-Image Server (G3 Only)
	Repartition the Hard Drive

	Re-Image Server (G1 and G2 Only)
	Setup User Properties on Server
	Install SQL Service Pack 3 (G1 Only)
	Install CardioLink 1.1D
	Install Server Core Update
	Upgrade CardioLink 5.2
	Install CardioLink Utilities
	Configure pcAnywhere Callers List (G1 Only)
	Configure pcAnywhere Callers List (G2 Only)

	Load AIT tape driver
	Restore data to the server
	Rename the Server
	Change the NT name
	Run the Rename utility
	Edit timeserv.ini
	Correct SNMP traps
	Configure Insight manager
	Reconfigure pcAnywhere

	Configure Network Settings
	Workgroup Member Setup
	Domain Member Setup
	Configure Settings

	Restore the CardioLink Database from BackupTape
	Enterprise Backups
	Restore from a Veritas Backup
	Restore from ArcServe Backup
	Restoring Database and Study Data from the Enterprise Network
	Using Veritas Backup Exec Remote Agent for Windows NT
	Using ArcServe Windows NT Enterprise ED. v6.5 Bld 600

	Install LMT server
	Install LMT client
	Install LMT Backup/Restore utility
	Re-Install Microsoft security patches
	Restore the GEMS Registry Key
	Restore the clab database
	Restore LMT database
	Install Serial Number update
	Restore LMT Custom Reports
	Verify time and time zone
	Register Acquisition systems
	Enable for advanced security
	Run the Replication utility
	Setup file paths at each Acquisition system
	Push emergency cases to the server
	Re-link LMT tables
	Restore ACC access /PedCath/Personal Files
	Schedule reports
	Verify the LMT application installed correctly
	Verify the modem connection and PC Anywhere
	Reconfigure hospital shares and mapped drives
	Reconfigure SQL Jobs
	Run DB Maintenance Job
	Setup Archive Generator
	Run a full tape backup
	CardioLink Network Functional Checkout Procedure
	Chassis Back View CD-ROM Drive
	Optical Drive - 3 1/2
	RS422 PCI Card
	Optical Drive - 5 1/4


	7 Drawings and Parts List
	Diagrams/Drawings/Illustrations
	Chassis Front View
	Back Panel Showing Slots for CardioLab/Mac-Lab Computers
	Slots for CardioLab/Mac-Lab Computer with RS422 or TRAM-net Card
	Back Panel Showing Slots for CardioLab/Mac-Lab Computers
	Slots for CardioLab/Mac-Lab Computer with PSI Card
	Thermal Writer
	Remote Acquisition Unit (RAU) with TRAM
	RAU Rear Panel
	RAU
	RAU
	Connections for the NT CardioLab/Mac-Lab Computer
	CardioLink Server Airflow Requirements

	Rack-Mount Server Front View
	Rack-Mount Server Back View
	Rack-Mount Server UPS
	Rack Mount Server UPS Rear View

	TRAMnet Communication
	TRAM-RAC 4A Housing
	Analog Output Connection


	Ordering Parts
	Introduction

	Specifications
	Special Instructions for Using Equipment
	Environmental
	Classifications/Standards


	CardioLink Server G1
	Table 18. CardioLink Server (Continued)
	Table 19. Rack for CardioLink Server
	CardioLink Server G2
	System Specifications

	LaserJet 4200 Printer
	Table 20. HP LaserJet 4200 Printer (Continued)
	Physical Specifications
	Electrical specifications
	Minimum recommended circuit capacity
	Environmental specifications
	Acoustic emissions (per ISO 9296)
	Safety certifications

	HP 2200 D
	Table 21. HP LaserJet 2200 D Printer
	Physical Specifications

	Purpose
	Special Notes

	Equipment needed
	Customer Notification

	New Server Install
	Re-name Installed Server
	System Functional Checkout Procedure
	CardioLink Server Rename Record


